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[bookmark: _Toc97719551]About this guide
This guide, X-Analysis User Manual, describes how to use X-Analysis and its other related modules. It discusses the following topics:
· Configuring X-Analysis
· Using X-Analysis Client
· License Manager (V2 licensing)
· Application Library/Areas
· Diagramming features
· Screen Components
· Business Rules Analysis
· Audit Options
· Document Manager and much more
[bookmark: _Toc97719552]Version
This guide describes X-Analysis, software version 13.2.14
[bookmark: _Toc97719553]How to use this guide
The manual has multiple chapters. Each chapter throws light on one or more of the diverse X-Analysis features which adequately support advanced analysis and documentation tasks. The Appendices contain the other crucial technical details relevant to understanding and using X-Analysis. The topics progress from general ideas to more advanced concepts, building on the earlier chapters.
This guide will prove to be very useful for software professionals–from analysts and developers to architects and operations teams – intending to analyze, document, or modernize AS/400 (or IBM i) applications. Explore this guide to gain insight into the inimitable facets of X-Analysis that equip users with rich understanding of existing legacy applications.
The X-Analysis suite of products contains a total of eight modules. This guide is about X-Analysis. For information about the other modules, please contact your Fresche Solutions representative, or visit us at: https://freschesolutions.com/products/x-analysis-suite/
[bookmark: _Toc97719554]What is new in the latest release?
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	This document did not change since the previous release of this application. 


[bookmark: _Toc97719555]Overview
A comprehensive, stepwise, and illustrative guide that encapsulates the advantages of X-Analysis as a multipurpose software product suite!
X-Analysis comes fully equipped to address all analysis and documentation needs – from analyzing Metrics to decoding monolithic Business Rules and many more. In sum, X-Analysis is a power-packed tool set, designed to keep technical complexities at bay, making conversion of existing application designs into the latest format a much easier exercise
[bookmark: _Toc97719556]Acronyms used in the manual
	Acronym
	Full form

	APD
	Access Path Diagram

	AAD
	Application Area Diagram

	DFD
	Data Flow Diagram

	DMD
	Data Model Diagram

	FFD
	File Field Details

	SCD
	Structure Chart Diagram 

	HSC
	Hierarchical Structure Chart

	PSC
	Program Structure Chart

	OSC
	Overview Structure Chart



[bookmark: _Toc97719557]Introduction to X-Analysis
X-Analysis# is a proven world-leading tool used by analysts, developers, architects, and operations teams for analyzing, documenting, modernizing, and rebuilding of IBM i applications. It also provides detailed analysis and interactive diagrammatic constructs that enable a better understanding of existing applications. It also has a set of powerful re-engineering facilities for automated database and application modernization which are integrated with the analysis and design extraction functions. Whether an application is poorly structured or highly structured (for example, Synon/2E applications), X-Analysis can extract the design logic of the application, providing an excellent base for efficient and effective design recovery.
X-Analysis is a suite of modules fully integrated with IBM Rational products (WDSc, RDp, RDi, etc.). It also runs standalone on Eclipse without any other product dependencies. Individual modules are grouped together to provide useful solution sets that meet a number of requirements around a central theme.
[bookmark: _Toc97719558]Profile Authority Requirements
	[image: ]
	Refer to the section “Profile Authority Requirements” in the document “X-Analysis_Initialisation” for this release.


X-Analysis# release 10.x onwards is digitally signed.
Since this product is under continuous improvement, you might notice some differences in the screens.
[bookmark: _Toc97719559]Configure Cross-Reference Library
Before using the X-Analysis Client, the cross-reference library that is, the application repository has to be built. The initialization process takes care of the setting up of the cross-reference database.
This chapter presents the steps, specific command screens, and the command keys for building a cross-reference library.
[bookmark: _Toc97719560]Set the Library List
	[image: ]
	Refer to the section “Set the Library List” in the document “X-Analysis_Initialisation” for this release.


[bookmark: _Toc97719561]Work with X-Analysis Reference Menu
	[image: ]
	Refer to the section “XREFMENU Command Screen” in the document “X-Analysis_Initialisation” for this release.



[bookmark: _Toc97719562]Work with X-Analysis for Application
From the master command screen above, press F6 and select the desired version to add a new X-Ref library. The following screen will appear only when version is below 13.1.00 and X-Analysis is installed on *SYSBAS:
 X-Analysis/4  Work with X-Analysis/4 Applications    Fresche Solutions
  XARWKAPP                                                      07:06:09
 			                                         14 Feb 2019
  X-ref Library. . . . . . . . .     __________
  X-ref Library ASP device . . .     *SYSBAS
  X-ref Library ASP group. . . .     *SYSBAS
  X-ref Other ASP device . . . .     *SYSBAS
  Version. . . . . . . . . . . .     13.0.00
  Text . . . . . . . . . . . . .     _____________________________
  Company/division . . . . . . .     _____________________________
 
 
 
 
 
  F1=Help        F3=Exit        F12=Cancel
Fig. 1.1.1 – Work with X-Analysis/4 Application – Add Application screen
This option will add an entry to the list of the X-Analysis/4 applications and create a new (empty) cross-reference library. The user must specify the name of the cross-reference library (for example, XAN4CDXA) . It is optional to the user to specify text and a company name. 
 X-Analysis/4   Work with X-Analysis/4 Applications    Fresche Solutions
  XARWKAPP                                                      07:06:09
 			                                         14 Feb 2019
  X-ref Library. . . . . . . . .     XAN4CDXAT  
  X-ref Library ASP device . . .     *SYSBAS
  X-ref Library ASP group. . . .     *SYSBAS
  X-ref Other ASP device . . . .     *SYSBAS
  Version. . . . . . . . . . . .     13.0.00
  Text . . . . . . . . . . . . .     XAN4CDEM1 Tutorial System  
  Company/division . . . . . . .     Fresche Solutions 
 
 
 
  F1=Help        F3=Exit        F12=Cancel
Fig. 1.1.2 – Work with X-Analysis/4 Application – Application added
Fields, viz., X-ref Library ASP device, ASP group, and Other ASP device—display—ASP device value, ASP group, and other ASP device value, respectively. Press F7=ASP Device to select the desired ASP device enlisted and in case there is no ASP device, *SYSBAS will be the default device.
The following screen will appear only when X-Analysis version is 13.1.00 or above and X-Analysis is installed on independent ASP group:
 X-Analysis/4  Work with X-Analysis/4 Applications      Fresche Solutions
  XARWKAPP                                                      07:06:09
 			                                         14 Feb 2019
  X-ref Library. . . . . . . . .     XAN4CDXAT  
  X-ref Library ASP device . . .     QPIASP____F7 for List
  X-ref Library ASP group. . . .     QPIASP
  X-ref Other ASP device . . . .     QPIASP____F7 for List
  Version. . . . . . . . . . . .     13.1.00
  Text . . . . . . . . . . . . .     XAN4CDEM1 Tutorial System  
  Company/division . . . . . . .     Fresche Solutions 
 
 
 
  F1=Help   F7=ASP Device     F3=Exit        F12=Cancel
Fig. 1.1.3 Application added

[bookmark: _Toc97719563]Libraries
	[image: ]
	Refer to the section “Libraries” in the document “X-Analysis_Initialisation” for this release.


[bookmark: _Toc97719564]Initialization
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	Refer to the section “Initialization” in the document “X-Analysis_Initialisation” for this release.



[bookmark: _Toc97719565]Exclusions
The exclusions can be set up after initializing the cross-reference using the “Exclusions” option from the Work with X-Analysis/4 Applications screen. Select Option 16 to do this and press Enter.
 X-Analysis/4           Work with Exclusions     Fresche Solutions
  XARWKXCS                                                 07:06:09
                                                        14 Feb 2019			                    
  Enter options, press Enter.
  5=Work with
 
   Program       Description
   XARWKSCE      Work with Diagram Exclusions
   XARWKSFE      Work with Source File Exclusions
   XARWKBRC      Work with Business Rule Call Exclusions
   XARWKHRE      Work with Hierarchy Exclusions
   XARWKUMLE     Work with UML Exclusions
   XARPRBEXC     Problem Analysis Exclusion
   XARWKPRE      Work with Subroutines/Subprocedures Exclusion
 
 
 
 
 F1=Help  F3=Exit  F10=Cmd line  F12=Cancel  F14=WRKSBMJOB  F24=More keys
 Fig. 1.2.1 - Work with Exclusions screen 
The exclusions screen provides a menu for object exclusion. The options are:
· XARWKSCE – Work with Diagram Exclusions
· XARWKSFE – Work with Source File Exclusions
· XARWKBRC – Work with Business Rule Call Exclusions
· XARWKHRE – Work with Hierarchy Exclusions
· XARWKUMLE – Work with UML Exclusions
· XARPRBEXC – Work with Problem Analysis Exclusion
· XARWKPRE – Work with Subroutines/Subprocedures Exclusion
[bookmark: _Toc97719566]XARWKSCE – Work with Diagram Exclusions
After initialization, the objects excluded by using this option will not appear in the following:
· Structure Chart Diagrams
· Data Flow Diagrams
· Object Where Used data
· Application Areas
	[image: ]
	The excluded programs will appear in the Program Structure Charts.


You should specify an object name and any required descriptive text. The object name can be generic. If an individual object name is specified, then it is validated against all objects currently loaded into X-Analysis. If a file name is specified, then it must be a physical file name. All logical views built over an excluded physical file are also excluded.
[bookmark: _Toc97719567]XARWKSFE – Work with Source File Exclusions
If the user uses this option to exclude source files than the excluded source files will not be loaded into X-Analysis. Specify a particular or generic file name. You can specify a particular library name or *ALL, or leave the name blank. A blank library name is equivalent to *ALL. This option can be taken prior to the initialization process.
[bookmark: _Toc97719568]XARWKBRC – Work with Business Rule Call Exclusions
After initialization, use this option to set up Business Rule call exclusions. Specify program name which you wish to exclude. This option will exclude the CALL Statement from the calling program for the excluded member.
[bookmark: _Toc97719569]XARWKHRE – Work with Hierarchy Exclusions
After initialization, use the Hierarchy Exclusion option to prevent all the programs called by the excluded programs shown in the Structure Chart Diagram and the Overview Structure Chart. Programs excluded in SCD or OSC gets displayed by a green arrow next to it.
[bookmark: _Toc97719570]XARWKUMLE – Work with UML Exclusions
After initialization, use this option to exclude objects for the UML diagram. Specify the object name which you wish to exclude from the UML diagram.
[bookmark: _Toc97719571]XARPRBEXC – Work with Problem Analysis Exclusion
After initialization, use this option to specify objects/sources to be excluded from Problem Analysis.
[bookmark: _Toc97719572]XARWKPRE – Work with Subroutines/Subprocedures Exclusion
Use this option to exclude source files. Excluded source files will not be loaded into X-Analysis. You have to provide the following details:
· Source Member name
· Source Member File name
· Source Member Library name
The Subroutines/Subprocedures Exclusion details can be left as blank. This option can be taken prior to the initialization.

[bookmark: _Toc97719573]Generating the Data Model
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	Refer to the section “Generating the Data Model” in the document “X-Analysis_Initialisation” for this release.


[bookmark: _Toc97719574]Refresh the Cross-Reference Library
	[image: ]
	Attempt the Refresh option only when you have modified Objects/Members.


X-Analysis provides a refresh command to register changes in Objects/Members of the application library to the cross-reference library. The XREFRESH command refreshes the X-Analysis cross-reference database for the specified libraries for all the changed objects.
The refresh will have no effect unless there are changes to (at least) one of the source files registered in the cross-reference database. This command will update the Object and the Member lists immediately and run a separate job to re-index the appropriate source code.
To run the refresh command from the 5250 screen, go to the Work with X-Analysis/4 Application screen and select Option 14 against the cross-reference library.
 X-Analysis/4      Work with X-Analysis/4 Applications     Fresche Solutions
  XARWKAPP                                                          11:25:43 
 			                                             22 Apr 2020                             
  Enter options, press Enter.
  1=Authorities 2=Change 3=Copy 4=Delete 5=Display 7=X-A Log 8=Libraries
  9=Variable Calls 10=App areas 11=Reports 12=Initialise 13=Build data model
  14=Refresh 15=Gen Business Rules 16=Exclusions 17=Objects 18=Pgm Stds			                                                  
  			
     X-ref Lib   Text                            Company/division
     XAN4CDXA    XAN4CDEM Tutorial System
  14 XAN4CDXAT   XAN4CDEM Tutorial System			
 
Fig. 1.3.1 – Work with X-Analysis Applications
Press Enter to invoke the XREFRESH command screen (displayed below):
                   Refresh Changed Objects (XREFRESH) 
 
 Type choices press Enter. 
 						                                                                
 X-Analysis Library . . . . . . . > XAN4CDXAT     Name
 Refresh Application Areas  . . .   *NO           *YES, *NO, Y, N			
 Refresh Business Rules . . . . .   *NO           *YES, *NO  
 
Fig. 1.3.2 – Refresh Changed Objects (XREFRESH)

	Feature
	Brief Description 

	X-Analysis Library
	The X-Analysis cross-reference library name.

	Refresh Application Area
	If you wish to refresh the Application Areas, select *YES. If you select *NO, the Application Areas will not be updated.

	Refresh Business Rules
	If you wish to refresh the Business Rules for each changed program, select *YES. If you select *NO, the Business Rules will not be updated, and you will need to re-generate all Business Rules next time to bring them up to date.




[bookmark: _Toc97719575]Variable Program Calls from Files or Programs
RPG language allows the use of variables in the CALL statements where the variable would contain the name of the next program to be called at runtime. The variable might be getting the next program name through some database file or hard-coding in the program logic itself. In such cases, the display program references command shows the variable name instead of the actual program which would be called at runtime. Therefore, some mechanism is required in X-Analysis to identify the possible programs which are called through variables at runtime.
In order to achieve this, Option 9 has been provided on the Work with X-Analysis/4 Application screen where the variable calling setup can be done.
 X-Analysis/4   Work with X-Analysis/4 Applications     Fresche Solutions
  XARWKAPP                                                        11:25:43 
                                                               22 Apr 2020 
  Enter options, press Enter.			                                                                       
  1=Authorities 2=Change 3=Copy 4=Delete 5=Display 7=X-A Log 8=Libraries
  9=Variable Calls 10=App areas 11=Reports 12=Initialise 13=Build data model
  14=Refresh 15=Gen Business Rules 16=Exclusions 17=Objects 18=Pgm Stds
 
    X-ref Lib   Text                            Company/division			
    			
    XAN4CDXA	XAN4CDEM Tutorial System         														
                                                                               
 F1=Help  F3=Exit  F10=Cmd line  F12=Cancel  F14=WRKSBMJOB  F24=More keys
Fig. 1.4.1 – Work with X-Analysis/4 Applications
This provides access to the following:
Variable Program Calls from Files: You can add the relevant file containing the info about the program names to be called. The files listed on this screen is called Generic Files. These files are read by the program(s) to determine which programs to call based on certain keys.
Work with Generic Files allows you to maintain the details of the files which are read by a program in order to determine which programs to call.
Press F6 to add a Generic File.
The following data should be maintained:
File name – The name of the database file which is used to retrieve the name of the programs to be called (the generic file). The name entered can be either a physical or a logical file name but it must be a ‘keyed’ file.
Key type – This field indicates the type of data used to retrieve the ‘called program’ name. Choose from:
*ALL – All records in the file are to be scanned to find the possible programs that can be called by the program.
*CONSTANT – All records keyed by any value which is moved into the key field name (see below) within the calling program refer to programs which can be called by the program.
Key field name – This field only applies when the key type is specified as *CONSTANT. It identifies the name by which the key field is ‘referred to’ in the calling program. This is the field which has values moved into it to determine which programs should be called.
Variable Program Calls from Programs: This case is for the generic programs which are called by the other program – to either return the names of the programs to call or call further programs directly. The purpose of this setup is to bypass the intermediate (generic) program and directly display the actual/second-level program.
Press F6 to add a Generic Program.
The following data should be maintained:
· Program name – The name of the program which is called to call further programs.
· Key Type – This field indicates the method used by the generic program to determine which programs to call. Choose from:
· *ALL – All program references for the generic program are shown as references for the calling program.
· *FILE – The generic program uses a generic file to determine which programs to call. The references as defined through Work with Generic Files will be shown as references for the calling program.
· File name – This field only applies when the key type above is specified as *FILE.
· The file name is validated against the files maintained through the Work with Generic Files screen.
[bookmark: _Toc97719576]Demo case
The example illustrated below displays the generic program using the generic file to determine which programs to call.
In this instance, PG_V5 is a generic program called by CL_GEN_PGM. See PG_V5 as listed under the Generic Programs list.
 X-Analysis/4       Work with Generic Programs    Fresche Solutions
  XARWKGPS                                                  11:25:43 
                                                         22 Apr 2020
  Enter options, press Enter.
  2=Change 4=Delete 5=Display 
 
    Program    Type                            File name			
    			
    PG_V5      *FILE         		       PGNAME											
 
Fig. 1.4.2 – Work with Generic Programs
The following screen shows PGNAME as listed under the Generic Files list.
 X-Analysis/4       Work with Generic Files       Fresche Solutions
  XARWKGPS                                                  11:25:43 
                                                         22 Apr 2020
  Enter options, press Enter.
  2=Change 4=Delete 5=Display 
 
    File     Key type         Key field name	   Called pgm field	
    PGNAME   *ALL			                   PGM1
    										
 
Fig. 1.4.3 – Work with Generic Files
PGM1 field of PGNAME file is considered for variable program calls.
There are two options to specify the Key type.
*ALL: All the program names for the Called Program Field (that is, PGM1) existing in the generic file (that is, PGNAME) will be added as the program references.
*CONSTANT: It works differently because it tracks the actual constant key value moved in the key field name for selecting the database records matching the key value for the variable call selection.
Refer to the example below with the entries in the PGMNAME file:
 X-Analysis/4       Work with Generic Files    Fresche Solutions
  XARWKGPS                                               11:25:43 
                                                      22 Apr 2020 
  Enter options, press Enter.
  2=Change 4=Delete 5=Display 
 
    COND             PGM1	      PGM2
 				
  000001 A   	     PG_V2K	      PG_V1	                   
  000002 B	     PG_V3K	      PG_V4
  ****** ******** End of report ***************							
 
Fig. 1.4.4 – Work with Generic Files
Considering the above setup and example, below program references are added once XREFRESH or the initialization process is executed on the X-Ref library:
 X-Analysis/4       Work with Generic Files    Fresche Solutions
  XARWKGPS                                               11:25:43 
                                                      22 Apr 2020 
  Enter options, press Enter.
  2=Change 4=Delete 5=Display 
 
  WHPNAM        WHTEXT	        WHFNAM          WHOBTB   WUSAGE
  CL_GEN_PGM	                      PG_V2K            P        I		
  CL_GEN_PGM                       PG_V3K             P        I	
  ****** ******** End of data ********							
 
Fig. 1.4.5 – Work with Generic Files
In this example, reference to Generic Programs has been deleted, and the references from relevant file/field listing on the "Work with Generic Files" screen has been added. The key type is specified as *ALL in the generic file entry. All the program names under the PGM1 field of PGNAME file are considered as dependencies of CL_GEN_PGM. Therefore, the object dependencies of PG_V5 are removed and the program names existing in PGM1 field of PGNAME file are added as the dependencies of CL_GEN_PGM program. As a result, the Object Where Used displays the replaced dependencies.
The other options from the X4WRKAPP screen are explained below:
· 1=Authorities: Use this option to maintain the User Authorities (for details on these, refer to the document “X-Analysis_User_Authorities” for this release).
· 2=Change: Use this option to change an application.
· 3=Copy: Use this option to copy an application.
· 4=Delete: Use this option to remove the X-Ref library from the application selection list. Note that selecting this option only removes the X-Ref entry from the server.
· 5=Display: Use this option to display the records from an application.
· 7=X-A Log: Use this option to view the details of the options taken for the selected X-Ref.
· 10=App Areas: Use this option to specify application areas for the selected application.
· 11=Reports: Use this option to request all the reports relating to application areas and objects.
· 17=Objects: Use this option to work with Objects for the selected application.
· 18=Pgm Stds: Use this option to set program standards for variables within programs if the variable you have entered does not have any object or field description known to X-Analysis.

[bookmark: _Toc97719577]User Defined Commands
The user may have defined their commands similar to standard IBM i commands. For X-Analysis to derive the references correctly, the user should map the user defined commands with the equivalent IBM i command in table XUSRCMDS in the cross-reference.
[image: ]
Fig. 1.5.1 – User Defined Commands
In the above example, the user has a command XACALL which is similar to the IBM i CALL command. For CALL command the column XUKWD1 will be valid and the column XUKWD2 to the column XUKWD5 are not in use. Similarly for the command DSPFD and SBMJOB, column XUKWD1 to the column XUKWD5 are not in use and can be left blank. The column XUCMD should have the user defined command and the column XULIKE, the IBM i command it is replacing. The other columns, XUKWD1-5 and XUTYPE, are not in use and can be left blank.
For the changes to take effect, the cross reference should be refreshed or re-initialized.
The XA-Guide is updated with the information about how the parameter named in the user defined command must match the IBM i command.
Let's take an example of the user defined command MYXCALL from the reference library.
When the user clicks the All Objects node from the reference library, you will get a display screen of Object List.
[image: ]
Fig. 1.5.2 – All Objects node
Refer to the screen below displaying user defined command MYXCALL.
[image: ]
Fig. 1.5.3 – All Objects List Screen
Select the Data Flow Diagram option from the context menu over an object, as shown below:
[image: ]
Fig. 1.5.4 – Data Flow Diagram option
This brings up the DFD for the object, MYXCALL.
[image: ]
Fig. 1.5.5 – DFD MYXCALL
Right click the object MYXCALL, and select the option Zoom Source.
[image: ]
Fig. 1.5.6 – Zoom Source MYXCALL
This brings up the Source List for the object MYXCALL. So the command value passed will be shown inside the DFD corresponding to the actual program by MYXCALL.
[image: ]
Fig. 1.5.7 – Source List MYXCALL
The screen above displays the user defined command MYXCALL which is similar to the IBM i command XACALL.
Similarly, there are few more user defined command created, which is similar to the IBM i command. Refer to the figure above 1.5.1.
· User defined command XCALL which is similar to IBM i command CALL.
· User defined command XDSPFD which is similar to IBM i command DSPFD.
· User defined command XSBMJOB which is similar to IBM i command SBMJOB.
[bookmark: _Toc97719578]Using X-Analysis Client
[bookmark: _Toc97719579]Sign-On Dialog
Start IBM's Rational products 9.0 and above or Eclipse (see https://www.myfreschesolutions.com/nexus/ui/docs?root=0&docId=590&kbnum=15954 for supported Eclipse version) .
Window > Open Perspective > Other > X-Analysis
[image: ]
Fig. 2.1.1 – Open Perspective > Other
Select the X-Analysis Perspective.
[image: ]
Fig. 2.1.2 – Open Perspective
Click OK to start the X-Analysis Perspective.
[image: ]Fig. 2.1.3 – X-Analysis Perspective
Expand the New Connection node to invoke the Sign-on dialog box.
[image: ]
Fig. 2.1.4 – X-Analysis Sign-on dialog box
Enter the following information to the Sign-on dialog box:
1. Enter the TCP/IP address/Computer Name of the IBM i to be accessed.
2. Enter the username and the password of a valid IBM i profile.
3. Specify the ASP Group If X-Analysis is installed on an ASP group.
4. Check the box for ‘Use SSL’ feature for additional security. For details refer to the section Use SSL feature.
5. Click Login.
After successful sign-on, X-Analysis lists the application libraries which were initialized from the X4WRKAPP screen on the IBM i.
	[image: ]
	Refer to the section “Using X-Analysis Client” in the document “X-Analysis_User_ Manual” for this release. 



[bookmark: _Toc97719580]Session Information
The X-Analysis Client displays detailed session information about the connection in the associated Session Information view.
[image: ]
Fig. 2.2.1 – Session Information
The Session Information details are as follows:
· Host Name: Displays the IP or the web link of the connected IBM i.
· X-Analysis Username: Displays the user name connected to the IBM i.
· X-Analysis Library: Name of the cross-reference library, the user has currently selected.
· Job Details: Displays job details in format – Job Number/Job Name/Job User.
· Database Library: The Subset Library which is being used to get the data from where the Data View options are selected. This displays a value only when a subset library has been selected.
· Application Area: Displays the currently selected Application Area.
· Data Model Info: Informs the user whether Data Modeling is available or not.
· Library List: Displays the library list for the current job.
· X-Resize Project: Displays the name of the currently selected X-Resize project.

[bookmark: _Toc97719581]X-Analysis Menu
X-Analysis provides the X-Analysis toolbar menu on the Eclipse toolbar. The following screen displays options available on the X-Analysis menu:
[image: ]
Fig. 2.3.1 – X-Analysis Menu
The details of the options provided by the X-Analysis menu is described below:
[bookmark: _Toc97719582]License Manager
V2 is the new licensing mechanism which is added to help both the new and existing X-Analysis users. Please contact Fresche Solutions at license@freschesolutions.com to obtain the license file.
[bookmark: _Toc97719583]Obtaining the License File
	[image: ]
	Refer to the section “Obtaining the License File” in the document “X-Suite_Installing_And_Using_the_License_Manager_Tool” for this release.


[bookmark: _Toc97719584]Applying the License File
	[image: ]
	Refer to the section “Applying the License File” in the document “ X-Analysis_Installation_And_Upgrade_Guide” for this release.


[bookmark: _Toc97719585]New DB2 Connection for i
The X-Analysis menu provides the New DB2 Connection for i option. Through this option, you can create connections to different IBM i servers. The user must provide valid sign on information when selecting the New DB2 Connection for i option. Upon successful sign on, X-Analysis adds a new IBM i node in the navigation view.
Creating New DB2 Connection for i from X-Analysis Plugin
[image: ]
Fig. 2.3.2 – New DB2 Connection for i from X-Analysis Plugin
[bookmark: _Toc97719586]New DB2 Connection for i (Kerberos)
Use this option to connect to IBM i server secured using Kerberos. This prompts for a login dialog where user profile and password are not required.
Kerberos requires IBM i and Windows user's profiles mapping and Kerberos authentication ticket (KDC) for the user generated and activated.
[image: ]
Fig. 2.3.3 – New DB2 Connection for i (Kerberos)

	[image: ]
	The Host Name should be the same which is recognized by the Kerberos environment.


Also, in order to generate Kerberos ticket you have to use the command KINIT in your command prompt. If you are not able to find the KINIT command, please check with your System/Network administrator.
After hitting this command, you will be asked for a password, here you can enter Windows user password.
The default validity of this ticket is 10 hours but this can be configured on Kerberos to Lifetime. All this is controlled by the Kerberos settings and managed by System/Network administrator.
[bookmark: _Toc97719587]New DB2 Connection for Windows
The X-Analysis menu provides the New DB2 Connection option. By selecting this option, you can create connections to use X-A Open (module for Open Systems Analysis). Enter a valid DB2 sign on information when selecting the New DB2 Connection for Windows option.
Creating New DB2 Connection for Windows from X-Analysis Plugin
[image: ]
Fig. 2.3.4 – New DB2 Connection for Window
Refer to Appendix A – X-Analysis Offline for more details on X-Analysis Offline.
[bookmark: _Toc97719588]Mark all for Documenter
Select the Mark all for Documenter option to mark all records for system documentation which are listed on the X-Analysis window.
[image: ]
Fig. 2.3.5 – Mark all for Documenter
You can view the marked records through the Documenter icon on toolbar.
[image: ]
Fig. 2.3.6 – Documenter icon
On clicking the Documenter icon, the Document Manager dialog will display all the marked records.
[image: ]
Fig. 2.3.7 – X-Analysis - Document Manager dialog
[bookmark: _Toc97719589]Change Application Folder
The default Application Folder for a specific application can be changed by selecting the Change Application Folder option from the X-Analysis menu (X-Analysis>Change Application Folder).
The following dialog appears on selecting this option:
 [image: ]
Fig. 2.3.8 – Change Application Folder
To select a new Application Folder, click Yes in the dialog box. The following dialog appears, prompting to specify the location for the new Application Folder.
Select the new Application Folder and click OK.
[image: ]
Fig. 2.3.9 – Select New Application Folder
[bookmark: _Toc97719590]Open Log Folder
This option opens the folder, currently used to record the log files of X-Analysis. The XAPlugin.log file can also be used for bug/error tracking. Select the Open Log Folder option from the X-Analysis menu (X-Analysis > Open Log Folder).
[image: ]
Fig. 2.3.10 – Open X-Analysis Log folder
[bookmark: _Toc97719591]Open Application Folder
Each application has its own Application Folder. This folder contains generated System Documents, Flowcharts, and DDL files. To view the Application Folder, select the Open Application Folder option from the X-Analysis menu (X-Analysis > Open Application Folder).
[image: ]
Fig. 2.3.11 – Open Application Folder
[bookmark: _Toc97719592]Authorize Google Drive
The Authorize Google Drive option authorizes you in exporting the DOCX or XLSX files to Google Drive. For more details, refer to Appendix H – Export to Google Drive.
[bookmark: _Toc97719593]Report an Issue
The Report an Issue option helps you in reporting an issue along with the log files. When you select this option, X-Analysis collects all the information required to sort out the bug/error which is being reported and generates a zip file. X-Analysis then invokes the mail client installed on the user's system and attaches the zip file with this mail.
[bookmark: _Toc97719594]Install SSL CA certificate
The Install SSL CA certificate allows you to transfer data in a convenient and secure manner. For more details, refer to Appendix F – Use SSL feature.

[bookmark: _Toc97719595]X-Analysis Preferences
The X-Analysis Preferences provides the facility to modify product preferences.
The X-Analysis Plugin comes with default preferences settings. You can change default preferences settings as required. To change preferences settings, open IBM's Rational product 9.5 and above or Eclipse 4.4 and above.
From the menu bar, select Window > Preferences to invoke the Preferences dialog.
[image: ]
Fig. 2.4.1 – Preferences option
To view / modify various X-Analysis Preferences, select the X-Analysis node.
	[image: ]
	While running multiple versions of X-Analysis, ensure that distinct workspace is created or used for each specific version. Also, remember to select the Preference settings for the particular version you are currently working on. Hence, if using 12.0.1, use the Preference setting for 12.0.1, and not 12.0.0.


The following window is displayed:
[image: ]
Fig. 2.4.2 – X-Analysis Preferences
Here is a detailed look at the X-Analysis Preferences for the X-Analysis Plugin:
· IP Address: Specify the IP address of the IBM i on which the X-Analysis server components are installed.
· User: Enter the username to sign on to X-Analysis.
· Use SSL: Check this box to enable the SSL setting by default when the New DB Connection for i option is selected.
· DB2 Port: Specify the port number for the DB2 instance, where DB2 services must be running. DB2 Port will be enabled on offline IP address that is, 127.0.0.1 or localhost. The default DB2 port is 50000.
· User Interface: Specify language for the X-Analysis user interface. The default language is English.
· Begin with Outline: Specify appropriate settings for the Outline Pane (View Pane). The default option is unchecked, which means that the Outline Pane will not be displayed automatically. The outline or any other view will be displayed only when asked for.
· Detailed DFD by default: Check this option to invoke a detailed data flow diagram as default.
· Show Re-engineered Screen for Screen/Report layout: Check this option to view the re-engineered screen for the Screen/Report layout. When not selected, the Screen/Report layout shows the green screen display, which is the default setting.
For users without a Modernization license, the option Show Re-engineered Screen for Screen/Report layout has no effect, and the Screen/Report layout shows the green screen by default.
For users with a Modernization license, the option Show Re-engineered Screen for Screen/Report layout affects the Screen/Report layout.
· If the option Show Re-engineered Screen for Screen/Report layout is checked-in, then it displays the re-engineered screen for the Screen/Report layout. Refer to the screen below.
[image: ]
 Fig. 2.4.3 – Re-engineered Screen for the Screen/Report layout
· If the option Show Re-engineered Screen for Screen/Report layout is not checked-in, then it displays the regular green screen for the Screen/Report layout. Refer to the screen below.
[image: ]
 Fig. 2.4.4 – Green screen for the Screen/Report layout
· Ignore Linked Repositories (if any): Check this feature to ignore linked repositories. The default option is unchecked.
· Open Called Procedure/Program source in same tab: Uncheck this option for not opening Called Procedure or program source in the same tab. The default option is checked.
· Open Data Flow Diagram in same tab: The default option is checked. Uncheck this box to force any DFD selected from within another Data Flow Diagram to open in a new editor. Currently such DFDs are drawn on the same editor.
· Use Business Rules Overlay mode as default: Check this option to set the Business Rules Overlay mode as default.
· Use Source buffering: Check this option to enable source buffering.
· Allow editing in Consolidated Rules: Check this option to make changes in the Consolidated Rules. This adds Business Rules Matching and Business Rules Status Category options to the Cross-reference and Application Area context menus.
· Show only Objects in Metrics: While listing metrics, when the relevant box is selected, then the metrics is shown for all items which actually have an object in the user's library(ies). When the box is left unselected, it also includes the source members which do not have any objects associated with it. Note that all such members are displayed in blue.
· Allow Cancel from Server Jobs progress monitor: This option is checked by default. If you uncheck this option, the Cancel button on the Batch Job Progress window will not end the job submitted on the server.
· Show Long names for Files: Checking this option displays a toggle button on the editor toolbar of the All Objects/Files list. Click this button to begin seeing the long names. Checking this option will also display long names for various diagrams.
· Use Wider boxes for DMD: Widens the DMD boxes to declutter the text for the users having bigger font size set for the PC display.

[bookmark: _Toc97719596]Advanced Preferences
Expand the X-Analysis node to view/modify the Advanced Preferences.
[image: ]
Fig. 2.5.1 – Advanced Preferences
You can modify the following Advanced Preferences for the X-Analysis Client:
· Work with Objects:
· Default File Attribute: Specify attribute for Object List of *Files. The default value is ‘PF’.
· Default Program Attribute: Specify attribute for Object List of *PGM. The default value is ‘*ALL’.
· Subset Data:
· Include Owners: The default value is *YES.
· Include All Dependents: The default value is *NO.
· Replicate Triggers/Constraints: The default value is *NO.
· Data Option: The default value is *REPLACE.
· Search Settings:
· Occurrence: Select the appropriate search setting from the drop-down box. You will view the streamlined content based on this selection. If no selection is made, then the default search setting will apply.
· Document Generation: The Use MS Word OLE Automation box is unchecked by default. Checking the box activates OLE Automation allowing greater flexibility in handling data during the document generation process.
· Diagram Export:
· The Use Visio Automation option is checked by default. It renders a flowchart by launching Visio and requires Visio to be installed on the machine. The Use File API is used to generate a flowchart even if Visio is not installed on the machine. Check Additional Overlap Correction to avoid minor connector overlaps in File API generated flowcharts.
· The Use Open Office Draw (Also specify the folder in >Folders tab) box is unchecked by default. Check the box to use Open Office Draw for exporting diagrams and Flowchart on Open Office. Select this setting before selecting the various editors for diagrams and sources.
	[image: ]
	The Use File API option can be used only to generate Flowchart.


· Database Language Translation: This allows non-English users to select ‘Database Translation Language’, enabling correct display of native characters in the X-Analysis Client software. Choose the language from the drop-down.
· Google Client ID: If you wish to use the Google Drive feature, enter your Google client ID. Refer to Appendix H – Export to Google Drive for more details.
· Google Client Secret: Refer to Appendix H – Export to Google Drive for more details.

[bookmark: _Toc97719597]Folders Preferences
Expand the X-Analysis node to view/modify the Folders Preferences.
[image: ]
Fig. 2.6.1 – Folders Preferences
· Folder Preferences:
· X-Analysis Folder: Specify the path for the X-Analysis folder
· Logs and Temporary files folder:
· Specify Folder: Specify the location to change the default location for the X-Analysis logs and temporary files. If this is left blank, then default location is set.
· Open Office Installation Path:
· Specify Folder: The user must specify the location for the Open Office folder to allow exporting diagrams and flowchart to draw.
· Number of session log files to preserve:
· Preferred Log Files: This is the number of previous session log files that will be preserved. Log files for all the previous sessions which exceed this value will be removed. Enter a value between 1 to 9999. Default value for Preferred Log Files is 10.

[bookmark: _Toc97719598]General Preferences
Expand the X-Analysis node to view/modify the General Preferences.
[image: ]
Fig. 2.7.1 – General Preferences
· Structure Chart
· Initial Unexpanded Depth: This sets the depth to which the SCD would appear expanded initially. Users can manually expand it afterwards and does not require data fetching from the server.
	[image: ]
	From version 13.2.12, level for "Initial Unexpanded Depth" increases from 14 to 99.


For example, refer to screen displaying a program with Initial Unexpanded Depth to 3.
[image: ]
 Fig. 2.7.2 – Initial Unexpanded Depth
· Maximum Diagram Depth: From version 13.2.12 this new feature is introduced to set the maximum diagram depth level for any particular program. Maximum depth level for the option Maximum Diagram Depth is 99.
For example, refer to screen displaying a program with Initial Unexpanded Depth to 3 and Maximum Diagram Depth to 7.
[image: ]
 Fig. 2.7.3 – Maximum Diagram Depth
· Maximum Files to show in a row in 'Show Files' mode: The Interactive Structure Chart can display up to 10 files in a row. Select an appropriate value for files to be displayed. The value ranges from 1-10, but the default value is 5.
· Preferred Volume Limit: The Interactive Structure Chart gets displayed according to the volume limit set / provided in this field. The default limit is 9999. It means, regardless of the total number of called objects, only 9999 maximum of called objects get displayed. User can create the using depth of 99, but if the number of records is more than the Preferred Volume Limit, then depth is automatically get adjusted so that number of records is nearest to Preferred Volume Limit. The limit set to 0 means all the objects with a depth up to 99 are shown.
· Google Drive Export
· Allow Export to Google Drive as DOCX: Check this option to allow Google Drive export in the DOCX format.
· Allow Export to Google Drive as XLSX: Check this option to allow Google Drive export in the XLSX format.
· Program Structure Chart
· Default View Level: Program Structure Chart display up to 20 levels. Select an appropriate level. The default level is 13.
· Variable Where Used
· Default View Level: Variable Where Used display up to 6 levels. Select an appropriate level. The default level is 1.
· Level 5 Cascading depth: Specify the depth of cascading calls, which the VWU level 5 will go tracking for the cascading parameters.
· Object Where Used
· Entry Level References: The Entry Level References need to gather information about calling program and then, in turn, calling program of calling program. This setting specifies the number of maximum recursions made while querying for the calling program. The default level is 7.
· Default Source Editor
· LPEX: LPEX editor is checked by default for IBM Rational products having RSE plugin. It implies that the source member will be displayed in LPEX editor for editing purpose.
· 5250 Emulator: 5250 Emulator is the default option for non-RSE plugin. It implies that the source member will be displayed in a 5250 session for editing purpose.
· Others
· No. of records to display: Displays the total number of records to be displayed in any *FILE object when the View Data option is executed.
· Pseudo Code Indentation Depth: This was hard coded to 4, but now the user can set the depth as required or better presentation. Default depth is 4.

[bookmark: _Toc97719599]X-Data Test Preferences
Expand the X-Data Test node to view/modify the X-Data Test Preferences.
[image: ]
Fig. 2.8.1 – X-Data Test Preferences
You can modify the following X-Data Test Preferences:
· Compare Test Result: Specify the Number of records to display (process); 100 records per table, by default.
· JSON Comparison Mode
· Short Name: Compare short name of the fields
· Long Name: Compare long name of the fields
[bookmark: _Toc97719600]X-DB Transform Preferences
You can modify the following X-DB Transform Preferences:
[image: ]
Fig. 2.9.1 – X-DB Transform Preferences
· Search and Replace Settings
· Enable duplicate checking for import: Enable duplicate check for search and replace import but, enabling them will slow down the import process.
· Activate preview when opening page: It allow user to implicitly execute preview when opening multiple numbers of pages.
· Oracle Specific Setting
· Table tablespace name: Oracle specific Table tablespace name can be mentioned here.
· Index tablespace name: Oracle specific index tablespace name can be mentioned here.
· Log Level
· Transform Log Level: Changing log level generates X-DB Transform log with appropriate information.
· Verification Log Level: Changing log level generates X-DB transform integrity verification log with appropriate information.
	[image: ]
	Preference changes will take effect for the new X-Analysis Instance.


[bookmark: _Toc97719601][bookmark: 1897438370]Application Library
[bookmark: _Toc97719602]Work with Application Libraries
The Application Libraries view is the first X-Analysis view that displays all the added applications.
[image: ]
Fig. 3.1.1 – Application Libraries view 

	[image: ]
	A warning will be displayed when the user attempts to open the cross-reference with a CCSID different from the current CCSID of IBM i.


[image: ]
Fig. 3.1.2 – Warning Message 

[bookmark: _Toc97719603]Application Library Menu Options
Select the cross-reference library and opt for the context menu which displays the following pop-up menu:
[image: ]
 Fig. 3.2.1 – Context menu for the X-Ref

[bookmark: _Toc97719604]New Application Area
X-Analysis creates an application area from part of one or multiple systems. It is possible to programmatically subdivide an application into logical modules or areas. For more details, refer to the section Application Area List.
[bookmark: _Toc97719605]Application Library List
The Application Library List is used to view/update the list of object and source libraries for the selected cross-reference. This feature allows you to add or remove any library or even change the sequence number. However, you need to re-initialize to see the effect after changing the application library list. To view/change the application libraries, opt for the context menu on the application library and select the Application Library List option. The following dialog box is displayed:
[image: ]
Fig. 3.3.1 – Application Library List dialog box
The Application Library List dialog box displays the list of libraries for the selected cross-reference library. You can add new libraries to the existing cross-reference library list. Provide a valid library name in the Library Name text box and choose the appropriate Type for the added library from the drop-down (it could be an object, a source, or a model library). Then click Add to add the library to the existing library list. Re-initialize the cross-reference library to see the change.
[bookmark: _Toc97719606]Affinity Comparison
The Affinity Comparison option is allowed on the X-Ref library as well as an application area.
The Affinity Comparison option at the X-Ref library displays all the objects belonging to one or more application areas along with the affinity comparison of those objects.
In the following window, the rows display the objects which exist on one or more application area, whereas the columns display the names of all the application areas belonging to the X-Ref library.
[image: ]
 Fig. 3.3.2 – Affinity Comparison window for XAN4CDXA

[bookmark: _Toc97719607]Refresh Options
The submenu has the following options:
· Initialize Cross-Reference
· Refresh Cross-Reference
· Rebuild Data Model
· Repository Refresh Log
[bookmark: _Toc97719608]Initialize Cross-Reference
The Initialize Cross-Reference option initializes the cross-reference library to reflect the changes made to the cross-reference library. Select the option from the Refresh Options submenu on the context menu of the cross-reference library. The following dialog gets displayed on selecting this option:
[image: ]
 Fig. 3.4.1 – Confirmation dialog for Initialize Cross-Reference option
Click Yes to submit a new batch job for initializing the cross-reference library.
The batch job processing on the server is displayed as below:
[image: ]
 Fig. 3.4.2 – Initialize Cross-Reference – Job Log view
	[image: ]
	The Initialize Cross-Reference option gets enabled only for the new cross-reference application.


[bookmark: _Toc97719609]Refresh Cross-Reference
The Refresh Cross-Reference option refreshes the Cross-reference library (repository) to reflect the changes, if any, made to the base (Object / Source) libraries of the Cross-reference library. This option only refreshes the sources and objects that have already been initialized; it will not look at the freshly-added or deleted sources and objects.
Select the Refresh Cross-Reference library option from the Refresh Options submenu on the context menu of the cross-reference library.
[image: ]
 Fig. 3.4.3 – Context menu option for Refresh Cross-Reference
The following dialog is displayed:
[image: ]
 Fig. 3.4.4 – Refresh Cross-Reference dialog box
Click OK to execute a batch job and refresh the cross-reference for any changes.
This action locks X-Analysis Plugin. After the Refresh process is over, the lock on X-Analysis Plugin is released.
[bookmark: _Toc97719610]Rebuild Data Model
Select the Rebuild Data Model option to bring up the Rebuild Data Model dialog.
[image: ]
 Fig. 3.4.5 – Rebuild Data Model dialog box
Click OK to unselect the application and submit the modelling command in batch mode. The process locks the application.
[bookmark: _Toc97719611]Repository Refresh Log
The Repository Refresh Log view displays a list of commands executed over the selected cross-reference library. Select the option from the Refresh Options submenu on the context menu of the cross-reference library.
[image: ]
 Fig. 3.4.6 – Repository Refresh Log
The log contains information about the user who executed the command and its date and time details. Only the following commands were reported:
· Application Initialization (XA4INIT)
· Data Model Generation (XDMODEL)
· Business Rules Extraction (XGENBRULES)
· X-Resize Initialization (XRESIZE)
· Application Refresh (XREFRESH)

[bookmark: _Toc97719612]Derive Business Rules
The Derive Business Rules option is available on the context menu over the application library, an application area, and on an individual *PGM or *MODULE type objects of RPG/RPGLE or CBL attribute. For more details, refer to the section Business Rules Analysis.

[bookmark: _Toc97719613]Import Options
The Import Options submenu has the Application Area using Excel Sheet as the only option. Select the option to open a dialog box. Browse for the pre-defined format of the Excel document.
[image: ]
 Fig. 3.5.1 – Application Area using Excel Sheet

	[image: ]
	The pre-defined format for the Excel sheet is available in the "format" folder available in the %appdata%\X-Analysis folder.
Also, note the categories given the Excel sheet must be updated using the description given in the Application Area Options section. The columns should have valid entries to avoid any errors/warnings. The XA client does not authenticate the value given in corresponding columns. Hence, it is recommended to correctly update the sheet.


[image: ]
 Fig. 3.5.2 – Format folder containing the Excel document
The screen format is shown below:
[image: ]
 Fig. 3.5.3 – Excel sheet – Pre-defined format
Refer to the screen for the data loaded from the Excel document.
[image: ]
 Fig. 3.5.4 – App Area Rules editor window
Right-click on the required row to delete the entries; save the changes by clicking the Save icon marked on the above screen. The rule can then be viewed in the Application Area Rules editor window on Eclipse.
[bookmark: _Toc97719614]Export Options
This submenu has the following options:
· Export as DDL
· Generate Database Service Programs
· Export CRUD Spreadsheet
[bookmark: _Toc97719615]Export as DDL
The Export as DDL option exports Data Model information as Data Definition Language to the application folder. This information may be used by any database management system, for example, Oracle or SQL server, to create a similar data model. For details, refer to the section Export as DDL from X-Analysis.
[bookmark: _Toc97719616]Generate Database Service Programs
The Generate Database Service Programs option calls the XWRTDBSP IBM i command and submits the job in batch. For details, refer to the section Generate Database Service Programs.
[bookmark: _Toc97719617]Export CRUD Spreadsheet
The Export Crud Spreadsheet option exports the metrics to a spreadsheet where the rows represent the program name and columns depict the file name. In the spreadsheet, each cell represents the way a program is using a file that is, Create, Read, Update or Delete.

[bookmark: _Toc97719618]Document Entire Application
Refer to the section Document Manager.
[bookmark: _Toc97719619]Document Changed Objects
The Document Changed Objects option documents those objects, which have changed since the last initialization was run on the cross-reference library. This option is available on the context menu of the application library. For more details, refer to the section Document Manager.

[bookmark: _Toc97719620][bookmark: -1298416235]Reengineer Programs
The Reengineer Programs option submits a batch job which performs the two tasks – Reengineering and Service Modules generation. The batch command (XREGENS) reengineers the client programs in such a way that the old code in RPG/RPGLE free/fixed format gets converted into a free format procedure-based module. It does not change the program structure. The subroutines are converted into procedures. 
The Reengineer Programs option is available on the context menu of the application library and application areas and also available on individual *PGM type objects, which are under the Modernization Options submenu. Select this option to display the following dialog: 
[image: ]
Fig. 3.6.1 – Reengineer Programs dialog box
Click OK to submit a batch job.
The following window displays the progress of the batch job.
[image: ]
 Fig. 3.6.2 – Batch Job Progress view
At any point, while the batch job is running, click the hyperlink (*ACTIVE) to view the Job Log. The Job Log view is shown below:
[image: ]
 Fig. 3.6.3 – Job Log view 
The ‘Task Completed’ message is displayed once the process is complete.
Now, double-click on the Screen Components node available under the cross-reference node in the navigation pane. It displays the Screen Components for the application. This option is also available for application areas.
[image: ]
 Fig. 3.6.4 – Screen Components

[bookmark: _Toc97719621]Inter-Repository Options
X-Analysis provides an option to compare database files across two cross-reference libraries. The options available are as under:
· Generate Difference Analysis
· Display Difference Analysis
· Customized Libraries
· Generate PTF Analysis
· PTF Analysis
· Manage Linked Repositories
For detailed description, refer to the section Inter-Repository Options.

[bookmark: _Toc97719622]Audit Options
X-Analysis provides the following Audit Options:
· Metrics Analysis
· Screen Metrics
· File Metrics
· Business Process Logic Metrics
· Specialized Analysis
· Problem Analysis
· Object Allocation
· Database Summary
· Summary Report
· Initialize Source Archiving
· Generate Metrics Analysis
· Edit Problem Audit Limit
· Edit Problem Categories
· Generate Problem Analysis
· Track Database Changes
· View Database Size Statistics
For detailed description, refer to the section Audit Options.

[bookmark: _Toc97719623]Work With Multiple List Options
X-Analysis facilitates you to work flexibly and methodically by generating multiple lists. Under an application library, double-click on these nodes – Files, Programs or All Objects – to display the Work with Objects dialog. Alternatively, click Member List from the toolbar to bring up the Work with Members dialog. Likewise, you can access additional lists by double-clicking on the Source Files node to view the source list comprising source files. 
Double-click on an individual Source File to view its Member List. The various lists that can be generated are as under: 

	Lists
	Brief Description 

	Object List  
	Displays a list of all/specified objects. 

	Member Lists
	Displays a list of all /specified source members.

	Source Files
	Displays a list of all source files.

	Business Rules
	Displays a list of all business rules and their narrations.

	Consolidated Rule
	Displays a list of all rules based on file-field combination. 

	Screen Components
	Displays a list of all reengineered components.

	Change History
	Displays a list of all source members that are modified. 

	Procedures
	Displays a list of all procedures.

	 X-Analysis Bookmarks
	Displays a list of objects that are bookmarked.

	Application Area List
	Displays a list of Application areas. 



[image: ]
 Fig. 3.7.1 – Application Library view
[bookmark: _Toc97719624]Object List
The Object List displays a list of all objects of the specified type from the selected library. Double-click on the All Objects node under the cross-reference library (XAN4CDXA) to bring up the Work with Objects dialog.
[image: ]
 Fig. 3.8.1 – Work with Objects dialog
The Library drop-down box contains the following two important entries, apart from the user libraries:
· *ALLUSR – All objects belonging to the user libraries
· *ALL – All objects (including those in the X-Ref lib)
The default option is *ALLUSR.
	[image: ]
	Object Name - An individual name/a generic name/ ‘*ALL’.
Both individual and generic names can have wildcards specified. Enter & (Ampersand) to denote that any one character and * (Asterisk) denotes any number of characters. Accordingly, C&&H* means that all the object names where the first character is C and fourth character is H, will be selected. More examples: AA&&2, OE*.


[bookmark: _Toc97719625]All Objects
When you click the All Objects node, the Work with Objects dialog (as shown above) is invoked with the Type/Attribute set as *ALL. Click OK to get the All Objects list.
[image: ]
Fig. 3.8.2 – All Objects List
The columns that appear in the All Objects list are described below:
Library: displays the name of the Object Library.
Name: displays the name of the object. If the Preferences setting for Show Long names for Files are selected, then long names for *FILE defined as DDL would get shown in this column. Click the toggle button provided on the editor toolbar to see the long names. The following sample screenshot shows the long names after the toggle button has been clicked.
[image: ]
 Fig. 3.8.3 – All Objects list – showing the Long Names
Type: displays the type of object.
Attribute: displays the attribute of an object.
Description: displays textual description/long name of the object.
Status: displays the object’s status which will be either *A, *B, *C, or *D. The details are provided in the Component Status section. The Status in the Object list is set for specific types of Objects only.
· For Object type *PGM, *MODULE, *QMQRY, *QRYDFN, the value of *A, *B, *C, and *D is set.
· For Object Type *FILE and Attribute PF/PF38 etc., the value is set by the data modeling process to *A, *B, *C, *D. After Initialization, when modeling has not been performed, the value is set as blank.
· For all other Object types, the process does not assign any value to the status column, and it is set as blank.
Changed: displays the date when the object was changed.
Created: displays the date the object was created.
Used: displays the date when the object was last used.
Days: displays the number of days this object has been used since creation.
Function: displays the function of the object. This applies to only program type objects and is explained later in this section.
The icons used in the All Objects list are denoted as below:
[image: ]
 Fig. 3.8.4 – All Objects Legend
Double-click on All Objects/Files/Programs under Application area node displays an additional column ‘Rule’ on the Object list. The ‘Rule’ column has the Application Area Rule Number against which the particular object is listed.
[image: ]
 Fig. 3.8.5 – All Objects list on an application area showing the Rule column
[bookmark: _Toc97719626]Programs
When you click the All Objects node, the Work with Objects dialog (as shown above) is invoked with the Type/Attribute set as *ALL. Click OK to get the All Objects list.
[image: ]
 Fig. 3.8.6 – Object List – Programs
The columns that appear in the Programs List are as follows:
Library: displays the name of the Object Library.
Name: displays the name of the program.
Type: displays the type of object; in this case it is *PGM.
Attribute: displays the object attribute like RPG/LE or CLP or CBL.
Description: displays textual description/long name of the program.
Status: displays the program status which will be either *A, *B, *C, or *D. The details are provided in the Component Status section on the following page.
Changed: displays the date when the program was changed.
Created: displays the date the program was created.
Used: displays the date when the program was last used.
Function: displays the function of the object. The various types are explained under the Function Type section.
PF Name: displays the name of the Physical File (or the Primary database file) related to an interactive program (i.e. a program that has any screen associated with it).
BR Count: displays the total count of business rules related to the program.
Annot. Count: displays the total count of business rule annotations related to the program.
Stmt. Count: displays the total count of the statements in the source list of the program.
Screen Count: displays the total count of screens recovered by the re-engineering process.
Mode Count: displays the total count of modes available to access the screens belonging to a program.
Double-click on the list item opens the object’s source code in the source browser.
	[image: ]
	The columns PF Name, Screen Count and Mode Count provide information specific to the Modernization tool and have no relevance for X-Analysis View/Advisor users.Files


Similarly, double-click the Files node under XAN4CDXA to bring up the Work with Objects dialog with the Type/Attribute set to *FILE/PF. Double-clicking on the All Objects node re-sets the Type/Attribute to *ALL/*ALL.
The following screen displays the Object List for Files:
[image: ]
 Fig. 3.8.7 – Object List – Files
The description of the columns that appear in the Files List are as follows:
Library: displays the name of the Object Library.
Name: displays the name of the file. If the Preferences setting for Show Long names for Files is selected, then long names for *FILE defined as DDL would get also shown in this column.
Type: displays the type of object; in this case it is *FILE.
Attribute: displays the object attribute like PF, LF, DSPF or PRTF.
Source Attribute: displays the object enhanced attribute like Index, View, PF-SQL, PF-DDS, Alias, LF-DDS, Query-Table.
Description: displays textual description/long name of the file.
Status: displays the file status which will be either *A, *B, *C, or *D. The details are provided in the Component Status section on the following page.
Changed: displays the date when the file was changed.
Created: displays the date the file was created.
Used: displays the date when the file was last used.
Stmt. Count: displays the total count of the statements in the source list of the file.
Format Count: displays the total count of screen formats related to a file.
	[image: ]
	The displayed Object List is sorted on an object's name in ascending order. Click the respective column heading to change the sort order.


To narrow down the search, the object name on the object group may be mentioned as well. It can be:
· *ALL
· Object Name (maximum 10 characters long).
Besides the other settings, the following can also be specified on the dialog:
Component Status
The Component Status can be picked up by selecting appropriate status, for example, *A, *B, etc. under the Function Attributes section.
Please note that the Component Status calculation for programs will not take self-calls into account.
[image: ]
 Fig. 3.8.8 – Work with Objects dialog showing Component Status
Component Status for Programs
· *A – Parent or top-level program that is, calls other programs but is not called itself
· *B – Program is called by another and calls other programs
· *C – Program at the end of a program tree; does not call other programs
· *D – Standalone program
Component Status for Files
· *A – Accessed by other files, but does not access any other file
· *B – Accesses other files and gets accessed by other files
· *C – Only accesses other files, not accessed by others
· *D – Standalone file
[bookmark: _Toc97719627]Function Type
This describes the function of the object and based on COOL: 2E definitions.
[image: ]
 Fig. 3.8.9 – Work with Objects dialog displaying Function Type
The Function Attributes apply to program type objects only. The available Function Types are defined here:
*ALL – Displays all objects; no function filter is applied.
DSPDEV – Defines a program which includes the Display file/s.
DSPFIL (Display File) – Defines a program which displays the records from a specified file, many at a time, using a sub-file.
DSPOTH (Display Other) – Defines a program which displays records from Display File(s) and does not have any file(s) in update/write/read mode. Also, the program does not have any Printer File(s).
DSPRCD (Display Record) – Defines a program which displays a single record from a specified database file.
DSPRCD2 (Display Record 2 panels) – Defines a program that is identical to the DSPRCD function, except that it allows the database record details to extend to two separate display device pages.
DSPRCD3 (Display Record 3 panels) – Defines a program that is identical to the DSPRCD function, except that it allows the database record details to extend to three separate display device pages.
DSPTRN (Display Transaction) – Defines a program which displays the records from a specified pair of database files. The pair must be connected by an Owned by or Refers to relation.
EDTFIL (Edit File) – Defines a program which maintains records on a specified file, many at a time, using a sub-file.
EDTRCD (Edit Record) – Defines a program which maintains (add, change, and delete) records on a specified file, one at a time.
EDTTRN (Edit Transaction) – Defines a program which maintains the records on a specified pair of header and detail files. The pair must be connected by an Owned by or Refers to relation.
EDTRCD2 (Edit Record 2 panels) – Is identical to the Edit Record function, except that it allows the record details to extend to two separate display pages.
EDTRCD3 (Edit Record 3 panels) – Is identical to the Edit Record function, except that it allows the record details to extend to three separate display pages.
EXCUSRPGM (Execute User Program) – Defines a program which allows a user to describe the interface to a user-written HLL program so that it can be referenced by functions.
EXCUSRSRC (Execute User Source) – This function is applicable for Synon/2E applications. Synon/2E allows a user to describe the interface to a user-written High-Level Language program so that it can be referenced by function. This function type is assigned to such programs.
OTH (Other) – Defines a program which calls a program and does not have any files in update/write/read mode. Also, the program does not have any Display File(s) or Printer File(s).
OTHCAL (Other Call) – It is identical to the OTH function except that it allows call with parameters.
OTHFIL (Other File) – Defines a program which accepts files in input mode and does not have Printer File(s), Display File(s) or any other files in update/write mode.
PMTRCD (Prompt Record) – Defines a program which prompts for a list of fields defined by a specified access path. The validated values can be passed to any other function.
PRTDSP (Print Display) – Defines a program which Display/Print records from input files and does not have any files in update/write mode.
PRTFIL (Print File) – Defines a program which prints records from a specified access path.
PRTDEV (Printer Device) – A program which includes a printer file.
SELRCD (Select Record) – Defines a program which displays the records from a specified file, many at a time, using a sub-file. The program allows you to select one of the records. The selected record is returned to the calling program. This function is called from a function that requested a selection list.
TRGFUN (Trigger) - A program which is associated with a PF having triggers is considered as TRGFUN in the object list.
UPDFIL (Update File) – Defines a program which updates specified files and does not have any Printer File(s) or Display File(s).
UPDOTH (Update Other) – Defines a program which updates data areas and has Display File(s). The program neither has a Printer File(s) nor files in update/write/read mode.
UPDPRT (Update Print) – Defines a program which prints a report with update(s) from the specified printer files. It does not have display files.

[bookmark: _Toc97719628]Member List
The Member List option displays the list of source members for a specified source file of the selected library. The Member List contains the members available in the selected library and the source file, based on the selected criteria.
Click the Member List icon to invoke the following dialog:
[image: ]
 Fig. 3.9.1 – Work with Members dialog box
Specify the selection criteria on the dialog to display a set of members.
1. Select the Source File and the Library using the drop-down list from the Library/Source File Name. Select *ALLUSR as the library name to prevent the source files in the cross-reference library from getting displayed.
2. The Member name on the Member Details group can be:
· *ALL
· Member Name (maximum 10 characters long)
3. Select the Type from the drop-down list.
4. Click OK.
	[image: ]
	Member Name - An individual name/a generic name/ ‘*ALL’.
Both individual and generic names can have wildcards specified. Enter & (Ampersand) to denote that any one character and * (Asterisk) denotes any number of characters. Accordingly, C&&H* means that all the member names where the first character is C and fourth character is H, will be selected. More examples: AA&&2, OE*.


The following screen displays the list of members for the selected criteria. Select any member and double-click to invoke its Source List.
[image: ]
 Fig. 3.9.2 – Member List
	[image: ]
	The first screen is sorted on the member name in ascending order. To change the sort order or to sort on any other column, click the respective column heading.



[bookmark: _Toc97719629]Source Files
Double-click on the Source Files node to generate a list of all the source files. The option is available under the cross-reference node. Double-click on any source file to display the Member List.
[image: ]
 Fig. 3.10.1 – Source File List

[bookmark: _Toc97719630]Business Rules
The program source is grouped into discrete blocks of logic so that each block represents a particular execution of business logic. This block of code is then converted into pseudo code that describes the execution of the logic. Literals and constants are liberally used in the narration, wherever possible, giving accurate descriptions of the logic. These logics are termed as Business Rules.
The Business Rules option displays a list of all the business rules and their narrations for the selected cross-reference library. The Business Rules node is available under the cross-reference node.
[image: ]
Fig. 3.11.1 – Business Rules for XAN4CDXA

[bookmark: _Toc97719631]Consolidated Rules
X-Analysis provides an important feature related to file-fields and business rules. Through this feature the user can view all the business rules related to a file-field. Double-click the Consolidated Rules node to invoke the following window:
[image: ]
 Fig. 3.12.1 – Consolidated Rules for XAN4CDXA
Select any business rule listed under a file and expand the business rules node to check the actual business rules code used, as shown below: 
[image: ]
 Fig. 3.12.2 – Expand Business Rules node to see the actual code
When you right-click for the context menu of an object (*FILE type) from the Object List or Member List, you will get the Programs to Consolidate option as shown below:
[image: ]
 Fig. 3.12.3 – Right-click menu showing the Programs to Consolidate option
Click this option. A list of programs having consolidation rules for the corresponding file-field is displayed.
Select the program(s) to be excluded from the consolidation processing. Check the corresponding box(es) provided under the Exclude column.
[image: ]
 Fig. 3.12.4 – Programs to Consolidate window showing the Excluded program, WWCONDET
Now select the Consolidated Rules option again (on the originally-selected object or the entire X-Ref library). You will notice that the programs other than WWCONDET are grayed out. The following screenshot shows the Consolidated Rules display taken on the originally-selected object, CONDET.
[image: ]
 Fig. 3.12.5 – Consolidated Rules display on CONDET
When the Allow editing in Consolidated Rules box is checked from the Preferences setting, you will see checkboxes in the Consolidated Rules window. The corresponding boxes can be checked/unchecked to show/hide the exportable rules.
[image: ]
 Fig. 3.12.6 – Consolidated Rules window showing the checkboxes

[bookmark: _Toc97719632]Change History
The Change History option lists the source members that have a had modification done after the first initialization was done. To ensure that Change History does show data, you must Initialize Source Archiving. Once the Source Archiving is initialized, then any Refresh or Initialization done for the cross-reference will record the metrics history for the changed source members. 
	[image: ]
	More details about Initialize Source Archiving can be found in the Audit Options section of this document. 


Double-click the Change History node under XAN4CDXA to invoke the following Work with Change History dialog: 
[image: ]
 Fig. 3.13.1 – Change History dialog for XAN4CDXA
Click OK to invoke the following window.
[image: ]
 Fig. 3.13.2 – Change History window for XAN4CDXA
Select a row and right-click on it for the context menu to call up a suitable source compare window. The following screen displays the context menu against a selected row:
[image: ]
 Fig. 3.13.3 – Context Menu displaying Source Compare Options
You can also view this data in program sequence. For this, click the Order by Program option available on the toolbar.
[image: ]
 Fig. 3.13.4 – Order by Program option
Now the Change History window will be re-ordered by the name of the programs:
[image: ]
 Fig. 3.13.5 – Change History – Order by Program window

[bookmark: _Toc97719633]Regenerated Programs
You can view the list of regenerated programs through the Regenerated Programs node.
[image: ]
 Fig. 3.14.1 – Regenerated Programs node
Double-click the node to invoke the following window:
[image: ]
 Fig. 3.14.2 – Regenerated Programs window

[bookmark: _Toc97719634]Source Scan
The Source Scan feature works on the entire source and thus, helps you scan particular text (also comments) used in a prescribed source member, or in general, all across the application/application area.
The node is available on the navigation pane, as shown below:
[image: ]
Fig. 3.15.1 – Source Scan node
Double-click the node to invoke the Work with Members – Source Scan dialog.
[image: ]
Fig. 3.15.2 – Source Scan dialog
You can provide a maximum of 120 character in the ‘Search Text’ box. The ‘Search Text’ supports use of AND or OR as well as parentheses to create a complex condition.
· AND - Both search words must be there in the same source line.
· OR - If either word is present in the source line.
However, in case a sentence/ phrase has to be scanned, the user must include it within the double quotation marks (“”). For example –
· "EXEC SQL" will scan and show all lines which contains the “EXEC SQL”.
· ((EXEC OR SQL) AND (DECLARE OR INSERT)) will scan and show all lines which contains statements – for example, the “EXEC” AND “DECLARE” statement or “SQL” AND “INSERT” statement.
You can limit the scan by selecting appropriate details in the other drop-down boxes. In this way you will get results quickly. The words mentioned in the ‘Search Text’ box scans the source member(s) for comments (if any) containing the keywords. When a specific member was declared in the ‘Member’ box, the search is narrowed for that particular member. However, the search yields result for all members when ‘Member’ field has *All or left Blank.
The Source Scan will display results from linked repositories (if any) as well. You can always check/uncheck the Include results from linked repositories (if any) option to include/exclude the linked repositories.
Select the Member Details as required and fill in the keyword/s, as is shown below.
[image: ]
Fig. 3.15.3 – Source Scan dialog – with details
When the scan is complete, the Source Scan result is displayed. Additionally, the result can be filtered to hide comments by using the Hide Comments/Show All toggle button in toolbar as shown below:
[image: ]
Fig. 3.15.4 – Window displaying Source Scan result
[image: ]
 Fig. 3.15.5 – Window displaying Source Scan result
The Source Scan functionality is used to scan a particular Application Area. When an application area is expanded, the Source Scan node appears as shown below:
[image: ]
 Fig. 3.15.6 – Source Scan Node
[image: ]
 Fig. 3.15.7 – Source Scan dialog box – Application Area

[bookmark: _Toc97719635]Field Search
The Field Search node is an alternative to Variable Where Used. Using this Field Search node, the user may search for a set of fields with similar names or a field where the user may not be able to recall the exact field name, but just remember a part of it. 
 The node is available on the navigation pane, as shown below: 
[image: ]
Fig. 3.16.1 – Field Search node
[image: ]
 Fig. 3.16.2.A – Field Search dialog box with details
[image: ]
 Fig. 3.16.2.B – Field Search dialog box with details
[image: ]
 Fig. 3.16.2.C – Field Search dialog box with details
The user can select Field Type from the drop-down list that is by default set to All Types. When a Field Type gets changed, the dialog box will take fixed values for various selections, and the user will not be allowed to modify the Occurrence field, Fetch All records, and Allow Constants.
You can also search for constants by checking the Allow Constants box. It will bring the first 5000 searches, and then allow to fetch next from the view. Selecting Fetch all records will get all the records at the first time.
Press Search. The following screen displays the search results for CUSNO.
[image: ]
Fig. 3.16.3 – Field Search window showing results for CUSNO

	[image: ]
	Field Search will work only on fields and constants identified by the X-Analysis initialization process. Keywords, user comments, and other such data are not included.



[bookmark: _Toc97719636][bookmark: -795179761]Procedures
Select the Procedures node to access procedure-related information. This node is available on the navigation pane of the application. Expand the Procedures node to display four sub-nodes as shown below:
[image: ]
Fig. 3.17.1 – Procedures node
These options are discussed as under:
1. All Procedures
2. Exportable Functions
3. External Procedures
4. SQL Procedures
[bookmark: _Toc97719637][bookmark: 38013196]All Procedures
The first option under the Procedures node is All Procedures.
Select All Procedures to display a list of members. The members in this list have procedures defined in their source code and the list of names of exported procedures and variables in a module. If the procedure is present in module as well as Service program, the one from the service program is excluded to avoid duplicates in this list.
	[image: ]
	As indicated in the definition above, the All Procedures List includes Exportable Functions data.


[image: ]
Fig. 3.17.2 – All Procedures option
Right-click on a row to access the Zoom Source or Variable Where Used option.
[image: ]
Fig. 3.17.3 – Context menu on a Procedure Name
[bookmark: _Toc97719638][bookmark: -370924368]Exportable Functions
Select the Exportable Functions option to display the list of names of exported procedures and variables in a module, which can be referred to by other modules.
[image: ]
Fig. 3.17.4 – Exportable Functions List
Right-click on a row to select the Zoom Source or the Variable Where Used options.
[bookmark: _Toc97719639][bookmark: -1358805946]External Procedures
The third option under the Procedures node is External Procedures. This option registers high-level language program like RPG, Java, C#, etc. as a stored procedure. However, the procedure may or may not use SQL.
Select the External Procedures option to invoke the following window:
[image: ]
 Fig. 3.17.5 – Window – External Procedures List
Right-click on a row for the context menu and select the options to view the Zoom Source, Data Flow Diagram, and the Object Where Used/Variable Where Used references.
[bookmark: _Toc97719640][bookmark: -292874875]SQL Procedures
The last option under the Procedures node is SQL Procedures. This option presents the entire procedure coded with SQL. The option follows the SQL Standard (PSM) and allows ‘normal’ DDL/DML SQL, in addition to procedural statements.
The following window appears on selecting the SQL Procedures option:
[image: ]
 Fig. 3.17.6 – Window – SQL Procedures
Right-click on a row will show the context menu through which you can view the Zoom Source, Data Flow Diagram, and the Object Where Used/Variable Where Used references.

[bookmark: _Toc97719641]Application Area List
X-Analysis allows easy subdivision of an application into business areas or application areas. The user can split the application areas further into sub-application areas for better application analysis. For analyzing an application/application area, X-Analysis provides a hierarchical listing of application areas called the Application Area List.
The Application Area List is provided as an option on the Navigation panel. It is the first option under the cross-reference library node.
[image: ]
 Fig. 3.18.1 – Application Area List
Double click on the above option to open the Application Area List.
[image: ]
 Fig. 3.18.2 – Application Area List
The Application area list provides the users a hierarchical listing of all the application areas presents in the selected Xref (including the child/nested app area up to level n). The list provides the details of the application area such as Refresh Seq, Lock Flag, Allow Refresh, Parent App Area, Level, and Owner.
User can also add a new application area at the top(root) level using the ‘+’ icon on the toolbar.
Parent App Area
It displays parent of each application area with full hierarchy. Suppose we have an application area A such that ( A -> A1 ( Nested/child app area ) -> A2 ( Nested/child app area ) ). In this case the parent app area for A2 will be displayed as A/A1.
Level
This listing provides depth detail of each application area, that is, parent application area with level 1, a child with level 2, and so on.
Owner
The profile/username of the user, who created a particular application area, is listed in the Owner column. There is no Owner for the application areas in demo cross-reference and those created with an older version and carried on to the latest version of X-Analysis. This information was not captured in the older versions of X-Analysis.
Right-click on the lists presents a context menu. Selecting ‘Open Application Area’ or double-click will open the selected application area on the Navigation pane. Options under the ‘Application Area Option’ are similar to what we get on right-click on an Application area node on the navigation panel.
[image: ]
 Fig. 3.18.3 – Application Area Rules
[bookmark: _Toc97719642]Adding Filter on Application Area List
By this feature, the user can filter the list of Application Area, Description, and Owner by the filtering box available on the top of the respective columns. Hence, it helps the user to identify the application area with a particular description very quickly. Refer to the screen below where the filtering process is displayed in detail:
[image: ]
 Fig. 3.18.4 – Providing Filtering Text
[image: ]
 Fig. 3.18.5 – After Filtering
While entering the filter text in the filtering box of the Application Area, Description, or Owner, the user must ensure the following:
· The user should always add prefix ‘*’ before the filter text.
· The filter text is not case-sensitive. For example, if the user enters a text “*PL*” as a filtering criterion, the filtering box will filter and display all text with “Pl” and “pl” along with the text “PL”.
· After adding the filter text, it is not required for the user to press <Enter>. The filtering text gets automatically updated and displayed in the Application Area List.
· If any filtering criteria already exist in the Application Area List and the user wants to add a new filtering criterion, then the new filtering criteria will complement the existing filtering criteria.
· If the user adds a New Application Area within the Application Area List with some existing filtering criteria, then the Application Area List will display that New Application Area, only if it matches the existing filtering criteria.
If the New Application Area created by the user does not match the filtering text, then it will not be displayed in the Application Area List. But once the user removes the filter, the New Application Area created will get displayed.
For example, refer to the below screen where a new Application Area, SALESP created in the Application Area List get displayed as it matches the filtering criteria in the Application Area.
[image: ]
 Fig. 3.18.6 – Application Area List SALESP
· If the user changes the Description for any Application Area when the filtering criteria is effective, then the change Application Area will be displayed in the Application Area List, only if it matches the existing filtering criteria.
If the Change Application Area created by the user does not match the filtering text, then it will not be displayed in the Application Area List. But once the user removes the filter, the Change Application Area created will get displayed.
[bookmark: _Toc97719643]Export Option
Application Area List provides various export options such as Export to PDF, Export to Microsoft Word, and Export to Microsoft Excel. Refer to the screen below:
[image: ]
 Fig. 3.18.7 – Export Option
Adding filtering criteria in the Application Area List enhance the export option. If the user, uses the export option with filtering content, then the export option will display only the sorted content in the form of PDF, Word, or Excel rather than exporting the entire content.
Refer to the screen below for the sorted content in the form of PDF, Word, or Excel. For example, if the user put the filter text “*CO” in the Application Area column.
[image: ]
 Fig. 3.18.8 – Application Area List
[image: ]
 Fig. 3.18.9 – Export to PDF
[image: ]
 Fig. 3.18.10 – Export to MS Word
[image: ]
 Fig. 3.18.11 – Export to MS Excel

[bookmark: _Toc97719644]Obsolete Object Management
Objects which are no longer in use or may have been replaced by any other objects are defined as an Obsolete Object. Select any desired object from the Object List and right-click to view the context menu. Click option Set Obsolete Object Flag as shown below:
[image: ]
 Fig. 3.19.1 – Set Obsolete Object Flag
A message will be prompted that will ask you to confirm the mark. Click Yes to continue.
[image: ]
 Fig. 3.19.2 – Set Obsolete Object Flag
Marking an object as obsolete will make its entry in the Problem Analysis. Select the Problem Analysis option from the Audit Options under the context menu on cross-reference to display the Problem Analysis data.
The Problem Analysis window displays the Obsolete Object category under the Obsolete Object Management node. It will show the record of all objects marked as obsolete. The Additional Detail column for Obsolete Object indicates the user, date and time on which the particular object was marked as obsolete.
[image: ]
 Fig. 3.19.3 – Set Obsolete Object Flag
The Obsolete Object Dependency category shows all the objects dependent on the selected Obsolete Object. The Additional Detail column for Obsolete Object Dependency indicates the associated Obsolete Object name. Refer to the screen below:
[image: ]
 Fig. 3.19.4 – Set Obsolete Object Flag
If the user marks the same object for the Obsolete flag again, then the Obsolete flag will be removed. To remove the Obsolete flag, click Yes in the dialog box.
[image: ]
 Fig. 3.19.5 – Set Obsolete Object Flag

	[image: ]
	After a cross-reference Upgrade (Option=77) or a cross-reference is created using Copy & Initialize (Option=78), the user must Generate Problem Analysis again to get the Obsolete Object list.


[bookmark: _Toc97719645]Application Area
X-Analysis creates application areas from part of one or multiple systems. It is possible to subdivide an application, programmatically, into logical modules or areas. This can be within the context of a single system or specific parts from multiple systems. For example, you can have an application area like ORDERS, containing Order Entry details from Operational System, to represent a single system Application Area. You can also have an application area as ORDERS, containing Order Entry details from Operational System and Sales Ledger details from Financial System, representing the application area as a specific part from multiple systems. 
The Application Area feature facilitates the grouping of an application into different Business Areas. They are defined on the basis of certain criteria called Application Area Rules. Application Area Rules are, hence, a mechanism which categorizes an application into different Application Areas. 
· Create New Application Area
· Remove Application Area
· Adding Objects to an Application Area
· Removing Objects from an Application Area
[bookmark: _Toc97719646]Create New Application Area
You can create an application area by running the X-Analysis Client or using X4WRKAPP on IBM i. 
[bookmark: _Toc97719647]Using X-Analysis Plugin
Opt for the context menu on the cross-reference library and select the New Application Area option. This brings up a dialog box to add a new application area to the selected cross-reference library. 
[image: ]
 Fig. 4.1.1 – New Application Area dialog box
Enter the Name and Description as per your choice. The Refresh Sequence is Default (value of one more than maximum refresh sequence will be used by default). This value can later be modified through the Change Application Area dialog. The Parent Area field is for reference only and cannot be changed. If the Allow Refresh box is unchecked, the re-building of the newly-added application area during initialization/refresh processing will not occur.
You can create new app areas or modify the existing ones to use new or old methods through the IBM i side as well as the XA client. If you want to add a new app area or change an existing one, the value set for the data area XAPPARABLD in the X-Ref library will be taken into account. This data area may be set to *NEW or *PRV. In case this is set to *NEW, the new method will become the default. If this is set as *PRV, an additional checkbox called the Use New Build Method will get prompted on the XA Client. The existing users can check this box to use the new method for re-building the application area. Leaving this box unchecked will use the previous build method. For the new users, however, the *NEW build method will be set as default. The new method and the modified selected objects’ criteria will expedite the application area build process.
To select an existing application area, you want to copy the rules from, check the Copy Rule from an existing Application Area box.
Click OK to add the new application area to the cross-reference library.
[image: ]
 Fig. 4.1.2 – New Application Area added
[bookmark: _Toc97719648]Using X4WRKAPP on IBM i
Option 10 on the X4WRKAPP screen is used to define an application area.
[image: ]
Fig. 4.1.3 – X4WRKAPP Application Area screen
The Work with Application Areas display allows user to do the following:
Maintain Application Areas
Press F6, the command key to enter a definition for a new area. Use Options 2 and 4 to change or delete the current application areas. Use Option 5 to display the application area's details.
Specify the Rules that defines an Application Area (XARWKRLS)
Select Option 7.
Display the Objects in an Application Area (XARWKAAO)
Options 8 and 9 display the program objects and the file objects respectively. You can browse the source and display the Structure Chart Diagram and Data Flow Diagram from the object lists.
Verify the data model for an Application Area (XVERIFY)
Option 10 allows you to verify the data model subset defined in an application area.
Create a new library from an Application Area (XCRTALIB)
Option 11 allows you to create a new library containing only the files defined by an application area.
Create a test data subset using an Application Area (XSUBSET)
Option 12 allows you to create a test data subset using only the files defined by an application area.
Press the function key 'F6' to add a new application area, then press the ENTER key. Repeat this for each application area.
Any number of select or omit criteria can be added to ensure the area contains only the required objects.
Add an application area, OE001, as in 'XAN4CDXA - XAN4CDEM Tutorial System'.
[image: ]
Fig. 4.1.4 – X4WRKAPP Application Area screen
The entry of the powerful user-defined rules, combined with the information about the entire application stored in the X-Analysis repository, are applied by X-Analysis to make this an instant and repeatable task. These application areas can then be used to accurately and confidently put a ring around all objects impacted and required from projects such as re-engineering, re-development, replacement or project management allocation of development responsibility.
The Application Area facilitates the grouping of an application into different business areas, thereby making it easier to understand and maintain the application.

[bookmark: _Toc97719649]Adding Object to an Application Area
To add a given object to an Application Area, opt for the Object List first. Double-click on All Objects to bring up the Work with Objects dialog box.
[image: ]
 Fig. 4.2.1 – All Objects node
[image: ]
 Fig. 4.2.2 – Work with Objects dialog box
Few options in Type are enabled, for example, *PGM, *FILE, and *DTAARA including option, *ALL in the Work with Objects. Set the default Library, Name, Attribute, and Type as *ALL. Click OK, and a new window gets displayed.
[image: ]
 Fig. 4.2.3 – Select Name from the Library
Select any Name from the Library and opt for the context menu on it. Then, select Add to Application Area option, as shown below:
[image: ]
 Fig. 4.2.4 – Add to Application Area option
This option presents the following dialog:
[image: ]
 Fig. 4.2.5 – Add to Application Area
Select the application area in which you want to add the object and click OK.
To add the related objects, select the second option that is, Add to Application Area with Related Objects, as shown below:
[image: ]
 Fig. 4.2.6 – Add to Application Area with Related Objects
This option invokes the following dialog, depending on the selection Type that maybe, *PGM/*FILE/*DTAARA by the user.
If the user selects the option Type as *PGM, the below window gets displayed.
[image: ]
 Fig. 4.2.7 – Add to Application Area with Related Objects
If the user selects the option Type as *DTAARA, the below window gets displayed.
[image: ]
 Fig. 4.2.8 – Add to Application Area with Related Objects
If the user selects the option Type as *FILE, the below window gets displayed.
[image: ]
 Fig. 4.2.9 – Add to Application Area with Related Objects
Perform the steps given below:
1. Select the application area in which you want to add the object.
2. Choose the required Options for Related Objects from the dropdown menus as mentioned above.
3. Click OK.
This adds the objects to the application area fulfilling the criterions.

[bookmark: _Toc97719650]Removing Object from an Application Area
Opt for the Object List and select the object to be removed from the application area. Right-click for the context menu on that object and select Omit from Application Area as displayed below:
[image: ]
Fig. 4.3.1 – Omit from Application Area option
The following dialog will be displayed:
[image: ]
Fig. 4.3.2 – Omit from Application Area dialog
To remove the object, select the application area name and click OK.
	[image: ]
	When the Lock Flag box is checked, the Application Area can neither be changed nor deleted. Moreover, the rules cannot be changed, and user will be unable to add or omit any object to/from the Application Area. The OK button will be disabled, and a lock icon will appear against the locked Application Area (See Below).


[image: ]
Fig. 4.3.3 – Lock Icon

	[image: ]
	Unlock the Application Area by unchecking the Lock Flag box which is located under the context menu in the Options>Change Application Area.



[bookmark: _Toc97719651]Context menu on an Application Area
The context menu on an application area is displayed below:
[image: ]
Fig. 4.4.1 – Context menu on an application area

[bookmark: _Toc97719652]Application Area Options
The Application Area Options sub-group consists of the following:
· Application Area Rules
· New Application Area
· Move Application Area
· Move To Root
· Change Application Area Rules
· Delete Application Area
· Affinity Identification
· Affinity Comparison
[bookmark: _Toc97719653]Application Area Rules
Select the Application Area Rules option invokes a window that display the available ‘Application Area Rules’. These rules determine which objects need to be placed in that particular Application Area. The user may update/delete by using the right-click context menu on a row, or add new rules using the Add button from the editor toolbar.
[image: ]
 Fig. 4.5.1 – Application Area Rules dialog showing the Add Rule option
The following dialog will come up when the Add Rule button is clicked:
	[image: ]
	From version 13.2.13, X-Analysis is enhanced to reflect the Application Area Rules in two panel:
· General
· Object Usage


Option Object Usage now modified and added in a separate tab of Application Area Rules to regroup all the possible criteria around Object Usage.
The Application Area Rules with criteria based on Object Usage now contain a drop-down list to specify the System name to apply the rules. The default in the System tab is Local machine. The list contain all the system name that have object attributes from. Refer to Appendix N - Importing data from Production Machine Importing data from Production Machine for creating rules based on production data related information.
[image: ]
Fig. 4.5.2.A – Application Area Rules-General
[image: ]
Fig. 4.5.2.B – Application Area Rules-Object Usage
The various options in the Application Area Rules dialog are described as below:

	Feature
	Brief Description 

	Sequence
	The sequence number of the rule, which determines the order in which the rules are processed.

	Rule Type
	Select from
· Object (O): This specifies that the scope of the rule type for only an Object.
· Application Area (A): This specifies the scope of the rule type for an application area.
· Problem Analysis (P): This specifies the scope of the rule type on Problem Analysis Category.

	Rule Value
	When the Rule Type is set as Application Area (A), the Rule Value dropdown will display all the application area names; when Rule Type is Problem Analysis (P), then all the Problem Analysis categories are displayed.

	Selection
	Defines whether the specified Object(s) should be selected or omitted. Choose from: 
· S - Select
· O - Omit
· ' ' - AND - a further condition for the previous Select/Omit
If only Omits are specified, then a Select *ALL will be applied when the rules are processed.

	Object Type
	Choose from
· P - Program.
· E - Entry point program, that is, a program that calls other programs but is not called by any program.
· F - File.
· * - All Object types.
· ' ' – For an AND line. (The AND line takes the same value as the SELECT/OMIT line.)

	Object Comparison
	Specify the comparison type:
· EQ - equal
· NE - not equal
· CT - compare text
· Object Name - An individual name/a generic name/ ‘*ALL’.
Both individual and generic names can have wildcards specified. Enter & to denote that any character is allowable. Thus AAA&1 means that any 5-character name where the first three characters are AAA and the fifth character is 1 will be selected. More examples: AA&&2, OE*.

	Object Usage
	Specify as follows
· Last Used (L): This will select the objects based on the last used date.
· Created (C): This will select the objects based on the Object creation date.
· Modified (M): This will select the objects based on the object change date.
· Days Count (D): This will select the objects based on the total number of days the Object was used.

	Usage Comparison
	Specify as follows
· Less than (<)
· Less or Equal (<=)
· Equal (=)
· Not Equal (<>)
· Greater or Equal (>=)
· Greater than (>)

	Usage Value
	Specify the usage value here. If the usage is Last used, Modified or Created, then value should be a Date in the MMDDYY format. If the usage is Days Count, the value should be a number. 

	System
	Specify the System here. The default should be the “Local” machine or any other preference set. The list contain all the system name that a User have object attributes from. Select one of the following:
· <Specific system>: Identifying a specific system, the application area rules will only qualify the objects reported from the mentioned system.
· <Max All Systems>: Selecting the System value <Max All Systems>, the application area rules will look if the maximum value from all the systems meets the criteria.
· <Min All Systems>: Selecting the System value <Min All Systems>, the application area rules will look if the minimum value from all the systems meets the criteria.

	Omit Local Usage
	For the rules based on Object Usage, the objects added to the application area are expected to be qualified by the maximum value / minimum value observed from all the systems. The Omit Local Usage criteria should dictate if the Local machine should be part of such qualification or not.

	Pgms Level
	When you select to include 'All' program references (or 'All Batch Programs'), a program level from 2 to 9 can be specified. The default value is 'ALL' that brings the entire depth of called programs.

	Include Referred Programs
	This option only applies to SELECT lines. It allows you to specify the selection of referenced programs. Select one of:
· N - No - do not include the programs called/referred by the specified program/file.
· Y - Yes - All the programs referred by the specified program (for program type selection) and the programs referencing the specified file (for file type selection) are included.
· U - Update programs - All programs which update the specified file are included.
· S - Split - All programs that update the specified file and are not present in any other application area are included.
· V - All updated programs - All programs which update the current file or any other file that have been added through 'Include Referred Files' or 'Include Owning File' or 'Include Dependent File” options are included.
· A - All - All programs referred by all called programs are included. Here dependent programs are selected based on the level (All programs which refers the current file or any other file that have been added through 'Include Referred Files' or 'Include Owning File' or 'Include Dependent File” options are included). This option for the File type selection includes the programs which reference the selected file or any files which have been included as owner or dependent files.
· B – All Batch Programs – All batch programs referred by all called programs are included. Here dependent programs are selected based on the level specified (All batch programs which refer the current file or any other file that have been added through 'Include Referred Files' or 'Include Owning File' or 'Include Dependent File” options are included).
· ' ' - For an AND line. (The AND line takes the same value as the SELECT/OMIT line.)

	Include Referred Files
	This option only applies to SELECT lines. It allows you to specify the selection of referenced files. Select one of:
· N - No - do not include files referenced by the specified program.
· Y - Yes - All files referred by the program are included [Dependent PF or LF is included. (Level 1)].
· U - Update files - All files which are updated by the program are included.
· V - All updated files - All files which are updated by the program or any other called program are included.
· A - All - All files referred by the current program or any other called program is included [All dependent PFs or LFs are included (at any level].
· ' ' – For an AND line. (The AND line takes the same value as the SELECT/OMIT line.)

	Include Owning Files
	This option only applies to SELECT lines. It allows you to specify the selection of files which own the specified file(s). Select one of:
· N - No - do not include files, which own the specified file(s).
· Y - Yes - Owned file is included for specified file or any other file added through 'Include ref'd files' relation. (that is, Level 1).
· C - Cumulative - Owned file is included for specified file or any other file added through 'Include ref'd files' relation. (At any level).
	[image: ]
	This option is only valid for the FILE type selection. If the Object Type is a Program, this option will therefore be disabled.




	Include Dependent Files
	This option only applies to SELECT lines. It allows you to specify the selection of files which are owned by the specified file(s). Select one of:
· Y - Yes - Dependent file is included for specified file or any other file added through 'Include ref'd files' relation. (that is, Level 1).
· N - No - do not include files, which are owned by the specified file(s).
· C - Cumulative - Dependent file is included for specified file or any other file added through 'Include ref'd files' relation. (At any level).
Cumulative means including all the dependents of the first file, all the dependents of the dependent files, and so on.
	[image: ]
	This option is only valid for the FILE type selection. If the Object Type is a Program, this option will therefore be disabled.




	Library Comparison 
	Specify the comparison type:
· EQ - equal
· NE - not equal

	Object Attribute
	Specify the attribute of the objects to be selected. The default is *ALL.

	Name/Text
	Fill the name/text of the rule in this box.

	Status
	For the files, specify the status as: 
· *A - Accessed by other files but does not access any other files.
· *B - Accesses other files and gets accessed by other files
· *C - Only accesses other files, not accessed by others
· *D - Standalone File
· *ALL - This is the default selection.
For the programs, specify the status as:
· *A - Parent or top-level program which calls other programs but is not called itself
· *B - Program is called by another and calls other programs
· *C - Program at end of a program tree and does not call other
· program
· *D - Standalone Program
· *ALL - This is the default selection.

	Library Name
	Provide the name of the X-Ref Library here.
· An individual name/a generic name/ ‘*ALL’.
If the Library Rule is left blank, it will be treated as equivalent to *EQ *ALL.



Note: Regarding the Implicitly-selected objects:
· For every *PGM type of objects, their *SRVPGMs and *MODULES are added by default.
· For service programs, their modules and the program that are using those modules are implicitly added.
· For modules, program/service programs that are using those modules are added in application area list.
Click Add on the Application Area Rules dialog after making your selections. Then click the Apply Rules button on the editor toolbar to rebuild the application area as per the specified rules. The same dialog opens if the user wants to update the Application Area Rules. The Update/Delete options are available on the rule’s context menu. Also, the user can rearrange the application area rules through the Re-Sequence Rule option as is required. Whenever the user modifies the rules in any manner, the Apply Rules button changes its color to red, and the editor description also get changed accordingly.
Right-click will invoke three options. Refer to the screen below:
[image: ]
 Fig. 4.5.3 – Application Area Rules window displaying the options
Selecting the Re-Sequence Rule option invokes the following dialog box:
[image: ]
 Fig. 4.5.4 – Application Area Rules – Re-Sequence Rule option
The Original sequence is default. Specify the Target sequence from its corresponding dropdown. The Option has the following three selections:
· Swap with: Swapping will exchange the positions of the Original and Target rules. (If Original is 7 and Target is 1 - Original will become 1 and Target 7)
· Insert before will insert the Original rule just before the Target rule (If Original is 7 and Target is 2 - Original will become 2, 2-6 will become 3-7)
· Insert After will insert the Original rule just after the Target rule (If Original is 7 and Target is 2 - Original will become 3, 3-6 will become 4-7).
Use the Reset Rule Sequence Numbers option in editor toolbar to reset the Rule Sequence number as per the natural order (1, 2, 3…). The reset will also re-build the application area.
[image: ]
 Fig. 4.5.5 – Application Area Rules – Reset Rule Sequence Numbers
The editor toolbar also has the Export to Excel option. On selecting this option, an excel sheet is generated based on the same format, which is used for entering the application area rules through Import Options - Application Area using Excel sheet option.
[image: ]
 Fig. 4.5.6 – Application Area Rules window showing the Export to MS Excel option
In case you directly close the editor window without applying the rules, an alert message pops up, as shown below:
[image: ]
 Fig. 4.5.7 – Alert message dialog box
Click Yes to confirm.
Adding Rules from IBM i
Any number of select/omit criteria (Application Area Rules) can be specified to define an Application Area.
Use Option 7 to define the rules for a specific Application Area.
[image: ]
 Fig. 4.5.8 – Application Area Rules on IBM i
This screen allows you to specify the rules used to divide an application into separate areas. You can add any number of select or omit criteria to ensure that the areas will contain all and only the correct objects.
Use F6 to add a rule.
[image: ]
 Fig. 4.5.9 – Add Application Area Rules from IBM i
After addition, the Application Area appears as shown below:
[image: ]
 Fig. 4.5.10 – Application Area Rules on IBM i
[bookmark: _Toc97719654]New Application Area
The New Application Area option is used to create an Application Area as a child of an existing Application Area.
[bookmark: _Toc97719655]Move Application Area
This option moves the selected Application Area as a child of an existing Application Area. Select the Move Application Area option. This will invoke a dialog box with all existing Application Area enlisted, as shown below:
[image: ]
 Fig. 4.5.8 – Move Application Area
Select the required Application Area and click OK to confirm. The invoked dialog box displays the process confirmation.
[image: ]
 Fig. 4.5.9 – Confirmation dialog box

	[image: ]
	If the user moves an Application Area that is already nested as a child, the relation with current parent will tend to cease. A confirmation dialog box as shown below asks the user to confirm the termination.


[image: ]
 Fig. 4.5.10 – Confirmation for termination
[bookmark: _Toc97719656][bookmark: 919591273]Move To Root
This option will move the selected Application Area to the root position. Select the Move To Root option. The selected application area will get deleted from the current parent Application Area. Click OK to confirm.
[image: ]
 Fig. 4.5.11 – Move to Root
A confirmation message will popup showing the process has been performed successfully.
[image: ]
 Fig. 4.5.12 – Confirmation message
[bookmark: _Toc97719657]Change Application Area Rules
Select the Change Application Area option to modify the application area description. You can change the Refresh Sequence. As required check/uncheck the Lock Flag and Allow Refresh checkboxes. To recapitulate, if you want to use the new method, change the data area XAPPARABLD in X-Ref library to *NEW. However, with this change, the XA client will not show the check-box for using the new method. The same gets reflected on the server side.
Click OK to reflect these changes to the application area.
[image: ]
 Fig. 4.5.13 – Change Application Area dialog
[bookmark: _Toc97719658]Delete Application Area
Select the Delete Application Area option. This prompts for deleting the selected application area. After confirmation it deletes the application area.
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	The user cannot delete an application area if it has another nested application area as a child.


[bookmark: _Toc97719659][bookmark: -2006818592]Affinity Identification
The Affinity Identification option displays the linkage of a program to another program and thereby helps to identify the objects that do not exist in an application area. Affinity Identification have high (or low) affinity to one or multiple programs under that application area, mainly due to data linkages or program dependencies. The affinity calculation is done at the server using the XAFFINIDX command.
The Affinity Identification option is shown below:
[image: ]
 Fig. 4.5.14 – Affinity Identification
Select the option to generate a matrix of programs in the application area against the related program objects falling within or outside the selected application area. Refer to the screen below where the affinity is displayed.
[image: ]
 Fig. 4.5.15 – Affinity Identification window
Two colors denote the affinity index of the programs with all the objects under the selected application area.
· Red – denotes above average Affinity Index.
· Green – denotes below average Affinity Index.
The above calculation is done based on the criteria below:
1. The program-to-program dependency at the specific depth in the calling sequence.
2. The common Database Files used in the specific pair of the programs.
3. Exactly matching Business Rules.
4. Partially matching Business Rules.
The Affinity calculation is done considering the specific weightage for the above cases. The default calculation settings are shown below (that is, in "Affinity Index" column):
	Type
	Level/Depth
	Affinity Index

	PGM
	1
	10

	PGM
	2
	8

	PGM
	3
	6

	PGM
	4
	4

	PGM
	5
	2

	PGM
	6
	2

	FILE
	N/A
	10

	BizRle
	Exact Match
	3

	BizRle
	Contained
	1
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	The Affinity Identification report can also be exported to MS Excel.


[bookmark: _Toc97719660]Affinity Comparison
Select the Affinity Comparison option at the application area level to display the comparison of affinity values for all the objects present in that application area versus their affinity in other application areas.
The following screen displays the Affinity Comparison option.
[image: ]
 Fig. 4.5.16 – Affinity Comparison
The following window will be invoked when the option is selected.
[image: ]
 Fig. 4.5.17 – Affinity Comparison window
The first column displays the selected application area and rest of the columns are the other application areas in the X-Ref library.
The color code represents the following details:
· Blue: represents the presence of that object in the application area corresponding to that column.
· Red: represent the object that does not exist in the application area but has the highest affinity.
· Green: represents the specific object that has the highest affinity and is also present in that application area.

[bookmark: _Toc97719661]Derive Business Rules
The topic has been discussed under the section Application Library.
[bookmark: _Toc97719662]Export Options
The topic has been discussed under the section Application Library.
[bookmark: _Toc97719663]Annotate
X-Analysis provides the annotation facility for application areas. Select any application area and opt for the context menu on it, then select the Annotate option. This invokes a dialog box; provide the required text and click Save. The annotation is stored in a table available in the cross-reference library.
[bookmark: _Toc97719664]Document Application Area
The topic has been discussed under the section Document Manager.
[bookmark: _Toc97719665]Data Management Options
	[image: ]
	Refer to the section “Data Management Options” in the document “X-DataTest_User_Manual” for this release.


[bookmark: _Toc97719666]Test Management Options
	[image: ]
	Note: Refer to the section “Test Management Options” in the document “X-DataTest_User_Manual” for this release.


[bookmark: _Toc97719667]Reengineer Programs
Refer to the section Reengineer Programs.
[bookmark: _Toc97719668]Audit Options
For detailed description, refer to the section Audit Options.

[bookmark: _Toc97719669]UML Options
The UML Options has the following option:
· Application Area Class Diagram
[bookmark: _Toc97719670]Application Area Class Diagram
The Application Area Class Diagram option is specific to application areas. This is a special class diagram, which displays all the objects available in the application area.
[image: ]
Fig. 4.6.1 – App Area Class diagram for the application area, MVCPROCESS

[bookmark: _Toc97719671]DDL Modernization node on an Application Area
The intention of converting DDS into DDL is for those clients who are planning to modernize their databases to get the enhanced DDL features. Below are some of the benefits:
1. Better data integrity (data validation is performed at Write/Update, unlike in DDS where the validation is performed on a read)
2. Access to new data types not supported in DDS (identity columns, BLOBs, CLOBs, and DataLinks etc.)
3. Better read performance.
[bookmark: _Toc97719672]DDS to DDL – X-Analysis
In X-Analysis, enhancing the maintainability of databases by converting from DDS to DDL can be achieved through the DDL Modernization node. This feature is only available for application areas. When an application area expands, the DDL Modernization node appears. Refer to screen as shown below:
[image: ]
 Fig. 4.7.1 – DDL Modernization node under application area, CUSTS
[bookmark: _Toc97719673]Add Conversion Library
Right-click the DDL Modernization node for the Add Conversion Library option. This will invoke the DDL Conversion Setup dialog box.
[image: ]
 Fig. 4.7.2 – DDL Modernization node – Add Conversion Library option
Through this dialog you can form a new DDL conversion schema library.
[image: ]
 Fig. 4.7.3 – DDL Conversion Setup dialog box
Enter the Name and Description (adding Description is optional). The following dialog box shows the name of the new DDL set up.
[image: ]
 Fig. 4.7.4 – DDL Conversion Setup dialog with Name
Click OK. The new node will appear as shown in the following screen.
[image: ]
 Fig. 4.7.5 – RMTDDL node
You may delete the newly created node. Right-click the Remove Schema option. The option is shown in the following screen.
[image: ]
 Fig. 4.7.6 – Remove Schema option
A confirmation dialog box as shown below asks you to confirm the deletion.
[image: ]
 Fig. 4.7.7 – Remove Schema message prompt
Click Yes.
Another dialog box will be displayed specifying that the schema library has been removed from the X-Ref. If there are Journal Receivers and the user still wants to delete the schema library, click Yes.
[image: ]
 Fig. 4.7.8 – Delete Library
This confirms the deletion of the schema library from the Client UI, table, and also from the database.
If another message is displayed as shown below, then the library needs to be manually deleted:
[image: ]
 Fig. 4.7.9 – Manual Deletion

	[image: ]
	It is vital that if any PFs or LFs are converted, they have the same format level identifiers as the original.


There are two sub-nodes under DDL Modernization:
· Run DDL Conversion Analysis
· Problem Analysis
[bookmark: _Toc97719674]Run DDL Conversion Analysis
Select this option to invoke the following dialog box:
[image: ]
 Fig. 4.7.10 – Generate Problem Analysis window
Click OK to submit a batch job. The following window displays the progress of the batch job.
[image: ]
 Fig. 4.7.11 – Batch Job Progress view
At any point, while the batch job is running, click on the hyperlink (*JOBQ) to view the Job Log. The Job Log view is shown below:
[image: ]
 Fig. 4.7.12 – Window displaying the Batch Job status
[bookmark: _Toc97719675]Problem Analysis
Problem Analysis contains specific information related to DDL conversion issues.
Double-click Problem Analysis option. The following screen presents the conversion issues (like File is a Joined logical) for the application area, CUSTS.
[image: ]
 Fig. 4.7.13 – Problem Analysis window
[bookmark: _Toc97719676]DDL Conversion – RMTDDL
The sub-nodes under the new node are shown below:
[image: ]
 Fig. 4.7.14 – DDL Modernization – sub-nodes
The subnodes available under the new setup, RMTDDL are:
· DDL Conversion Settings
· Generate File Analysis
· File Analysis
· Surrogate File Analysis
· Derived Constraints
· Run DDL conversion
· DDL conversion error log
· File Conversion Report
· Tables
· Indexes
· Views
· DDS LFs
· Schema Diagram
[bookmark: _Toc97719677]DDL Conversion Settings
Click the DDL Conversion Settings option to invoke the following dialog box.
[image: ]
 Fig. 4.7.15 – DDL Conversion Settings window
DDL conversions for each Generation Method:
	Generation Method
	PF with unique key converted to:
	PF with non-unique key converted to:
	PF without key converted to:
	LF converted to:

	Basic Conversion
	Table with primary key
	1. Suffixed surrogate table without key
2. Index with the key with PF name
	Table
	DDL index/view as applicable

	Surrogate Table for keyed PF and Index for PF keys
	Table with suffixed name
	Table with suffixed name
	1. Suffixed surrogate table
2. DDS LF with PF name
	DDL index/view as applicable

	Surrogate Table for PF and DDS LF for original PF fields/keys
	1. Suffixed surrogate table
2. DDS LF with PF name
	1. Suffixed surrogate table
2. DDS LF with PF name
	1. Suffixed surrogate table
2. DDS LF with PF name
	DDL index/view as applicable

	Surrogate Table for PF and DDS LF for PF and all Access Paths
	1. Suffixed surrogate table
2. DDS LF with PF name
	1. Suffixed surrogate table
2. DDS LF with PF name
	1. Suffixed surrogate table
2. DDS LF with PF name
	DDS LF method of indexes/views


Only on selecting the Generation Method as Surrogate Table for PF and DDS LF for PF and all Access Paths the checkboxes for Generate Existing LF with original fields specified and Create Indexes to support retained DDS LFs will be enabled. This is indicated in the dialog below.
[image: ]
 Fig. 4.7.16 – DDL Conversion Settings window
Checking the “Create Constraints in separate source members” box will create the constraints for the specific member, else all the constraints will get added in a single source member. Check “Apply Derived Constraints” box to ensure that the derived constraints are applied.
Check the other relevant boxes as per the conversion requirements, and then click Apply.
	[image: ]
	The Import Column Template in the image provided above is disabled. To enable this feature, the XDDLTMPLTE table must be populated manually from the IBM i screen.


Click the Conversion Setup tab to modify the conversion parameters.
[image: ]
 Fig. 4.7.17 – DDL Conversion Settings displaying the Conversion Setup tab
Click Apply to implement the changes.
[bookmark: _Toc97719678]Generate File Analysis
Select the Generate File Analysis option, to invoke the following dialog box.
[image: ]
 Fig. 4.7.18 – Generate File Analysis dialog box
Click OK.
[bookmark: _Toc97719679]File Analysis
Selecting the File Analysis option will present a list, which displays all the files. The files are sorted as per the settings applied through the DDL Conversion Settings option.
The below screen shows the File Analysis list for the conversion library, RMTDDL.
[image: ]
 Fig. 4.7.19 – File Analysis window
The right-click context menu has the Compare Converted Source option, which allows you to compare the original source of a file, with the one that has been generated using X-DB Modernize. The below screen shows the converted Source Compare window.
[image: ]
 Fig. 4.7.20 – Compare Converted Source window
[bookmark: _Toc97719680]Surrogate File Analysis
When you select the Surrogate File Analysis option, a list gets displayed for the PFs, which are now converted to surrogate tables.
The list contains details about the file name, program name, source file, source library, source RRN and statement. This data gets automatically populated when the user run the conversion job.
[image: ]
 Fig. 4.7.21 – Surrogate File Analysis window
[bookmark: _Toc97719681][bookmark: 2019865212]Derived Constraints
Derived constraints are derived from the Data model and are generated optionally generated during DDL modernization. The user can determine the validity of the constraints during problem analysis and the invalid entries get reported in the DDL Modernization->Problem Analysis node.
The following screen shows the Derived Constraints window.
[image: ]
 Fig. 4.7.22 – Derived Constraints window
You can omit/select a specific constraint by right-clicking on a row or use Ctrl / Shift and right-clicking the mouse. Through toggle behavior, the omitted constraint(s) can be re-selected. You can also click the Omit All (X) or Select All (✓) icons from the editor toolbar. The Show Description button also has toggle behavior, and you can click on it to get the detailed description. Alternatively, you can click the box under the Constraint Selected column for the omit/select purpose.
[image: ]
 Fig. 4.7.23 – Show Description button – Derived Constraints
[bookmark: _Toc97719682]Run DDL Conversion
Double-clicking the Run DDL Conversion option invokes the following dialog box:
[image: ]
 Fig. 4.7.24 – Run DDL Conversion dialog box
Choose the Compilation Type from the drop-down menu. The default option is *INLINE. Click OK.
[bookmark: _Toc97719683]DDL Conversion Error log
The DDL conversion error log lists the record of errors that occurred during the DDL conversion process. Refer to the example below for the DDL conversion error log.
[image: ]
 Fig. 4.7.25 – DDL Conversion Error log for VISHDDLIB
[bookmark: _Toc97719684][bookmark: -154806831]File Conversion Report
The File Conversion Report lists all the objects for conversion under the given categories. The number of categories displayed may vary, as these are based on the Generation Method, which you would have selected for DDL conversion. This window is similar to the File Analysis window.
The below screens shows the File Conversion Report for RMTDDL. It gives the total count for the objects falling under each category.
[image: ]
 Fig. 4.7.26 – File Conversion Report for RMTDDL
When you expand each category, the details of the files are presented as shown below.
[image: ]
 Fig. 4.7.27 – Detailed view of File Conversion Report
These details show data after the conversion is complete. The user can see before and after conversion through the Format level identifier columns. The record count before and after conversion is also available. In the above window, the Constraints column shows “N”. It shows “Y” if a constraint member name has been provided for a table after which you can use the Zoom Source option to zoom to the specific constraint member.
	[image: ]
	If the Format ID (Before and After) does not match, the report will highlight this row in blue.


[bookmark: _Toc97719685][bookmark: -1373746862]Tables
Double-click the Tables sub-node to invoke the following window. It presents the names of all the Tables for RMTDDL. Each table is also assigned a system table name.
[image: ]
 Fig. 4.7.28 – Window displaying Tables for RMTDDL
The table names have a right-click option, Zoom Source to invoke the Source List for that table. Select the Zoom Source option to invoke the following window:
[image: ]
 Fig. 4.7.29 – Source List window – ASTATUSXQ
[bookmark: _Toc97719686][bookmark: 277558306]Indexes
Double-click the Indexes sub-node to display the index names. Similar to the Tables, each index is assigned a System Index Name.
[image: ]
 Fig. 4.7.30 – Window displaying Indexes for RMTDDL
Right-click on an index name to invoke the Zoom Source option. The following screen shows the Source List for a selected Index name:
[image: ]
 Fig. 4.7.31 – Source List window – CONDETL1ID
[bookmark: _Toc97719687][bookmark: 794774919]Views
Select the Views sub-node to invoke the window listing the Table Name beside the System View Name. The screen below presents the Views window:
[image: ]
 Fig. 4.7.32 – Window displaying Views for RMTDDL
Select the Zoom Source option to invoke the Source List window.
[image: ]
 Fig. 4.7.33 – Source List window – ASTATUSL1
	[image: ]
	Zoom Source displays the source from QDDLSRC, if existing in the given library. Otherwise, the image of DSPFFD would be displayed.


[bookmark: _Toc97719688]DDS LFs
Select the DDS LFs option to view all the DDS LFs generated by DB-Modernize process.
The following screen shows the DDS LFs window.
[image: ]
 Fig. 4.7.34 – DDS LFs window
Right-click or double-click on a row to zoom to the source of an LF. The following screen shows the Zoom Source option.
[image: ]
 Fig. 4.7.35 – DDS LFs window showing the Zoom Source option
[bookmark: _Toc97719689][bookmark: 1315247370]Schema Diagram
Select the Schema Diagram option to invoke the block diagram for the entire schema, which represents the files and relation among the files. You can see the storage types, length, and the NULL constraint. Various relevant details like the primary keys, foreign keys, columns are presented in the Schema Diagram.
[image: ]
 Fig. 4.7.36 – Schema Diagram for RMTDDL
The user can export the Schema Diagram using the Export to Image option. The option is shown below:
[image: ]
 Fig. 4.7.37 – DDL Schema Diagram showing the Export to Image option
[bookmark: _Toc97719690]Application Area Diagramming
[bookmark: _Toc97719691]Application Area Diagram
X-Analysis allows easy subdivision of an application into business areas or application areas. You can split the application areas further into sub-application areas for better application analysis. For analyzing an application/application area, X-Analysis provides another diagrammatic construct called the Application Area Diagram.
The Application Area Diagram helps in visualizing the relationships between various applications areas. When the user selects the entire cross-reference library, the Application Area Diagram option displays all the application areas and sub-application areas.
[image: ]
Fig. 5.1.1 – Application Area Diagram for XAN4RCPTTD
The bluish-grey blocks represent an application area. A larger box exemplifies an application area with child Application Areas. The parent application area boxes will have a size that fits all child application areas within the box.
Selecting an application area displays the relationship among various application areas. Select an application area to test this. The Application Area Diagram displays colored arrows – Red, Black, and Blue.
Blue Arrow – Displays Program-to-Program calls. The blue arrow points towards the application areas having the maximum number of calling programs.
When the cursor is hovered over the blue line, then the number of called and calling programs are displayed. In the below screen, programs in CUSTOMERS are calling 17 programs in ALLFILES, and ALLFILES is calling 128 programs of CUSTOMERS.
[image: ]
Fig. 5.1.2 – Pop-up showing the called and calling programs
Red Arrow – Program-to-File references are displayed with distinct red arrows. In case a program from one application area refers to files of the other application areas, then there is one distinct red arrow. A bi-directional red arrow will be displayed if files of two application areas are referring to each other.
When you hover the cursor over the red line, then the number of referred files get displayed. In the following screen, 2 files are being referred between DATATEST and OE.
Black Arrow – The arrow depicts the count references, references that do not encompass references to a file or a call to a program. The legend addresses the black color as “Others”.
[image: ]
Fig. 5.1.3 – Pop-up box showing files being referred between DATATEST and OE
[bookmark: _Toc97719692]Application Area Diagram Summary View
The Application Area Diagram provides an option to view the Application Area Diagram summary. Click Show AAD summary on the Application Area Diagram toolbar.
[image: ]
Fig. 5.1.4 – Show AAD Summary button
A new window displaying the relationship summary for all the application areas will be invoked.
[image: ]
Fig. 5.1.5 – Application Area Diagram Summary for XAN4RCPTTD
The Show AAD summary displays limited records if a particular application area is selected from the Application Area Diagram.
[image: ]
Fig. 5.1.6 – AAD Summary for selected Application Area

	[image: ]
	From release 13.2.09, the AAD Summary for an Application Area Diagram is enhanced with a new sub-table, “Object Details”, that shows the list of actual object references and the Usage Count on the AAD Summary list.


The Object Details sub-table is divided in to three field, that is, Name, Attribute, and Library displaying the Object Detail information.
If the Usage Count is equal to one, the object information must appear on the same row, as the information list belongs to that Application Area.
If the Usage Count is more than one, the expansion symbol must appear in front of the usage count, and no information will appear in the sub-table for that particular row.
If the user clicks the expansion button, then the object detail information gets fetched from the server on demand and then the sub-table will get displayed for that selected application row.
[image: ]
Fig. 5.1.7 – Usage Count equal to one and more than one

	[image: ]
	When the Usage Count is more than one, in that case, the first row aligned with the AAD Summary list entry will always remain blank.


When the user clicks the export option, the AAD Summary will export all the information from the Object Details sub-table matching the current filtering and sorting with the expand and collapsed state.
[image: ]
Fig. 5.1.8 – Various export option
[image: ]
Fig. 5.1.9 – Export to MS Excel
From the Application Area Diagram, If the user changes the relationship to display the AAD Summary list, then the information on the AAD Summary will return to the collapsed state.

[bookmark: _Toc97719693]Area Flow Diagram
The Area Flow Diagram (AFD) can be generated for an individual application area.
Select the Area Flow Diagram option to display programs and files in an application area, along with the relations among them. The default selection is on the file which has the most referring programs.
The following screen displays the AFD for the application area, MVCPROCESS.
[image: ]
Fig. 5.2.1 – Area Flow Diagram for MVCPROCESS

	[image: ]
	The Area Flow Diagram will now show the long name for the files when the long names exist and the Windows>Preferences>X-Analysis XX.X.X>Show Long Names for Files option is selected.


[bookmark: _Toc97719694]Legend
The nature of the programs and the files can be established through the AFD Legend bar. The screen is shown below.
[image: ]
Fig. 5.2.2 – AFD with Legend
· Selected Object – This depicts the object on which you have made the selection. The highlighted objects are those referred to by the object.
· Input – This depicts the input file if program is selected, and a program receiving input if file is selected.
· Output – This depicts the output file if program is selected, and a program writing output if file is selected.
· Update – This depicts the Update file.
· Called Program – This depicts the program called by other programs.
· Calling Program – This depicts the program calling other programs.
Click Export Options and select to export the generated AFD into either MS Visio or Image.
[image: ]
Fig. 5.2.3 – Area Flow Diagram with Export Options
[bookmark: _Toc97719695]Annotation List
From version 13.2.09, X-Analysis gets enhanced to introduce a new option, Annotation List, in the Cross-Reference menu.
Refer to the screen below displaying the new option Annotation List.
[image: ]
Fig. 6.1.1 – Annotation List

[bookmark: _Toc97719696][bookmark: -1138095379]Annotation List Dialog box
Annotation List provides the basic information about the objects, annotations, and their categories.
Double click the option, Annotation List, from the Cross-Reference menu to open the Annotation List dialog box.
Refer to the screen below displaying the Annotation List dialog box.
[image: ]
Fig. 6.2.1 – Annotation List dialog box
The Annotation List dialog box provides the detail for all the available Objects with their respective Library, Name, Type, Attribute, Field Name, Category, and Annotation.
If the user selects and right-click any object type from the Annotation list editor a new option Annotate will help the user to edit or modify that object type.
[image: ]
Fig. 6.2.2 – Annotate
[image: ]
Fig. 6.2.3 – Annotation editor or dialog box
The Annotation List dialog box is now enhanced with an option tooltip for the column Annotation.
When the user hovers around the option Annotation with long description, the new feature tooltip displays the entire content in the Annotation list dialog box without restricting the vertical or horizontal scroll bar.
[image: ]
Fig. 6.2.4 – Annotation List dialog box
The tooltip also restricts its contents to one screen while functioning in multi-screen environments.
Double-clicking the Annotation entry from the Annotation List dialog box will open the Annotation editor/dialog box for that entry.
This option enables the user to Save or Delete the Annotation for the selected entry in the Annotation editor/dialog box.
[image: ]
Fig. 6.2.5 – Annotation editor or dialog box
If the user deletes the contents for the selected entry from the Annotation List dialog box and press Save. In that case, the row for that Category will not get removed, only the Annotation option appears blank.
Similarly, If the user updates the content for the selected entry from the Annotation List dialog box and press Save, its new content will be reflected in the Annotation List for that selected entry.
Refer to the screen below displaying the Annotation blank.
[image: ]
Fig. 6.2.6 – Annotation blank

	[image: ]
	For a single object, we can find multiple Annotation List entries from different categories in the Annotation List dialog box represented by Library, Name, Type, or Attribute.


Refer to the screen below displaying multiple Annotation List entries
[image: ]
Fig. 6.2.7 – Annotation List entries
	[image: ]
	The Annotation List gets automatically refreshed, once the user exit from the Annotation List dialog box. Similarly, when the user performs Save/Delete, the Annotation List gets automatically refreshed based upon the action performed by the user.



[bookmark: _Toc97719697]Filtering Capabilities
Annotation List dialog box provides the filtering option in the Library, Name, Field Name, Category, and Annotation.
Refer to the screen below displaying the Filtering Capabilities in the Annotation List dialog box.
[image: ]
Fig. 6.3.1 – Filtering Capabilities in the Annotation List dialog box
The filtering option in the Annotation List dialog box provides some common behaviour, that is:
· Case-Insensitive
· Regular expression (REGEX)
· Dynamic display
When performing a REGEX filtering operation on the Annotation column, the filtering execution must systematically take abstraction of any CR/LF (Carriage Return/Line Feed) that could precede the section of the string that qualifies.
Currently, the prefix regex expression “*” required if the user is not searching for an Annotation starting with the specified criteria.
Refer to the screen below with the expression “*” that helps the user in filtering out any column with the text in the middle or the end of entries.
[image: ]
Fig. 6.3.2 – Filtering Capabilities in Categories
[bookmark: _Toc97719698]Field Name
Column, Field Name added to the Annotation List for the user to find the information about the File/Field annotation inside the Annotation List when available.
This column will remain blank for all other Annotations.
[image: ]
Fig. 6.4.1 – Field Name
By default, the Category column would display by File/Field for a field entry. In case, the user selects the Object Type as *VAR-Field for any sequence, then that Heading would be displayed in the Annotation Template.
Refer to the screen below displaying the Annotation Template.
[image: ]
Fig. 6.4.2 – Annotation Template
 
[bookmark: _Toc97719699][bookmark: -1605136522]Annotation Template
A new sub-node Annotation Template is added in the option Annotation list. Right-click the option Annotation List for the sub-node Annotation Template.
Refer to the screen displaying the option Annotation Template.
[image: ]
Fig. 6.5.1 – Annotation Template
[image: ]
Fig. 6.5.2 – Annotation Template
If the user performs any change to any of the Annotation Template from the dialog, it gets automatically updated in the Annotation List editor, when the user clicks the Save button.
	[image: ]
	Annotation List provided in the Cross-Reference menu is not a part of Business Rules Annotations.


[bookmark: _Toc97719700]Quick Reference to an Object
X-Analysis provides various options that provide detailed information regarding different objects/members. When required, these give you the options to refer to any given object quickly, and provide relevant information and/or diagrammatic presentations.

	Feature
	Brief Description

	Jump to
	Displays all the options available for a specified member, object or variable for fast access to Source Browser, DFD, Structure Chart, PSC, Object Where Used, Source cross-reference, Variable Where Used and DMD.

	Source Browser 
	Displays source code of the selected member. Provides various options related to the source code.

	View Object Where Used
	Displays all the instances of an object in the application.

	 Variable Where Used
	Displays all the instances of the specified variable in the application.

	File Field Details
	Displays the Field Details for a file.

	 LFs / Access Paths
	Displays all Access Paths for the selected Physical File.

	Member X-Ref
	Displays all the instances of the specified variable in the source code. This is available only on the Source Browser view.

	Enhanced Member X-Ref
	Displays the references of a variable in the member, along with the information.

	Add Bookmark
	Displays the bookmarked source lines, besides allowing you to edit bookmarks as per requirement.

	More Info
	Displays detailed object Information like name, Long name, library, type, attribute, etc.




[bookmark: _Toc97719701][bookmark: 65367009]Jump to Dialog
The primary requirement of an analyst working with a case tool is to get quick and ample information about an object. X-Analysis facilitates this by providing faster access to the objects using the Jump to the utility. This utility is accessible from any screen using the Jump to button on the toolbar. 
	[image: ]
	The user can also invoke the option Jump to by pressing Ctr+Shift+J.


Jump to displays all the options available for a specified member, object, or variable for fast access to Source Browser, DFD, Structure Chart, PSC, Object Where Used, Member X-Reference, Variable Where Used, DMD, and Application Area. 
[image: ]
Fig. 7.1.1 – Jump to dialog

	Options
	Each option acts on the Object/Variable specified in the selection edit box 

	Zoom Source  
	Zooms the source code of the object. 

	Data Flow Diagram
	Displays the Data Flow Diagram of the object.

	Structure Chart Diagram
	Displays the Structure Chart of the object. 

	Program Structure Chart
	Displays the sequence of calls within the program.

	Object Where Used
	Displays all the instances of an object in the application.

	Member X-Ref
	 Lists all the Source Lines where the Field/Variable has been used/referenced, in the Source Member and its associated Device Files and Copybooks. This option enables only when Jump to is opted on the Source Browser.

	 Variable Where Used
	 This option enables only when Jump to is opted on the Source Browser.

	 Variable Where Updated
	 Displays all the instances of the specified variable in the application.

	 Variable Where Defined
	Same as Variable Where Used, but displays only those source lines where the field is updated. 

	Data Model Diagram
	Displays the source lines where the variable is defined. Displays the Data Model Diagram of the object. 

	Application Area
	Selects the Application area on the Navigation panel. 



	[image: ]
	When entering a search for Variable Where Used on a string literal from Jump to, include the variable name within the single quotations marks (‘ ’) as shown below:


[image: ]
Fig. 7.1.2 – Jump to dialog
When the search is performed for Physical File/Field Name, the result will have only File/field Where Used references.

[bookmark: _Toc97719702]Source Browser View
The source browser displays the source for an object. The context menu on any member/object has the Zoom Source option, which invokes the source browser for that object or member.
[image: ]
 Fig. 7.2.1 – Context menu – Zoom Source option
	[image: ]
	Select any member/object and double-click on it to open the source member of that object in the X-Analysis source browser.


[bookmark: _Toc97719703]Zoom Source
The Source Browser follows the pattern similar to IBM’s SEU and is equivalent to viewing a source member in SEU browser mode. However, the X-Analysis source browser provides a number of additional features. It allows you to browse another source, and also continue with another zoom on reaching there. Further, you can traverse to the previous screen from where the zoom was issued.
[image: ]
 Fig. 7.2.2 – Source Browser View
Note the following on this view:
· When the Source Browser invokes, then the cursor is positioned to the beginning of C-specifications for RPG/RPGLE programs and Procedure Division for COBOL programs.
· Double-click on the line performs 'Member X-Ref' or 'Object Where Used' depending on whether Object/Variable is available on that line. Preference is given to the Member X-Ref option, in case it is a Program. On Physical/Logical Files, Variable Where Used is performed for the field on that line for that file.
Use of Templates by the Source Browser
The source browser uses the extension of any *PGM file to determine its type, for example, the attributes which are equivalent to CBL are: CBLLE, CBLnn (CBL36 & CBL38), CICSCBL, CICSSQLCBL, SQLCBL, SQLCBLLE, and undefined attributes if it is a COBOL Source File.
Information about an object can be displayed by selecting/highlighting the object and performing one of these.
· Opt for the context menu to select an option.
· User may copy the variable name to the clipboard by simply clicking the option depicting variable name in the context menu as shown below:
[image: ]

Fig. 7.2.3 – Templates by the Source Browser
· Double-click to bring up a designated view depending on the current view.
[bookmark: _Toc97719704]Zoom Source toolbar
The Zoom Source toolbar comprises various options, which are discussed below.
[image: ]
 Fig. 7.2.4 – Toolbar available on Source Browser
[bookmark: _Toc97719705]Source Options
Source Options is the drop-down menu presenting the different source mode views that are available.
[image: ]
 Fig. 7.2.5 – Source Options
[bookmark: _Toc97719706]Normal Source Code
The Normal Source Code is the default source view for RPG/COBOL programs.
Indented Source Code
Select Indented Source Code from Source Options to display the indented source code:
[image: ]
 Fig. 7.2.6 – Indented Source Code
[bookmark: _Toc97719707]Business Rules Overlay
Select the Business Rules Overlay option to observe the business rules embedded in the Normal Source Code. The following screen displays the Business Rules Overlay view for CON001.
[image: ]
 Fig. 7.2.7 – Business Rules Overlay window
[bookmark: _Toc97719708]Business Rules
Select the Business Rules option to access the business rules for the selected source member. The Business Rules for CON001 are displayed below.
[image: ]
 Fig. 7.2.8 – Business Rules
[bookmark: _Toc97719709]Consolidated Rules
Select the Consolidated Rules option to display the file-field based business logic for the selected source member. The Consolidated Rules for CON001 are displayed below:
[image: ]
 Fig. 7.2.9 – Consolidated Rules
[bookmark: _Toc97719710]Expanded Copybooks
Select the Expanded Copybooks from the Source Options to expand all the copybooks in the member. This option inline all the Copybooks used in the program if they exist.
The Expanded Copybooks option for the source line /Include QCPYSRC, XLICDEFR is shown below.
[image: ]
 Fig. 7.2.10 – Expanded Copybooks
[image: ]
 Fig. 7.2.11 – Expanded Copybooks
[bookmark: _Toc97719711]Expand Copybook
X-Analysis also provide the Expand Copybook/Hide Copybook option by right-clicking the source line. This option only expands the selected copybook and not all the copybooks in a member.
The Expand Copybook/Hide Copybook option for the source line /Include QCPYSRC, XLICDEFR is shown below.
[image: ]
 Fig. 7.2.12 – Expand Copybook
[image: ]
 Fig. 7.2.13 – Hide Copybook
[bookmark: _Toc97719712]Business Process Logic
Select the Business Process Logic option to access the process logic for the selected source member. The Business Process Logic for CON001 is shown below.
[image: ]
 Fig. 7.2.14 – Business Process Logic Option
[bookmark: _Toc97719713]Source Outline
Select the Source Outline option to view all subroutines/modules and called programs available in the source code.
The cursor is positioned to a particular line of code in the source browser when the user double-clicks on any of the listed items from the Source Outline view.
[image: ]
 Fig. 7.2.15 – Source Outline
[bookmark: _Toc97719714]Show Split Panel
The Show Split Panel option helps you compare the Normal Source Code with its Business Process Logic code. It promotes a better understanding of the Business Process Logic code.
[image: ]
 Fig. 7.2.16 – Show Split Panel
Select the Show Split Panel option to display a split panel displaying the Normal Source and the Business Process Logic code simultaneously:
[image: ]
 Fig. 7.2.17 – Normal Source Code and Business Process Logic code
When you double-click on a particular line in the Normal/Original Source code, its corresponding source line on the Business Process Logic code gets highlighted. The Show Split Panel button has toggle behavior and clicking it reverts to the Normal Source Code view.
[bookmark: _Toc97719715]Pseudo Code
Pseudo Code is also a toggle option for viewing the Pseudo Code for the Normal Source Code.
[image: ]
 Fig. 7.2.18 – Pseudo Code toggle button
Click the icon to display the Pseudo Code for CON001.
[image: ]
 Fig. 7.2.19 – Pseudo Code for CON001
You can switch back to the Original Code through the toggle action of the button. The user can set the Pseudo Code Indentation Depth level (0-4) using X-Analysis ‘General Preferences’ option.
[image: ]
 Fig. 7.2.20 – Original Code toggle button
[bookmark: _Toc97719716]Source Level
Source Levels 1-5 are available on Program objects only. The Source Level menu on this display allows for indentation and five levels of source listing. Each level suppresses certain source lines.
[image: ]
 Fig. 7.2.21 – Source Level options
The current source level is shown on the title bar.
[bookmark: _Toc97719717]Diagram Options
Choose different diagram options:
1. Data Flow Diagram: Generates Data Flow Diagram for the Object.
2. Hierarchical Structure Chart: Generates Hierarchical Structure Chart diagram for the Object.
3. Structure Chart Diagram: Generates Structure Chart Diagram for the Object.
4. Screen Flow Diagram: Generates Screen Flow Diagram for the Object.
5. Program Structure Chart: Generates Program Structure Chart for the Object.
[image: ]
 Fig. 7.2.22 – Diagram Options
[bookmark: _Toc97719718]Generate UML
Choose different UML diagram options:
1. Class Diagram: Generates Class Diagram for the Object.
2. Activity Diagram: Generates Activity Diagram for the Object.
[image: ]
 Fig. 7.2.23 – Generate UML Options
[bookmark: _Toc97719719]Flowchart
It is a drop-down menu, and contains two options:
1. Flowchart: Generates Flowchart for the Program.
2. Flowchart for current Subroutine/Procedure: Generates Flowchart for the selected Subroutine/Procedure of the Program.
[image: ]
 Fig. 7.2.24 – Flowchart options
Click the Flowchart icon to generate a flowchart using Microsoft Visio.
[bookmark: _Toc97719720]Screen Components
Select the Screen Components option to display a list of all available screen components for the selected program.
[image: ]
 Fig. 7.2.25 – Screen Components options
[bookmark: _Toc97719721]Screen/Report Design
The Screen/Report Design displays the layout for associated DSPF/PRTF.
[image: ]
 Fig. 7.2.26 – Screen/Report Design option
[bookmark: _Toc97719722]Lpex/SEU Editor
[bookmark: _Toc97719723]SEU
You can make changes to the source code using the SEU option. Click the SEU icon available on the Source Browser toolbar.
[image: ]
 Fig. 7.2.27 – Invoke SEU option from the Source Browser
[bookmark: _Toc97719724]Lpex Editor
You can make changes to the source code using the Zoom in Lpex option. Click the Zoom in Lpex icon available on the Source Browser toolbar to initiate the Lpex editor.
[image: ]
 Fig. 7.2.28 – Invoke Zoom in Lpex option from the Source Browser
	[image: ]
	Zoom in Lpex is a default option for all IBM Rational products having an RSE plugin. For all other Eclipse products, SEU (5250 Emulator) is the default option. You can change the default settings using the X-Analysis ‘General Preferences’ option. Invoking 5250 sessions requires XAN4SEU users on the IBM i. Refer to Appendix B – Enabling the SEU Interface for creating a XAN4SEU user.


The X-Analysis Plugin comes with default Preferences settings. To change the Preferences settings, start IBM's RDi/RDp/WDSC (9.5 and above) or Eclipse 4.4 (and above), then select Window > Preferences to display the Preferences window.
[image: ]
 Fig. 7.2.29 – General X-Analysis Preferences setting for Source Editor
[bookmark: _Toc97719725]Export Options
It is a drop-down menu, and contains options for exporting list, adding annotates, and generating system document.
1. Export to PDF: Exports current list on the X-Analysis Client to PDF.
2. Export to MS Word: Exports current list on the X-Analysis Client to MS Word.
3. Export to MS Excel: Exports current list on the X-Analysis Client to MS Excel.
4. Annotate: Allows to add annotates for the selected object.
5. Documenter: Allows to access the Documenter option for generating a customized system document.
[image: ]
 Fig. 7.2.33 – Export Options
[bookmark: _Toc97719726]Download Source Code
The Download Source Code option allows you to export the Source Code into a text file format. The option is shown in the screen below:
[image: ]
 Fig. 7.2.34 – Download Source Code option
There are two sub-options – Source with Sequence and Date and Only Source as shown below. If you select the first sub-option, then the Source is exported along with the sequence and date. If the second sub-option, then only the source is exported.
[image: ]
 Fig. 7.2.35 – Download Source Code sub-options
[bookmark: _Toc97719727]Print
The Print option directly prints the currently displayed source content. You may select the paper size as Letter or A4.
[image: ]
 Fig. 7.2.36 – Print option
[image: ]
 Fig. 7.2.37 – X-Analysis Printing
[bookmark: _Toc97719728]View Code
Select the View Code option to view the reengineered, the restructured, or the generated code of a selected object.
[image: ]
 Fig. 7.2.38 – View Code option

[bookmark: _Toc97719729]Object Where Used
The Object Where Used option lists all the instances in the application where a specified object (*FILE type) has been used/referenced. The following are the details of the sub-options of Object Where Used.
· Usage References: List of objects which are using this object.
· All References: List of objects where this object is being used. Besides this, source references for which the objects do not exist are also displayed.
· Update References: List of objects that are writing or updating the records to a file in any way is included. Earlier, only programs in Update and Update/Out mode were included. Therefore, the number of records will also increase.
· Delete References: List of objects that are deleting the records from the specified object.
· Entry Level References: Entry-level references in 'Object Where Used' list all entry-level programs (*A), which directly or indirectly access the object in question.
· Real Time References: It is the most flexible option because it facilitates live impact analysis and displays the Real-Time references or the object dependencies at runtime. It does not use any data existing in the XA tables populated during the last initialization/refresh of the X-Ref library.
Select CUSF from the Member/Object List, and choose the Object Where Used option from the context menu.
[image: ]
Fig. 7.3.1 – Object Where Used option
This produces an Object Where Used listing for all objects referring to CUSF.
If you select the Object Where Used on a PF (CUSF, in this case), then besides listing the objects using CUSF, the objects using the LFs built on CUSF (for example, CUSFL3) are also reported.
[image: ]
Fig. 7.3.2 – Object Where Used – Usage References screen
On the other hand, if you select the Object Where Used on a LF (CUSFL3, in this case), then besides listing the objects using CUSF, the Physical Files on which the Logical File created are also reported.
If you select the Object Where Used on a variable in a *PGM type object, then all objects where the variable has been used are listed.
Select an object and click ENTER to access its Source List. Alternatively, double-click on that object row. Double-click on an object from the Object Where Used list to zoom on to the source line where the first reference has been made.
[image: ]
 Fig. 7.3.3 – Object Where Used – Usage References screen
For Entry Level References, the Fetch Next References option allows the user to view the references for a particular object at different levels. The maximum attainable level is 11 and the Fetch Next References toolbar button will be disabled if, in case, there is no references available for the next level. Click the toolbar button successively in order to get the next references. Refer to the screen below:
[image: ]
Fig. 7.3.4 – Entry Level References List
Select the Show Call Path option to display the path from the Entry level program to the referred object which may be a file/program, and on which the option for Object Where Used > Entry Level References are shown. Opt for the context menu on an object from the Entry Level references, and then select the Show Call Path option. Refer to the screen below:
[image: ]
Fig. 7.3.5 – Object Where Used - Entry Level References
[image: ]
Fig. 7.3.6 – Entry Level References List

	[image: ]
	 The Object Where Used references will always show usage for DSPF as Input/Output and for PRTF as Output. 
When the Object Where Used is selected on *MODULE, the program to which this module is an entry module and the references to this program will be included. 
The ‘Text’ Column will be renamed to ‘Text/Long Name’ column when at least one file with a long name is present and the Windows>Preferences>X-Analysis XX.X.X>Show Long Names for Files option is selected. 



[bookmark: _Toc97719730]Variable Where Used
The Variable Where Used option lists all source lines from the application, where the field/variable of a file/program is used/referenced in any of the source members and its associated device files and copybooks. 
A wide variety of options can be specified including: 
Files, Array Definitions, Data Structures, Sub-Fields Data Structures, Indicators, Key Lists, Data Fields, File Formats, Subroutines, Program Variable, Array Elements, Parameter Lists, Parameters, Key Fields, Message Ids, EXCPT Names, etc. 
The Variable Where Used submenu provides the following options: 
· All References: All references of this variable.
· Update References: References where this variable is being updated.
· File References: All references where the object using this variable is a file.
· Definitions Only: Lists references where this variable was defined.
· Summary References*: This option on a variable or File/Field, lists all members that use the selected variable or File/Field and also the usage for the same. The option is explained in more detail at the end of this section.
· Rule Variable References: Lists all Business Rules based on the selected object from across the entire application.
Select the Variable Where Used option for the CUSNO field using the JumpTo dialog.
[image: ]
 Fig. 7.4.1 – Variable Where Used view for CUSNO
[bookmark: _Toc97719731]Legend
· Dark Red depicts the Field Definition Statements in DDS sources only.
· Black depicts the File Operations.
· Magenta depicts the Parameters.
· Dark Brown depicts the Program Structure Operation.
· Dark Blue depicts the Field Operation.
[image: ]
 Fig. 7.4.2 – Legend for Variable Where Used
[bookmark: _Toc97719732]View Levels
The Variable Where Used view is available up to Level 6 view and the Default View Level icon, located on the toolbar allows access to these levels.
[image: ]
 Fig. 7.4.3 – Expanded View Level Menu

	[image: ]
	Default View Level for the Variable Where Used option can be set in the X-Analysis Preferences (General Preferences) window.


The Level selected is displayed in a separate column as shown in the screen below:
[image: ]
 Fig. 7.4.4 – Variable Where Used window showing the Level column
Higher Variable Where Used levels can be requested using VWU Levels. The Variable Where Used levels display the following information:
· Level 1: At this Level, the VWU process displays the direct occurrences of the variable. The same is followed when you select the Member X-Ref option. However, VWU at Level 1 also tracks non-direct references such as program key field mapping, embedded SQL field-to-variable mapping (includes field-to-field and variable-to-variable mapping), etc. Note that the same level In File/Field Where Used is only allowed on file fields, tracking the presence of that field with the combination of file in the programs.
[image: ]
 Fig. 7.4.5 – Variable Where Used Level 1 View
· Level 2: This level considers the dependent variables found at level 1 (that is, the variables, which are modified or being modified with the level 1 variable) and tracks them in addition to the entries loaded for level 1.
[image: ]
 Fig. 7.4.6 – Variable Where Used Level 2 View
· Level 3: This level considers the dependent variables found at level 2 (that is, the variables, which are modified or being modified with the level 2 variable) and tracks them in addition to the entries loaded for level 2.
[image: ]
 Fig. 7.4.7 – Variable Where Used Level 3 View
· Level 4/Parameters: This level considers the dependent variables found at level 3 (that is, the variables, which are modified or being modified with the level 3 variable) and tracks them in addition to the entries loaded for level 3. It also considers the dependencies of up to level 4 within the specific program for the parameters tracking in calling and called programs.
[image: ]
 Fig. 7.4.8 – Variable Where Used Level 4 / Parameters View
· Level 5/Cascading Parameters: This level considers the dependent variables found at level 4 (that is, the variables, which are modified or being modified with the level 4 variable) and tracks them in addition to the entries loaded for level 4. Extending the information in Level 4, Level 5 includes references where CUSNO fields are parameters in a function, called by another function.
In addition, parameters tracking (of the variables from level 1 to 4) is done but differently than level 4. In the case of level 4, the mapped parameter is tracked only for level 1. However, in this case, level 5 call gets submitted recursively to track the mapped parameter in that program (that is, calling and/or called program) at level 5. As the recursive call gets submitted at level 5, this will go till the top or bottom of the call stack to trace everything and would keep submitting level 5 dependency for everything.
[image: ]
 Fig. 7.4.9 – Variable Where Used Level 5 / Cascading Parameters View
· Maximum Tracking: Tracking at this level like that for level 5 in addition to identifying level 6 and level 7 dependencies (only in the program where the request is being made). The tracking outside the program boundary (that is, for calling and called program for cascaded parameter tracking) has no impact.
This way, we can say that Level 1, 2, 3, 6, and 7 have lightweight processing. Level 4 goes for parameter tracking of the entries found up to Level 3 and Level 5 goes for cascaded parameter tracking of the entries found up to Level 3.
[image: ]
 Fig. 7.4.10 – Variable Where Used – Maximum Tracking View
This is the highest view level, also referred to as ‘Maximum Tracking’. It displays Variable Where Used information for all the levels mentioned above, as well as any other possible references of the CUSNO field.
· Backtrack: The Backtrack feature allows a line on 'Variable Where Used' to be traced back when shown at level 2 or higher. The selected line highlights the Variable Where Used option of the variable line which was previously selected. For example, at level 4, the corresponding level 3, level 2, and level 1 lines will display. This allows users to understand why the current line was being shown as level 4 in the VWU result.
[image: ]
 Fig. 7.4.11 – Backtrack – Level 3 Variable
[image: ]
 Fig. 7.4.12 – Backtrack – Level 3 Variable
Please note that the Implicit Field Used In Program indicate fields which are being used as a key field but not directly used in the program.
	[image: ]
	Implicit Field Used In Program indicate fields which are being used as a key field but not directly used in the program.



	[image: ]
	Important note: Under the new VWU Process, tracking of constant literals is restricted to display only those lines where that constant is used. This action disables the tracking of the constant dependencies at further levels. To expand its usage, take the VWU option on the appropriate tracked variable.
The Paging Mechanism allows the user to see 20000 records per page at a time. Navigation is allowed through the pages by using the Next and Previous buttons present on the toolbar. Any sorting done on the columns is limited to the records on that page only. Navigation to the next page would result in the loss of any sorting. 
The Export All Records option, to an Excel sheet, is allowed on Variable Where Used records when the option is enabled, and the record count exceeds 20000. The other Export options allow exporting of records on that page only.


[image: ]
 Fig. 7.4.13 – Export All Records
*Summary References – The Variable Where Used > Summary References option opens a new editor showing the distinct summary of members, using the variable. The Usage Count column shows the number to times the variable is used.
[image: ]
 Fig. 7.4.14 – Window showing Summary References for CUSF
Qualified Field and File references in Embedded SQL
SQL statements can have qualified field and file references.
Variable Where Used can be performed on each element of the qualified field or file reference. Additionally, combinations from the qualified reference, that make sense, can also be used for Variable Where Used.
For example,
SELECT FNAME INTO: NAME FROM SALES
WHERE SALES.FNAME = 'Scott'
For the above SALES.FNAME, following can be searched via Variable Where Used feature:
· FNAME
· SALES
· SALES.FNAME
If the above qualified field were being modified in SQL statement like UPDATE, then following will return results when Update References will be opted.
· FNAME
· SALES.FNAME
	[image: ]
	At times, the desired combination may not be specified from the source right click menu. In such cases, and for any possible combination, the JumpTo dialog can be used to specify Variable Where Used, Variable Where Updated.



[bookmark: _Toc97719733]File/Field Where Used (FFWU)
The File/Field Where Used (FFWU) functionality works similar to the Variable Where Used with the only difference being that the tracking of the references is limited to the fields within the specified file; the VWU process does tracking at the global level. 
The FFWU for LFs works similar to FFWU for the PF. If multiple DB files (including the LF selected in FFWU) are used in any program then lines from all the referred files (that is, database file, printer file, device file, etc.) having the same field name will be traced in FFWU. Besides this, if the same name field is also present in any PF and its LF is used in the program, then lines from both PF and LF will also be traced. 

[bookmark: _Toc97719734]File Field Details
The File Field Details option displays the field details for a file. This option is available for objects having PF/LF attribute. 
Right-click for the context menu on a PF/LF from the Member/Object List and select the File Field Details option. The following window will be displayed.
[image: ]
 Fig. 7.5.1 – File Field Details for CUSF
If there are keys for a PF or LF, they are displayed in blue color as shown in the screen below.
[image: ]
 Fig. 7.5.2 – File Field Details showing key in blue color

[bookmark: _Toc97719735]LF/Access Paths
Access Paths refer to either the PF or LF. 
 Select the LFs/Access Paths option to display all Access Paths for the selected physical file. Opt for the context menu on a PF from the Object/Member List, and then select the LFs/Access Paths option.
[image: ]
 Fig. 7.6.1 – LFs / Access Paths
To browse a source of any LF, double-click on it or select the Zoom Source option from the context menu.
Note that the superset information is related to the number of key fields in different access paths for the specific PF. In other words, superset against an access path in this panel means another file contains the key fields of this access path (in the same order) and some additional key fields.
	[image: ]
	The LFs/Access Paths will now show the long name for the Files and Fields on the LF/Access Paths list when the long names exist and the Windows>Preferences>X-Analysis XX.X.X>Show Long Names for Files option is selected.



[bookmark: _Toc97719736][bookmark: 1191756488]Member X-Ref
The Member X-Ref option lists all source lines where the field/variable has been used/referenced, in the source member and its associated Device Files and Copybooks.
A wide variety of options can be specified including:
Files, Array Definitions, Data Structures, Sub-Fields of Data Structures, Indicators, Key Lists, Data Fields, File Formats, Subroutines, Program Variable, Array Elements, Parameter Lists, Parameters, Key Fields, Message Ids, EXCPT Names, etc.
Double-click on a field in source member displays Member X-Ref. Alternatively, choose the Member X-Ref option from the context menu.
When the user selects this option for a sub-item (such as a Sub-Field, Data Structure, Array Element, or File Format), a list of the sub-items along with all references to the parent items is displayed. Double-click on the source line to view the source of the object.
[image: ]
Fig. 7.7.1 – Member X-Ref view
[bookmark: _Toc97719737]Legend
· Dark Red depicts the Field Definition Statements in DDS sources only.
· Black depicts the File Operations.
· Magenta depicts the Parameters.
· Dark Brown depicts the Program Structure Operation.
· Dark Blue depicts the Field Operation.
[image: ]
Fig. 7.7.2 – Legend for Member X-Ref

[bookmark: _Toc97719738][bookmark: 1922473867]Enhanced Member X-Ref
The Enhanced Member X-Ref option displays the references of a variable in the member, along with information about how each subroutine handles this variable. It also presents the logical order in which the variable actually gets used, and not in the order of how it is physically placed in the source. 
[image: ]
Fig. 7.8.1.A – Enhanced Member X-Ref view
[image: ]
Fig. 7.8.1.B – Enhanced Member X-Ref view

[bookmark: _Toc97719739]Add Bookmark
Use the Add Bookmark option to access the facility and bookmark a selected source line in the Source List view.
[image: ]
 Fig. 7.9.1 – Add Bookmark option
Select this option to invoke a dialog as shown below. You can edit the name of the Bookmark as per requirement.
[image: ]
 Fig. 7.9.2 – Add Bookmark dialog
Click OK to bookmark the specific source line. The below screen shows the bookmarked source line.
[image: ]
 Fig. 7.9.3 – Bookmarked selection – *IN03
To remove the bookmark, right-click on the bookmarked field and select the Remove Bookmark option. Alternatively, use the Delete option from the X-Analysis Bookmarks window.
[image: ]
 Fig. 7.9.4 – X-Analysis toolbar displaying the X-Analysis Bookmarks icon
When you click the icon, the following window is invoked:
[image: ]
 Fig. 7.9.5 – X-Analysis Bookmarks window
You also have the option to ‘share’ the bookmarks. When shared, the bookmarks become visible to others who are using the same cross-reference.
The following window displays the Share option:
[image: ]
 Fig. 7.9.6 – X-Analysis Bookmarks context menu showing the Share option
[bookmark: _Toc97719740]Copy Variable Name
User may copy the variable name to the clipboard by simply clicking the option depicting variable name in the context menu as shown below:
[image: ]
 Fig. 7.10.1 – Copy Variable Name
[bookmark: _Toc97719741]Program Logic Documentation
[bookmark: _Toc97719742]Data Flow Diagram
A Data Flow Diagram (DFD) is a diagrammatic representation of the data flow. A particular application contains many files and programs, and a DFD depicts all possible interrelationships among these multiple files and programs contained within that application. A color-coded DFD simultaneously plays the dual role of presenting the data flow at the high object level, in addition to providing contextual details regarding specific variables and parameters passed between objects.
The Bus Routing DFD offers two benefits. First, it gives a precise idea of where and how the inputted data affects the desired output; second, it helps to visualize how an object within an application correlates with the other objects. The diagrams showing the data flow in neat blocks let even non-technical users get a clear picture of the object(s) interrelationships.
Select the Data Flow Diagram option from the context menu over an object, as shown below:
[image: ] Fig. 8.1.1 – Data Flow Diagram option
This brings up the DFD for the object, CUSF.
[image: ] Fig. 8.1.2 – Data Flow Diagram
The DFD is also a graphic equivalent of the Object Where Used data. Besides the Logical Views/Access Paths for CUSF, you can see how CUSF fits into the application (that is, the programs that update CUSF, programs that use CUSF as an input file, and so on).
You will see how the dynamic and interactive diagram facilitates access to other features contained within an object. There are varied and flexible features and options like Hide/Show Objects, Expand/Collapse Referenced Objects, View Annotation, Attributes – all of these and more are explained ahead.
	[image: ]
	In program-centered DFDs, the display files or DSPFs will be shown as Input/Output Files. In an object-centered DFD on a DSPF, programs will be shown as Input/Output Programs. 
 In an object-centered DFD on a PRTF, the programs will be shown in the Output mode whereas in the program-centered DFD, the PRTF will be shown in the Output mode.


[bookmark: _Toc97719743]Hide/Show Objects
To have a better understanding of object interrelationships, the user can hide/show all objects pertaining to programs. A single-click action on the icon alongside the objects enables you to hide/show objects.
In the following screen, the icon against Access Paths is clicked to hide objects.
[image: ] Fig. 8.1.3 – Hide Objects icon
The following screen shows how another click displays all the objects within.
[image: ] Fig. 8.1.4 – Show Objects icon
[bookmark: _Toc97719744]Expand/Collapse Referenced Objects
The DFD takes another dynamic form when you expand the referenced object(s) on selecting a particular category from the main object’s box. The following screen displays how the user can perform the action:
[image: ] Fig. 8.1.5 – Expand Referenced Objects
A single click on the arrow icon adjacent to Update Programs shows the objects updating CUSF. The following screen displays the expanded view of the referenced objects’ list:
[image: ] Fig. 8.1.6 – Expanded view of Update Programs
[bookmark: _Toc97719745]View Annotation
The View Annotation option allows user to see annotation for a specific object. There is a red icon denoting Annotated text on the right side of the Object. Refer to the below screen.
[image: ] Fig. 8.1.7 – View Annotation option
Double-click on the View Annotation icon to invoke the Annotation dialog box, displaying the notes that had been written earlier.
You can further add/modify notes in the Annotation dialog box and click Save. The user can view these notes later, using the same option.
[image: ]
 Fig. 8.1.8 – Annotation dialog box
[bookmark: _Toc97719746]Attributes
The Attributes feature comprises the impacted fields of a particular object. Through these fields, the main object is referenced.
[image: ] Fig. 8.1.9 – Attributes icon
The different objects corresponding to the main object have fields within them, implicit as ‘Attributes’. These are easily accessible by a single-click on the Attributes icon. The term ‘Attributes’ is changed to related attribute – input, update, output, etc., on expanding the Attributes button, as shown below:
[image: ] Fig. 8.1.10 – Expanded Attributes
[bookmark: _Toc97719747]Detail DFD icon
The Detail DFD presents the field usage of all the objects.
[image: ] Fig. 8.1.11 – Detail DFD icon
When you click on the Detail DFD icon on the toolbar, the Attributes section of all the objects gets expanded, displaying referred fields from all objects.
The following screen displays the detailed DFD screen:
[image: ] Fig. 8.1.12 – Detail DFD view
	[image: ]
	The Detailed Data Flow Diagram or Field Usage on Data Flow Diagram will now show the long name for the files when the long names exist and the Windows>Preferences>X-Analysis XX.X.X>Show Long Names for Files option is selected.


[bookmark: _Toc97719748]Legend icon
The Legend icon on the toolbar displays details of the color scheme used by the DFD. Click the icon shown below:
[image: ] Fig. 8.1.13 – Legend icon
The color scheme helps in understand the reference and association of specific objects, like how each object is referred to or used by the main object on which the DFD was opted. The expanded view of the Legend is given below.
[image: ] Fig. 8.1.14 – Legend Expanded
Each object box has a colored square or disk on the top left corner. A disk denotes that the object is a file, whereas a square denotes a program. The description of the DFD Legend is as follows:
· Access Path – This is the LF for the File on which the Data Flow Diagram has been opted.
· Called – This is to represent programs called by the main program.
· Calling – This denotes the programs calling the main program.
· Input – For a program-centered DFD, this denotes an input file. For a file-centered DFD, this denotes a program taking input from the file.
· Internal Routines – These are Synon-specific routines being called from a 2E program.
· Output – For a program-centered DFD, this denotes an output file. For a file-centered DFD, this denotes a program giving output to the file.
· Update – For a program-centered DFD, this denotes an update file. For a file-centered DFD, this denotes a program updating the file.
[bookmark: _Toc97719749]DFD Restricted to an Application Area
X-Analysis provides an additional feature related to DFDs. You can restrict the DFDs to the selected application area by clicking on the Restrict To Application Area icon. Clicking the icon will display only those child objects which belong to that particular selected application area.
The following screen displays the DFD on CUSF. Notice that the Restrict To Application Area icon is disabled. This is so because this option only gets enabled when any application area is selected.
[image: ] Fig. 8.1.15 – DFD on CUSF with disabled Restrict To Application Area icon
Now select the application area, MVCPROCESS.
Select the Data Flow Diagram option on CUSF; notice that the Restrict To Application Area icon is enabled (see the following screen). This is so because you have selected an application area.
[image: ] Fig. 8.1.16 – Data Flow Diagram on CUSF with enabled Restrict To Application Area icon
Now, click Restrict To Application Area icon as shown below:
[image: ] Fig. 8.1.17 – Clicking Restrict To Application Area icon
The following screen is displayed:
[image: ] Fig. 8.1.18 – Restricted DFD on CUSF for application area, MVCPROCESS
This shows that the child objects belong to the application area, MVCPROCESS.
	[image: ]
	While using the Restrict To Application Area feature, ensure that the originally-selected application area is not changed.
When the Data Flow Diagram is selected on *MODULE, the program to which this module is an entry module and the references of this program will be included.



[bookmark: _Toc97719750]Structure Chart Diagram
Before going to documenting program logic, it is imperative to understand how control transfers from one program to the next. 
 A Structure Chart Diagram (or SCD) addresses this issue and represents the control through graphical, color-coded block diagrams. SCD is a nested tree diagram that shows the complete call hierarchy of the ‘programs called’. These diagrams contain relevant information as per control flow and call structure. Also, the user can view data input objects and avail of a summarized description for each of the objects. Important functional aspects like updates, prints, and displays are color-coded to help the user to instantly focus on these commonly preferred details. 
[image: ] Fig. 8.2.1 – Structure Chart Diagram
[bookmark: _Toc97719751]Legend
The SCD Legend describes the type of object displayed.
· Update – This depicts the program that updates a file.
· Display – This depicts the program that uses a Display file.
· Print – This depicts the program that uses a Print file.
· Input – This depicts the program that uses an Input file.
· Output – This depicts the program that writes to a file.
· Command – This simply depicts a Command.
· Others – This refers to the Programs where it is referring to a file which is not Update/Display/Print/Input/Output.
· Internal Routine – This refers to the Synon-specific routines.
· Indeterminate – This depicts the programs where the usage cannot be programmatically determined.
· Trigger – This depicts the program which is a Trigger.
· Module – This depicts the program which is a Module.
[image: ]
 Fig. 8.2.2 – Rollup Group
The Rollup group describes the cumulative component function of the program and its dependents.
The following types of Rollup groups are available:
· UPD – At least one program updates a file.
· PRT – Program and dependent programs create a printed report.
· DSP – Program and dependent programs use input files and display files.
· OTH – No cumulative component function can be determined.
[bookmark: _Toc97719752]Annotate
X-Analysis also allows annotation on the Structure Chart.
Select an object displayed in the SCD and opt for the Annotate option from the context menu.
[image: ]
 Fig. 8.2.3 – Annotate option
This brings up the Annotation dialog box. The user must write their note and click Save. The annotation is stored in a file available in the cross-reference library.
[image: ]
 Fig. 8.2.4 – Annotation dialog box for OEMENU
Regenerate the SCD to check for any object annotations.
[image: ]
Fig. 8.2.5 – Annotation icon for OEMENU in a re-generated SCD
Double-click the Annotation icon to bring up the Annotation dialog box.
[bookmark: _Toc97719753]Function Type
Function Type describes the function of the object and is based on COOL: 2E definitions.
[bookmark: _Toc97719754]Hierarchy Exclusions in SCD
Work with Exclusions is Option 16 on the Work with X-Analysis/4 Applications screen. With the help of this feature, the user can add a program’s name for Hierarchy Exclusions. This affects the SCD and the OSC. This feature removes the child nodes of the excluded object, and a green arrow is displayed to indicate the hierarchy exclusion. The below sample screen shows this feature.
[image: ]
 Fig. 8.2.6 – Hierarchy Exclusions in SCD
[bookmark: _Toc97719755]Repeated nodes in SCD
The SCD displays the repeated objects (having child nodes) with a green arrow beside them. The following sample screen demonstrates the repeated nodes in an SCD.
[image: ]
 Fig. 8.2.7 – Repeated nodes in SCD
[bookmark: _Toc97719756]Structure Chart Diagram with Files
The SCD provides a graphic display of the program-to-program relationships. The SCD with files also displays associated files along with programs. Note that the associated files, data areas along with programs get displayed, but the user-defined printer files and the display files are not displayed.
To see the SCD with files, click Show Files icon available on the SCD toolbar.
[image: ]
 Fig. 8.2.8 – Show Files icon
[image: ]
 Fig. 8.2.9 – Structure Chart Diagram with I/O Files
[bookmark: _Toc97719757]Structure Chart Diagram – Show Overridden Files Only
In the case of only CLP/CLLE objects, the SCD has the feature that displays the Overridden Files. The following sample screen shows the Show Overridden Files Only icon.
[image: ]
 Fig. 8.2.10 – Show Overridden Files Only icon
Click this icon to display the overridden files as shown in the following window:
[image: ]
 Fig. 8.2.11 – SCD – Show Overridden Files Only window
[bookmark: _Toc97719758]Detailed Structure Chart
Generate the Detailed SCD by clicking the Show Narratives icon from the toolbar of both the SCD and the Expanded Structure Chart Diagram. The program narratives, all the associated files including PRTFs/DSPFs and the data areas along with called programs will be displayed.
The following screen shows the icon.
[image: ]
 Fig. 8.2.12 – Show Narratives icon
The screen below shows the detailed SCD for the selected object, FAXSHT.
[image: ]
 Fig. 8.2.13 – Detailed Structure Chart Diagram
[image: ]
 Fig. 8.2.14 – Rollup Group
The Rollup group describes the cumulative component function of the program and its dependents.
The following types of Rollup groups are available:
· UPD – At least one program updates a file.
· PRT – Program and dependent programs create a printed report.
· DSP – Program and dependent programs use input files and display files.
· OTH – No cumulative component function can be determined.
[bookmark: _Toc97719759]Show Files Mode
The SCD in Show Files mode displays the Expanded Structure Chart with all the associated files and data areas which are referred by the programs shown in the diagram.
To generate the Expanded Structure Chart, click Show Files icon.
[image: ]
 Fig. 8.2.15 – Show Files icon on toolbar
After clicking the icon, the following window will open, displaying the details.
[image: ]
 Fig. 8.2.16 – SCD (Show files mode)
The Show Files icon has toggle behavior. Click it again (Normal SCD icon) to return to the normal view of the Structure Chart.
	[image: ]
	In the Structure Chart Diagram, the Detailed as well as the Show Files mode will now show the long name for the files when the long names exist and the Windows>Preferences>X-Analysis XX.X.X>Show Long Names for Files option is selected.




	[image: ]
	The setting of the XDLTCLREF data area as *YES or *NO controls whether to retain overridden file references for the CL programs or delete them. Since this data area is set to *YES by default, it means all the override types of file references from the CL program will be deleted. You can set this to *NO to retain all the references (including overrides). In the Expanded Structure Chart or the Detailed Structure Chart, the override type of files will be visible as a referrred file when the data area is set to *NO. These files will also be visible on the Data Flow Diagram in such a case.


[bookmark: _Toc97719760]Function Type
Function Type describes the function of the object and is based on COOL: 2E definitions.
[bookmark: _Toc97719761]Application Area SCD
When you select the Structure Chart Diagram option on an application area (the application area node should be selected), then objects not belonging to the selected application area are highlighted in blue. The names of the application areas are displayed on the tool tip of those objects which do not belong to the selected application area.
	[image: ]
	While using the Restrict To Application Area feature, ensure that the originally-selected application area remains the same.


[image: ]
 Fig. 8.3.1 – Structure Chart Diagram for WWCCONSC when Application Area is selected

	[image: ]
	SCD can be limited by volume or number of objects shown. This is applicable to the interactive mode of SCDs. You must set the ‘Preferred Volume Limit’ in the X-Analysis General Preferences dialog.
Exporting very large SCDs to MS Word or PDF may show the incomplete diagram because the number of pages to be exported is limited to 100 pages and 120 pages respectively



[bookmark: _Toc97719762]Hierarchical Structure Chart Diagram
The Hierarchical Structure Chart Diagram offers a different layout for viewing the SCD. This illustration gives a well-defined view of all the programs by representing their control flow and call structure. Neat, color-coded bus routing block diagrams depict the movement of control/programs. 
Like the SCD, the Hierarchical Structure Chart Diagram displays the repeated objects (having child nodes) as expanded and shaded in green. 
Select the Hierarchical Structure Chart option for any object from the context menu. In the following screen, OEMENU is selected. 
[image: ]Fig. 8.4.1 – Hierarchical Structure Chart option
The screen below shows the delineation of the main object OEMENU into several blocks of related objects in the order of calling. The color codes signify the identity of objects as command-based or input-based or print-based, and so on.
[image: ]Fig. 8.4.2 – Hierarchical Structure Chart
[bookmark: _Toc97719763]Narration
Access the additional details related to an object through the icon in the screen below.
[image: ]Fig. 8.4.3 – Narratives icon
Click on the icon displayed above to invoke a pop-up window which provides the auto-generated narration for the program, as shown below:
[image: ]Fig. 8.4.4 – Narratives pop-up box
[bookmark: _Toc97719764]Referred Files
The Hierarchical Structure Chart has a feature that displays the referred files inline. An expandable icon called Referred Files is available in each box. Click on the icon preceding Referred Files in the screen below.
[image: ]Fig. 8.4.5 – Referred Files
The box will expand to display the files referred to by OE001. The color-coded geometric shape before the file name indicates the file type.
[image: ]Fig. 8.4.6 – Referred Files – Expanded
[bookmark: _Toc97719765]Show Root Node
Click the Show Root Node icon to display the root node:
[image: ]Fig. 8.4.7 – Show Root Node icon
[bookmark: _Toc97719766]Legend icon
The Legend icon on the toolbar displays details of the color scheme used by the Hierarchical SCD. The colors help in establishing the reference and association of specific objects. Click the Legend icon, as shown below:
[image: ]Fig. 8.4.8 – Legend icon
The following screen shows the expanded view of the Legend:
[image: ]Fig. 8.4.9 – Legend expanded
The description of the HSC Legend is as follows:
· Update – This depicts the program that updates a file.
· Display – This depicts the program that uses a Display file.
· Print – This depicts the program that uses a Print file.
· Input – This depicts the program that uses an Input file.
· Output – This depicts the program that writes to a file.
· Command – This simply depicts a Command.
· Others – This refers to the Programs where they are referring to a file which is not Update/Display/Print/Input/Output.
· Internal Routine – This refers to the Synon-specific routines.
· Indeterminate – This depicts the programs where the usage cannot be programmatically determined.
· Trigger – This depicts the program which is a Trigger.
· Module – This depicts the program which is a Module.

[bookmark: _Toc97719767]Inverted Structure Chart
The Inverted Structure Chart depicts the reverse order of the calling programs. In other words, it tracks down the backward movement of how a specific program gets called. It shows the immediate calling programs that may be the same for the other called programs. In the screenshot below, XCMMENU program is calling for both WWCUSF and CUSFMAINTC along with the main called program, CUSFMAINT.
[image: ]
 Fig. 8.5.1 – Inverted Structure Chart
[bookmark: _Toc97719768]Legend
The image and the description of the Inverted Structure Chart Legend are as follows:
[image: ]
 Fig. 8.5.2 – Legend
· Update – This depicts the program that updates a file.
· Display – This depicts the program that uses a Display file.
· Print – This depicts the program that uses a Print file.
· Input – This depicts the program that uses an Input file.
· Output – This depicts the program that writes to a file.
· Command – This simply depicts a Command.
· Others – This refers to the Programs where they are referring to a file which is not Update/Display/Print/Input/Output.
· Internal Routine – This refers to the Synon-specific routines.
· Indeterminate – This depicts the programs where the usage cannot be programmatically determined.
· Trigger – This depicts the program which is a Trigger.
· Module – This depicts the program which is a Module.
The Inverted Structure Chart can also be viewed as the diagrammatic representation of Object Where Used > Entry Level References for a particular program. The references appear as a list in tabular form that gives the lead of the calling object. In this case, it is XCMMENU, as shown in the screen below:
[image: ]
 Fig. 8.5.3 – Entry Level References List

[bookmark: _Toc97719769]Program Structure Chart/PSC
The Program Structure Chart graphically displays the sequence of calls in the program. The call operation can perform the following:
· Execute a Subroutine
· Execute a Sub-Procedure
· Execute a Program/Module/Service Program.
The subroutines are displayed as small rectangles with a grey background, displaying the name of the subroutine. The object’s Function Type determines the coloring of all other boxes namely, Programs, Modules, and Service Programs.
The boxes, other than the subroutine boxes, are of the size of program element as on the Structure Chart.
[image: ]
 Fig. 8.6.1 – Program Structure Chart
The menu options and context menu options on the PSC work the same way as on the SCD, except for the Zoom Source option.
Note that in the case of Synon applications, the PSC also displays the internal routines. Refer to Appendix C – X2E Specific Features for details.
	[image: ]
	If there is no Main Procedure and only sub-procedures exist, then the PSC displays each sub-procedure's PSC independently, one after the other. If no sub-procedures exist, then the PSC only displays the program.


[bookmark: _Toc97719770]Legend
[image: ]
 Fig. 8.6.2 – Legend
There are two colors in the PSC Legend. White depicts the calling Programs or Modules. Gray depicts the calling Subroutines or Procedures.
 

[bookmark: _Toc97719771]Overview Structure Chart/OSC
The OSC gives a snapshot of an application displaying all entry points to the application. The details of all the mainline entry-level programs are displayed, giving an idea of the modules and sub-modules present in an application. 
	[image: ]
	Note that similar to exporting very large SCDs, exporting large OSCs to MS Word or PDF may show an incomplete diagram because the number of pages to be exported has been limited to 100 pages and 120 pages respectively. 


 The Overview Structure Chart node is available under the cross-reference library node and application area(s) node. Double-click the Overview Structure Chart node to display the following dialog. 
[image: ]
 Fig. 8.7.1 – Overview Structure Chart dialog
The Overview Structure Chart dialog prompts you to:
1. Select the Application Area name, if available, else leave it as *NONE.
2. Choose the Object Library from the drop-down list.
3. The Program Name will be set as *ALL.
Click OK to display the Objects’ OSC based on the selection criterion.
[image: ]
 Fig. 8.7.2 – Overview Structure Chart window
[bookmark: _Toc97719772]Legend
The description of the OSC Legend is as follows:
[image: ]
 Fig. 8.7.3 – Legend
· Update – This depicts the program that updates a file.
· Display – This depicts the program that uses a Display file.
· Print – This depicts the program that uses a Print file.
· Input – This depicts the program that uses an Input file.
· Output – This depicts the program that writes to a file.
·  Command – This simply depicts a Command.
· Others – This refers to the Programs that are referring to a file which is not Update/Display/Print/Input/Output.
· Internal Routine – This refers to the Synon-specific routines.
· Indeterminate – This depicts the programs where the usage cannot be programmatically determined.
· Trigger – This depicts the program which is a Trigger.
· Module – This depicts the program which is a Module.
The OSC can be expanded/collapsed using the button on the lines.
[image: ]
 Fig. 8.7.4 – Collapse
[image: ]
 Fig. 8.7.5 – Expand
[image: ]
 Fig. 8.7.6 – Rollup Group
The Rollup group describes the cumulative component function of the program and its dependents.
The following types of Rollup groups are available:
· UPD – At least one program updates a file.
· PRT – Program and dependent programs create a printed report.
· DSP – Program and dependent programs use input files and display files.
· OTH – No cumulative component function can be determined.
[bookmark: _Toc97719773]Function Type
Function Type describes the function of the object and is based on COOL: 2E definitions.
[bookmark: _Toc97719774]Hierarchy Exclusions in OSC
Work with Exclusions is an option on the Work with X-Analysis/4 Applications menu (Option 16). Use this feature to add a program’s name for Hierarchy Exclusions. It affects the OSC and the SCD. This feature removes the child nodes of the excluded object, and a green arrow is displayed to indicate the hierarchy exclusion.
[bookmark: _Toc97719775][bookmark: 1994131008]Repeated Nodes in OSC
The OSC displays the repeated objects (having child nodes) with a green arrow beside them.
The following screen displays repeated nodes in OSC.
[image: ]
 Fig. 8.7.7 – Repeated nodes in OSC
[bookmark: _Toc97719776][bookmark: 613217553]Detailed OSC
Click on the Show Narratives icon to invoke the Detailed Overview Structure Chart. It is available on the toolbar associated with the OSC.
[image: ]
 Fig. 8.7.8 – Detailed OSC
[image: ]
 Fig. 8.7.9 – Rollup Group
The Rollup group describes the cumulative component function of the program and its dependents.
The following types of Rollup groups are available:
· UPD – At least one program updates a file
· PRT – Program and dependent programs create a printed report
· DSP – Program and dependent programs use input files and display files
· OTH – No cumulative component function can be determined.
[bookmark: _Toc97719777][bookmark: 656213164]Show Files Mode
The OSC in Show Files mode displays the Overview Structure Chart with all the associated files and data areas, which are referred by the programs shown in the diagram.
To generate the Overview Structure Chart, click Show Files icon.
[image: ]
 Fig. 8.7.10 – Show Files icon on toolbar
After clicking the icon, the following window will open, displaying the details.
[image: ]
 Fig. 8.7.11 – OSC (Show files mode)
The Show Files icon has toggle behavior. Click it again (Normal SCD icon) to return to the normal view of the Overview Structure Chart.
	[image: ]
	In the Overview Structure Chart, the Detailed as well as the Show Files mode will now show the long name of the files when the long names exist and the Windows>Preferences>X-Analysis XX.X.X>Show Long Names for Files option is selected.


[bookmark: _Toc97719778]Function Type
Function Type describes the function of the object and is based on COOL: 2E definitions.
[bookmark: _Toc97719779][bookmark: -1972732709]OSC with Files
The Normal Overview Structure Chart displays a snapshot of an application using programs only. Click the Show Files icon available on the OSC toolbar to display the available files along with the programs.
[image: ]
 Fig. 8.7.12 – Overview Structure Chart with I/O Files
[bookmark: _Toc97719780]Application Area with OSC
When you select the OSC option on an application area (ensure that the Application Area node is selected), then objects not belonging to the selected application area are highlighted in blue. The names of application areas are displayed on the tooltip which do not belong to the selected application area.
[image: ]
 Fig. 8.7.13 – OSC on selected application area, MVCPROCESS

[bookmark: _Toc97719781]Screen/Report Design
The Screen/Report Design option works on Display and Printer Files. It displays the actual layout for the Display/Printer file. This option also works on program objects (RPG, RPGLE, and MENU) and displays the layout of the associated Display/Printer files.
Note that to view the Screen Fields details, the X-Rules license is mandatory as these details are shown only after the Business Rules have been generated. If the required authority is missing, the Screen Fields view will be blank.
[image: ]
 Fig. 8.8.1 – Screen/Report Design view
	[image: ]
	If more than one Display or Printer File is associated with a program, then the Screen/Report Design will display Screen Design list icon for selecting the DSPF/PRTF to display.



	[image: ]
	The Screen/Report Design will now show the long name for the files and fields on the Screen Fields list when the long names exist and the Windows>Preferences>X-Analysis XX.X.X>Show Long Names for Files option is selected.


[image: ]
 Fig. 8.8.2 – Select Layout for DSPF/PRTF
[image: ]
 Fig. 8.8.3 – Screen/Report Layout view
If you select the Screen/Report Design option while documenting, then the current Screen Design will be printed with the Field Details. An option for detailed documentation of Screen Design has been provided in the System Documenter Wizard. Select the Detailed option to print the DCD, ACD, and header information for each screen.

[bookmark: _Toc97719782]Screen Flow Diagram
The Screen Flow Diagram is an extended form of Activity Diagram for RSA/RSM. It displays the screens’ flow for a program. This diagram is available on RPGLE/RPG. There are four types of screens:
· Subfile (Screen with a dependent grid)
· Update capable screen
· Display only screen
· Repeated node
Select WWCONHDR from the Object List of the tutorial application. Opt for the context menu on it, and then select the Screen Flow Diagram option. The following screen displays the Screen Flow Diagram for WWCONHDR.
[image: ]
 Fig. 8.9.1 – Screen Flow Diagram
[bookmark: _Toc97719783]Legend
The Screen Flow Diagram Legend illustrates the type of object displayed.
[image: ]
 Fig. 8.9.2 – Legend
· Subfile – This refers to the object using a Subfile.
· Update – This refers to the object updating a file.
· Display – This refers to the object using a Display file.
· Primary File – This refers to the PF used by the object.
· Secondary File – This refers to the Secondary File used by the object.
· Indeterminate – This refers to the objects where the usage cannot be programmatically determined.
[bookmark: _Toc97719784]Repeated Nodes in Screen Flow Diagram
The Screen Flow Diagram displays the repeated nodes in their original color. Also, an arrow of the same color is displayed for the repeated nodes (having child nodes). The following screen displays repeated nodes in Screen Flow Diagram.
[image: ]
 Fig. 8.9.3 – Screen Flow Diagram with the repeated node
The Show Files icon is provided to show the files used by the function.
[image: ]
 Fig. 8.9.4 – Show Files icon
When the user clicks Show Files icon, all the files related to the selected object are displayed, as shown below:
[image: ]
 Fig. 8.9.5 – Screen Flow Diagram for WWCONHDR with Files

	[image: ]
	The functions in Screen Flow Diagram suffixed with "G" denote the grid display corresponding to the subfile record format of the display file used in the program. The ones suffixed with "D" represent the screen functions for the flat screen record format of the display file.



[bookmark: _Toc97719785]Access Path Diagram
The Access Path Diagram is the diagrammatic representation of LFs/Access Paths lists. The LFs/Access Paths displays all the access paths for a selected physical file.
[image: ]
 Fig. 8.10.1 – Access Path Diagram option on DMD
 Opt for the context menu on that PF to generate the Access Path Diagram for a PF, and then select the Access Path Diagram option. 
The following diagram displays the Access Path Diagram for CUSF. 
[image: ]
Fig. 8.10.2 – Access Path Diagram for CUSF

	[image: ]
	The Access Path Diagram will now show the long name for the files when the long names exist and the Windows>Preferences>X-Analysis XX.X.X>Show Long Names for Files option is selected.


[bookmark: _Toc97719786]Legend
The Access Path Diagram Legend displays the following:
[image: ]
Fig. 8.10.3 – Legend
· Main – This depicts the main object.
· Alternative PID – This depicts the alternative Primary Identifier file.
· Logical File – This depicts the LF for the selected object.
[bookmark: _Toc97719787]Data Model Diagram
The Data Model Diagram (or DMD) displays file relationships for a File within the X-Ref library or an application area. The related members are displayed distinctly in yellow, while the external Objects (applicable only in the application area) are displayed in blue. The unrelated member is depicted in faded brown which distinguishes it from the related members. 
The color of the lines across the diagram means: 
· Red line depicts 'Refers to' relation
· Blue line represents 'Owned by' relation
· Black Line represents ‘Multiple’ relations
When the number of files and relations are high, then two parallel lines may show as overlapped. When the lines are too close, it may seem that both connect to the same set of files, but in reality, it may be connecting to a different file in the same Row/Column. The tail of the arrow depicts the Dependent file, whereas the head represents the Parent file. As you can see below, CNTACS is a dependent file, whereas ASTATUS is the parent file.
[image: ]
Fig. 9.1.1.A – DMD for XAN4CDXA Demo Application
[image: ]
Fig. 9.1.1.B – DMD for XAN4CDXA Demo Application
The File Connection details are displayed in the Relationships in DMD view.
The Where Extracted option enlists all the programs that make the relation to be identified. The user can use this option from the context menu on the relationship in the DMD view.
[image: ]
Fig. 9.1.2 – Where Extracted option
[image: ]
Fig. 9.1.3 – Where Extracted information
Single-click on a specific object shows the references of that object. For instance, click on CUSTS to view its references.
[image: ]
Fig. 9.1.4 – DMD of XAN4CDXA – with CUSTS selected

	[image: ]
	When at least one or more files are defined using a long name and Windows> Preferences>X-Analysis XX.X.X>Show Long Names for Files option is selected, the box size for all the files in Data Model Diagram will increase to accommodate the long names. 



[bookmark: _Toc97719788]Legend
The DMD Legend depicts the relationship type of the object(s).
[image: ]
Fig. 9.1.5 – Legend
· Refer To – This depicts a relationship where a non-key field of another file is referred. In other words, the high-level key field(s) of the referenced file to be included as any lowest level key entries on the referring file.
· Owned By – This depicts a relationship where the key field of another file is referred.
· Uni-Directional – This depicts one to one database relationship; more simply, a singular relationship between two objects.
· Multiple Rels – This depicts multiple relationships (that is Refer To, Owned By, and Uni-Directional) between two objects.
· Internal – This depicts the file internal to an application area.
· External – This depicts the file external to an application area.
· Extended By – This depicts a special kind of Refers to which is seen in Synon applications.
· Unrelated Files – This shows unrelated files.
· Join File Relations – This depicts a relation between two files when they are used in a JOIN in a Logical file/View.

[bookmark: _Toc97719789]Generating Data Model Diagram
	[image: ]
	Refer to the section “Generating Data Model Diagram” in the document “X-DataTest_User_Manual” for this release. 


[bookmark: _Toc97719790]DMD for an Application Area
The user can also generate the DMD for an application area. The user can opt for it either by expanding the application area under the cross-reference library node or by selecting the specific application area name on the Data Model Diagram dialog.
The DMD for an application area is restricted to that application area, representing the relationships among the related objects of the application area.
[image: ]
 Fig. 9.2.1.A – DMD for Application Area MVCPROCESS (Restricted)
[image: ]
 Fig. 9.2.1.B – DMD for Application Area MVCPROCESS (Restricted)
Click Unrestrict, To Application Area icon, to un-restrict the application area of the DMD.
[image: ]
 Fig. 9.2.2.A – DMD for Application Area MVCPROCESS (Un-Restricted)
[image: ]
 Fig. 9.2.2.B – DMD for Application Area MVCPROCESS (Un-Restricted)

	[image: ]
	While using the ‘Restrict To Application Area’ feature, ensure that the originally-selected application area is not changed.



[bookmark: _Toc97719791]Understanding Data Model Database
The metadata database that underlies X-Analysis is a valuable resource and contains information that can be leveraged for your purposes. 
There are five core tables that are generated by the X-Analysis data modelling process. These tables are listed below. 

	Feature
	Brief Description 

	XPIDS 
	Primary identifiers 

	XDD
	Data dictionary

	XRELS
	Relationships

	XSHKEYS
	Relationship detail

	XKEYMAP 
	Access paths 



[image: ]
 Fig. 9.3.1 – X-Analysis Data Model Database
The easiest way to view the data in the data model is to use the Data Dictionary facility provided within X-Analysis.
1. Open the Customer Maintenance System in X-Analysis.
2. Click the Data Dictionary icon on the toolbar.
[bookmark: _Toc97719792]Business Rules Analysis
Fresche Solution’s Business Rules Extraction software, X-Rules, can be used to highlight the business rules within a source member using X-Analysis. Using X-Rules, the user may identify the business logic and narrate it from individual programs or parts of the entire system. This business logic, thus extracted, is analyzed and documented using the various related features of X-Analysis.
The Business Rules of an application are what make the application function uniquely. While X-Analysis can expose the Business Rules implicit in the data and process models of an application, this does not entirely account for the vast amount of business logic that is buried inside the source code of the programs.
X-Rules is capable of identifying and narrating this logic automatically from individual programs or parts of the entire system. The business rules logic can then be analyzed and documented with the powerful and interactive source browser integrated with X-Analysis.

[bookmark: _Toc97719793]Business Rules
The program source is grouped into discrete blocks of logic so that each block represents a particular execution of a business rule. This block of code is then converted into ‘Pseudo Code’ that describes the execution of the logic. Literals and constants are liberally used in the narration, wherever possible, giving very accurate descriptions of the logic. Each rule has an exclusive identifier that makes system-wide analysis and documentation of business rules possible in X-Analysis.
The user can achieve this entire process by invoking a single command on X-Analysis. The business rules generation process identifies the various components of the business rules and writes them too either:
1. A new source member or
2. An index over the original source member.
	[image: ]
	X-Analysis can display business rules automatically using the generated index.


X-Rules not only identifies the Business Rules Logic, but also generates a prototype application for a part of the original application.
X-Rules uses the X-Analysis cross-reference database and the original application program source code to provide shadow programs for the functions in the prototype application. These shadow programs contain all the business rules logic from the original programs. These rules include all field validation that is additional to the normal database integrity checks (which are generated automatically), calls to batch programs for additional functions, and secondary file processing.
The primary criteria to track Business Rules are the presence of CAS, COMP, IF, ELSEIF, and WHEN statements.
For the secondary criteria, the following are specified:
· The condition involves one or more database fields.
· The condition contains the screen fields which get tracked to the database fields.
· The condition involves the %EQUAL, %FOUND, %EOF built-in functions.
· The condition contains the resulting indicators for the database I/O operations (analogous to %EQUAL, %FOUND, and %EOF built-in functions).
· The presence of the conditioning indicators for some other operation codes (for example, CHECK, SCAN, and LOOKUP).
Based on the above specifications, the recovered logic contains the following business rules components:
· Field Validations
· Calls to other (significant) programs
· Secondary (database) file updates
· Non-owner file reads

[bookmark: _Toc97719794]Derive Business Rules
This option is available on the context menu of a cross-reference library and an application area. The Business Rules may only be generated for RPG, RPGLE, and CBL objects (*PGM, *MODULE type).
The Derive Business Rules option on an individual program calls the XBIZRULES command. This command uses the X-Analysis databases to re-engineer all relevant functionality from a legacy program.
The extracted code comprises the following:
· Validations
· Batch Program Calls
· Secondary File Updates
· Non-owner File reads
The Derive Business Rules option on an individual *PGM or *MODULE object invokes the following dialog:
[image: ]
 Fig. 10.1.1 – Derive Business Rules dialog
The process involves identifying a few key components of the program, including message statements, return codes, and validation flags. Then, the significant update files are identified. After the process is over, the program is scanned for statements that represent any of the above logic types. These statements are written to the file XEXTRGLINS – the "Trigger Lines" file, which is then used to produce the required output.
The Derive Business Rules option for the entire application or a single application area calls the XGENBRULES command.
[image: ]
 Fig. 10.1.2 – Derive Business Rules dialog on an Application Area
This command will identify the business rules logic in each program in the application over which the specified cross-reference database has been built. A source member containing the business rules logic and narrative describing each rule is generated for each program. This is achieved by invoking the XBIZRULES X-Model command for each program in the application.
	[image: ]
	The Business Rules Extraction & Analysis can be changed accordingly by changing the values of the data area XBZRMODE (Business Rule Mode). The possible values are: 
*STD (by default) – Only data base fields are tracked to extract the rules. 
*EXTEND – In addition to database fields, any non-tracked conditions are also extracted. 
*All – All conditions are tracked other than any explicit exclusions. 



[bookmark: _Toc97719795]View Business Rules
X-Analysis can display Business Rules automatically using the generated index.
X-Analysis allows the display of the source member for any program in the application. When the source member is displayed, click the Source Options drop-down menu and select Business Rules to see the business rules logic highlighted within the member. You can immediately see the business logic within the context of the program as a whole.
[image: ]
 Fig. 10.2.1 – Source Code of CUSFMAINT
The following window is invoked:
[image: ]
 Fig. 10.2.2 – Business Rules for CUSFMAINT
The Business Rules view also displays columns for Error Message, Business Rule Annotation, Rule Status, and Rule Status Comment. The user can see the columns in the below screen.
	[image: ]
	The Business Rules and Consolidated Rules will now show the long name for the files and fields when the long names exist and the Windows>Preferences>X-Analysis XX.X.X>Show Long Names for Files option is selected. 
Any rule starting with 50001 is a rule extracted from a Range/Validation defined on an associated device file, but it is shown as a rule on the Program. Also, the RRN for such rules also start with 50001.


[image: ]
 Fig. 10.2.3 – Business Rules window showing the new columns
The Configure Columns feature in the Business Rules view helps the user to manage the columns displayed. You can reduce the width or hide any column, by setting the width to 0.
[image: ]
 Fig. 10.2.4 – Business Rules window – Configure Columns option
Filter the display of business rules using the various buttons. The user can filter these rules based on whether they are Exportable Rules, Update Rules, or Excluded Rules. These three filters have toggle behavior.
[image: ]
 Fig. 10.2.5 – Business Rules window – Filter buttons

	[image: ]
	For details regarding Business Rules Status, refer to Appendix G – Setting Status for Business Rules.


When the business rule attributes (that is file, field, and rule text) are found for the first time, they get classified together as the Original Rule.
Right-clicking on a specific rule will display the Matched Rules option. The option is shown in the sample screen below:
[image: ]
 Fig. 10.2.6 – Business Rules window showing the right-click option – Matched Rules
Click this option to see the Exact Rule Match and Similar Rule Match. Refer to the screen below which display two sample type matches.
[image: ]
 Fig. 10.2.7 – Matched Rules window showing the Exact and Similar Match type
Exact Rule Match – When the business rule’s attributes (that is, file, field, and the rule text) match the BR attributes of another rule in an existing program and the rule’s BR condition is also the same, then that rule is called Exact Matching Rule. 
Similar Rule Match – When the business rule’s attributes (that is, file, field, and the rule text) match the BR attributes of another rule in an existing program but the rule’s BR condition does not match, then that rule is classified as Similar Matching Rule.
	[image: ]
	During the business rules’ generation process, if any field interacts with a data area or database file, then business rules are generated as described below:


· Relation of Data Area and Business Rules: When field dependency is tracked on a data area, the business rule gets generated for that field, and the business rule file and field get updated with the data area name.
· Relation of Database file and Business Rules: When a field is tracked on a database file, then that specific field from the database file gets selected as the business rule field and the database file as the business rule file.
[bookmark: _Toc97719796]Inter-Repository Options
The Inter-Repository Options provides different sub-options for comparing database files (across any two cross-reference libraries) and managing linked repositories. 
 The Difference Analysis option analyzes the application database files and reports the difference with the files. 
The PTF Analysis option analyzes the base and the customized applications for PTF analysis. 
The Manage Linked Repositories option allows analysis of one or more IBM i and/or non-IBM i (Windows) cross-reference library to an existing cross-reference library. 
The Inter-Repository Options is available on the context menu of the cross-reference library. 
[image: ]
 Fig. 11.1.1 – Inter-Repository Options
The following group of options is available under it:
· Generate Difference Analysis
· Display Difference Analysis
· Customized Libraries
· Generate PTF Analysis
· PTF Analysis
· Manage Linked Repositories
	[image: ]
	Fresche Solutions supplies the following two additional data libraries for demonstrating Difference Analysis and PTF Analysis: 
XAN4CDEMCU – This library contains objects from XAN4CDEM with simulated changes. 
XAN4CDEMPT – This library contains simulated PTF for XAN4CDEM. 



[bookmark: _Toc97719797]Audit Options
These options simplify the auditing processes for you by providing effective means to measure, monitor, and manage changes and complexity to applications. Audit Options are available on the context menu over the cross-reference library and application areas.
[image: ]
 Fig. 11.2.1 – Audit Options

	[image: ]
	The Audit Options functionality is implicitly dependent on X-Rules for certain problem analysis categories and screen metrics. You must own the X-Rules license to generate Business Rules (for the X-Ref library) before using them. 
The X-Audit features dependent on X-Rules license are "Program Code Alerts" under Problem Analysis and Screen Metrics information. 


[bookmark: _Toc97719798]UML Diagramming
X-Analysis provides various options for UML diagramming on RPG/RPT/SQLRPG types of programs. The following options are available in X-Analysis for UML diagramming:
· Activity Diagram
· Class Diagram
The UML Diagramming options are available on the context menu under the UML Options submenu on the Object/Member List.
[image: ]
Fig. 12.1.1 – UML Options

	[image: ]
	The UML functionality will be available inside of any version of Eclipse from version 4.4 and up and for the first time inside of RDi.


[bookmark: _Toc97719799]The Pre-Requisites
Use the Business Rules functionality to re-engineer the programs. The Activity Diagrams will then be generated on the re-engineered program(s).
[bookmark: _Toc97719800]Activity Diagram
The Activity Diagram illustrates the dynamic nature of a system by modeling the flow of control from activity to activity. An activity represents an operation on some class in the system that results in a change in the state of the system. Typically, Activity Diagrams are used for model workflow or business processes and internal operation.
Let take an example of Activity Diagram. From the tutorial application XAN4CDXA, select the WWCUSTS program and opt for the context menu on it, then select the Activity Diagram option under the UML Options group. This invokes the Activity Diagram as displayed below:
[image: ]
 Fig. 12.2.1 – Activity Diagram for WWCUSTS

[bookmark: _Toc97719801]Class Diagram
The Class Diagram is the backbone of all Object-oriented methods, including UML. It describes the static structure of a system. Classes represent an abstraction of entities with common characteristics. Associations represent the relationships between classes.
Let take an example of a Class Diagram. From the tutorial application XAN4CDXA, select WWCUSTS and opt for the context menu on it, then select the Class Diagram option under the UML Options group. This action displays the Class Diagram as shown below:
[image: ]
 Fig. 12.3.1 – Class Diagram
The Class Diagram displays the following:
1. Shows all the PF used by the program, and their relationships.
2. Joining fields are shown on the edge of the connection.
3. All the keys fields and field usage are shown inside the file figure as attribute with their types.
[bookmark: _Toc97719802]Data Management Features
X-Analysis automatically derives the system data model by analyzing both the actual data contents and all programs that use this data to verify the existence of any cross-file relationships. These potential relationships are verified by performing an integrity check to ensure that all data from the dependent file does indeed validly reference data records from the owning file. In this way, even the most complex legacy system can be data modeled with relatively no effort.

[bookmark: _Toc97719803][bookmark: -1466823836]View Data
The user can also view file records from the data model of an application.
Select the View Data option to view the actual records held in PFs. The option is available on all the objects displayed in the DMD.
[image: ]Fig. 13.1.1 – View Data option on the DMD object
[image: ] Fig. 13.1.2 – Data View for CUSF
[bookmark: _Toc97719804]Record Display
The View Data window lists records for a selected file. Double-click on a record to display the complete record.
If the user double-clicks Bertwhistle & Company Ltd., the record gets displayed along with its dependent files data.
[image: ]
 Fig. 13.1.3 – Record Display with Dependents
The tab at the bottom displays the dependent file data which includes any ACCESSES/OWNS/ REFERS TO relationships for CUSF in the DMD.
On the record display, the Descriptors button displays the ACCESSED BY/REFERS TO relationships. This is like a JOIN to a foreign file, to get the description for the code used from the Master/Owning file.
[image: ]
 Fig. 13.1.4 – Descriptors button on Record Display
Click the Descriptors button to invoke the following window:
[image: ]
Fig. 13.1.5 – Window presenting Descriptors from Master/Owning file

[bookmark: _Toc97719805]Data Dictionary
X-Analysis makes a complicated task of data modeling an easy one. When the data inherent in a specific application is accessible, data modeling can be a straightforward procedure. X-Analysis has the Data Dictionary option for this purpose.
The Data Dictionary contains detailed information for every field in each file in the application database. Much of this data is the standard metadata extracted for each file and stored on the XDD file – for instance, field and column names, field size, and field type.
Thus, record metadata is readily available for use by other applications.
Click on the Data Dictionary icon available on the X-Analysis toolbar. This will show up the Data Dictionary submenu options. These options are:
[image: ]
 Fig. 13.2.1 – Data Dictionary menu options
[bookmark: _Toc97719806]Entities
The first submenu option is Entities. Select this option to display the Primary Identifiers view. This is also the default view when the user invokes the Data Dictionary from X-Analysis.
The identification of the correct primary identifier is crucial to the building of an accurate data model. This identifier is determined by an examination of all the access paths for the file and is verified against the data in the file. All the primary identifiers are written to the XPIDS file.
[image: ]
 Fig. 13.2.2 – Data View for XPIDS
[bookmark: _Toc97719807]Access Paths
The second submenu option is Access Paths. This file records, all of the access paths available to each Physical File. There is one XKEYMAP record for each access path. The user can select the Access Paths option by clicking on the Data Dictionary icon.
[image: ]
 Fig. 13.2.3 – Data Dictionary – Access Paths
Up to 10 key fields can be associated with each field.
[bookmark: _Toc97719808]Fields
The third submenu option is Fields. Select this option to view information for every field in each file in the application database. All the field information extracted during the Data Modelling process is contained in the Data Dictionary file. Each field from each Physical File in XPIDS is listed. The metadata extracted can be interpreted and utilized by applications to read, write, and format the fields correctly.
The TYPE column values can be of following types:
H: High Level Key or High Oder Key (First field of a multiple key LF)
K: Key (Only field of an LF)
D: Descriptor (Field which contains description/text)
W: Computed (Field which has some calculation/formula using other Fields of that file)
T: Total able (Field which is numeric and can be totaled)
	[image: ]
	W and T types are deprecated and not being set.


On selecting the Fields option, the file fields’ details are displayed as shown in the screen below:
[image: ]
 Fig. 13.2.4 – Data Dictionary – File Fields
[bookmark: _Toc97719809]Relationships
The fourth submenu option is Relationships. Select this option to view relationships among all the PFs that form the Data Model, as the files contained in an application could be inter-related. For executing the data modeling procedure, it is imperative to have information about all these relationships.
[image: ]
 Fig. 13.2.5 – Data Dictionary – Relationships
There are three types of relationships that can be identified:
· Owns – PID to PID relationship
· Accesses – Access Path to Access Path relationship
· Refers to – Foreign key to PID relationship
When a user right-click on an object, besides the Variable Where Used functionality, the user gets two more options on the context menu – Joint Where Used and Where Extracted. These options are shown in the screen below:
[image: ]
 Fig. 13.2.6 – Context menu showing Joint Where Used and Where Extracted options
The details for these features are as follows:
· Joint Where Used: Displays the list of programs with the Join Usage of the Owning file and Dependent file.
· Where Extracted: Displays the origin program and relationship details. The Origin program is the program of X-Analysis product where the relationship was extracted in the Data Model build process. The information of "Where Extracted" is further used in the data modeling process.
[bookmark: _Toc97719810]Relationship Details
The last submenu option is Relationship Details. Select this option to view the detailed composition of every File-to-File relationship. This file is the counterpart to XRELS, and every File-to-File relationship is recorded in XRELS. XSHKEYS describes each of the Field-to-Field relationships that make up these XRELS relationships.
[image: ]
 Fig. 13.2.7 – Data Dictionary – Relationship Details

[bookmark: _Toc97719811]Data Dictionary Overrides
The elaborate Data Modelling process demands the presence of several details. Select the Data Dictionary Overrides menu to access detailed information for every field in each file in the application database. Much of this data is the standard metadata extracted for each file and stored on the XDD file – for instance, field and column names, field size, and field type. Thus, record metadata is readily available for use by other applications. The drop-down icon for this option is present alongside the Data Dictionary icon on the X-Analysis toolbar.
The Data Dictionary Overrides submenu options are:
[image: ]
 Fig. 13.3.1 – Data Dictionary Overrides – Submenu options
[bookmark: _Toc97719812]Override PIDS
The first submenu option is Override PIDs. Click this option to display the XOVRPIDS file which contains all the override entries for the XPIDS file.
	Field
	Field Name
	Size
	Description

	Physical File Name 
	OVRPF
	10A
	 

	PID File Name
	OVRPID
	10A
	Access Path for file to be used as the PID.

	Relationship Priority
	OVRPTY
	1A
	Only 1, 2 & 3 signify; 1 is the highest – this value is used when determining which “owner” file is to supply the descriptor for screen layouts.

	Reference Only 
	OVRRFO
	1A
	If this relationship is reference only, enter “y”.



The screenshot below displays the Override PIDs fields.
[image: ]
 Fig. 13.3.2 – Data Dictionary Overrides– Override PIDS
[bookmark: _Toc97719813]Override Relationships
Override Relationships is the next option on the Override Data Dictionary menu. Select this option to display the XOVRRELS file, which holds the override entries for XRELS. The relationship among override entries is shown in Data model Diagram.

	Field
	Field Name
	Size
	Description

	Owning PF 
	OVROPF
	10A
	 

	Dependent PF
	OVRDPF
	10A
	 

	Dependent LF
	OVRDLF
	1A
	 

	Relationship Type
	OVRRFO
	1A
	Defines the relation type. The user can enter only one choice. 
O – add a ‘owns’ relation 
Y – adds a unidirectional relation
() – Blank – ‘Refer To’ 
D – Not supported 
E – Not supported 



The following screen displays the Override Relationships window.
[image: ]
 Fig. 13.3.3 – Data Dictionary Overrides– Override Relationships
Click Add Record(s) in order to add the override entries for XRELS as shown above.

	Feature
	Description

	Validate 
	This option validates the field entry.

	Add & Return
	 Select this option if you don’t want to add more records.

	Add Successively
	 Select this option to save the newly filled records and add more without leaving the current page.

	Reset 
	This option will reset all the data entered. 



Add the appropriate entries with the desired Relation Type (O/Y/D/E). You may save and then continue with adding more entries by taking option Add Successively.
[image: ]
 Fig. 13.3.4 – Data Dictionary Overrides– Override Relationships
After entering the valid entries, click Add & Return to add the objects fulfilling the criterions for override relationship and you will be presented with a screen as shown below:
[image: ]
 Fig. 13.3.5 – Data Dictionary Overrides– Override Relationships
	[image: ]
	The Relation Type ‘D’ and ‘E’ are not supported yet.


The user needs to regenerate Data Model in order to reflect the above defined relationship. To do this, select Option 13 on the Work with X-Analysis/4 Applications menu. Press ENTER to run the modelling command. This principal command runs in batch and completes the modelling process. See Generating DMD.
Take DMD option from the Context Menu over ASTATUS.
[image: ]
 Fig. 13.3.6 – DMD for ASTATUS
From the above screen, the specified relations can be seen clearly.
[bookmark: _Toc97719814]Override Relationship Details
The next submenu option is Override Relationship Details. Select this option to display XOVRSHKS file which contains the override entries for the XSHKEYS file.

	Field
	Field Name
	Size
	Description

	Owning PF 
	OVSOPF 
	10A
	 

	Dependent PF
	OVSDPF
	10A
	 

	Dependent LF
	OVSDLF
	10A
	 

	Key Seq.
	OVSSEQ
	5P2
	 

	Owing PF Field 
	OVSOFD 
	10A
	 

	Dependent PF Field
	OVSDFD
	10A
	 

	 Constant 
	OVSCON 
	20A
	 



[image: ]
 Fig. 13.3.7 – Data Dictionary Overrides – Override Relationship Details
[bookmark: _Toc97719815]Override Program References
The last option is Override Program References. Select this option to add or remove program references for a specific object. Also note, only *PGM type objects will be added for Called and Calling objects.
[image: ]
 Fig. 13.3.8 – Data Dictionary Overrides – Override Program References
[bookmark: _Toc97719816]Exporting & Printing
Modern software design tools frequently offer the facility to re-engineer a data model or entity relationship diagram from an existing database. This is usually done over an Open Database Connectivity (ODBC) connection and relies on the metadata held within a database to describe the relationships between tables. These tools are often unable to re-engineer an accurate data model from an existing DB2 database because it predates the database features that the tool relies on. You can use the X-Analysis data model to bridge this gap and import your data model into other tools.
X-Analysis provides various export options for exporting diagrams and technical details directly to applications such as PDF/Microsoft Word or Microsoft Visio.
The interface to PDF/Microsoft Word is sophisticated enough to automatically produce detailed and structured documents that have Contents & Index pages, chapters, sections and all of the screens available in X-Analysis, displayed with a simple selection wizard. Existing documentation, object/field annotation can be included in the exported PDF/Microsoft Word documents.
· Export to PDF
· Export to Microsoft Word
· Export to Microsoft Excel
· Export to Image
· Export to Flowchart

[bookmark: _Toc97719817]Export to PDF
Select the Export to PDF option from the Export Options icon available on the toolbar to export the content to the PDF format.
[image: ]
Fig. 14.1.1 – PDF view of current Source Code

[bookmark: _Toc97719818][bookmark: 394125406]Export to Microsoft Word
Select the Export to Microsoft Word option from the Export Options icon available on the toolbar to export the content to the Word format.
[image: ]
 Fig. 14.2.1 – Microsoft Word view of Current Source Code

	[image: ]
	Exporting very large diagram to MS Word or PDF may show the incomplete diagram because the number of pages to be exported have been limited to 100 pages and 120 pages respectively.



[bookmark: _Toc97719819][bookmark: -482453880]Export to Microsoft Excel
X-Analysis displays various lists. All lists have the options to export data to MS Excel and MS Word. The Export Options drop-down icon appears on the associated toolbar.
Select Export to Excel and export current source code in the MS Excel format, as displayed below:
[image: ]
Fig. 14.3.1 – Microsoft Excel view of Current Source Code

[bookmark: _Toc97719820][bookmark: -182668137]Export to Image
X-Analysis displays various diagrams. Diagrams like Data Model Diagram, Data Flow Diagram, Overview Structure Chart, Structure Chart, and Access Path Diagram, etc. have the options to export the diagram to an image. The Export Options drop-down icon appears on the associated toolbar.
The image is saved in PNG format. It can be opened using the default application defined in the Windows for this type of file.
There is a limitation in the size for exported image. The exported image cannot be larger than 70000 points in height. Any diagram having more than above height would get chopped. Please note that 1 point = 1/72 inches.

[bookmark: _Toc97719821]Export to Flowchart
X-Analysis generates Flowcharts for RPG, RPGLE, and COBOL programs. It also generates Process Flow Diagrams for CL programs. The Flowchart option is enabled only in the source browser view. It generates the flowchart of the displayed program using MS Visio.
Each level of source (selected source member) has a different flowchart:
· Level 1-2 will have a Flowchart without any code.
· Level 3-4 will have a Flowchart with code without blank lines, and with no comments.
· Level 5 will have a Flowchart with full code and comments.
The right-click menu option Jump to subroutine on EXSR (Execute Subroutine) boxes opens the flowchart for the selected subroutine. This option is available at all levels.
The RPG/CBL flowchart has special handling feature for the GOTO/CAB opcode. Logically GOTO/CAB opcode force the logic for a jump to another part of the code, with no return. Hence, the flowchart does not show a connection coming out from GOTO/CAB opcode and shows the flow as abruptly terminated.
	[image: ]
	GOTO/CAB as well as the TAG lines are represented by a circle in the flowchart.


[image: ]
 Fig. 14.4.1 – Jump to Subroutine
[image: ]
 Fig. 14.4.2 – Subroutine View of $RVCUS

[bookmark: _Toc97719822]Printing from X-Analysis
X-Analysis allows printing of various List/Diagrams/Source members. The Print icon is available on the toolbar of various list/diagrams/source members.
	[image: ]
	Printer should be already configured.



[bookmark: _Toc97719823]Export as DDL from X-Analysis
[bookmark: 1717903927]The Export as DDL option exports data model information as Data Definition Language (DDL) to the application folder. This information may be used by any database management system.
	[image: ]
	For example, Oracle or SQL Server, to create a similar data model. 


 The Data Definition Language (DDL) is a sequence of Structured Query Language (SQL) commands that define the structure of a database. X-Analysis can export the structure of an application or application areas as DDL. The DDL can be used to recreate a database on any SQL database system. If your modeling tool does not support XML, then you can use the Export as DDL option. This option recreates your database as SQL tables with complete metadata information, required for a tool to re-engineer the new database over ODBC. Some third-party modeling tools allow importing SQL scripts or DDL files directly. To export the DDL for the example Tutorial System (XAN4CDXA) data model: 
To export the DDL for the example Tutorial System (XAN4CDXA) data model:
1. Open, XAN4CDXA from the X-Analysis Client.
2. Opt for the context menu on XAN4CDXA, and then select the Export as DDL option from the Export Options submenu.
[image: ]
 Fig. 14.5.1 – Export as DDL
X-Analysis displays the following confirmation dialog to start the process:
[image: ]
 Fig. 14.5.2 – DDL Export confirmation dialog
After the process is over, X-Analysis displays a successful message.
[image: ]
 Fig. 14.5.3 – DDL Export completion messagee
To view exported DDL statements, select menu X-Analysis > Open Application Folder. The generated DDL file is listed in this folder.
[image: ]
 Fig. 14.5.4 – Application Folder displaying .DDL File
DDL is plain text and human readable so you can view the file in any text, such as Notepad. The snippet of the DDL statement generated is displayed below:
[image: ]
 Fig. 14.5.5 – DDL File in Notepad
	[image: ]
	The Export as DDL option is also available on application areas.


When you right-click on a PF, the context menu shows the Exclude Constraints option.
[image: ]
 Fig. 14.5.6 – Exclude Constraints
Selecting this option presents the potential constraints which get reflected through the Export as DDL functionality. The relations excluded here (by checking the corresponding boxes) would not show up as a Foreign key constraint when DDL is exported.
Exclude Constraints option displaying the Potential Constraints
[image: ]
 Fig. 14.5.7 – Potential Constraints

[bookmark: _Toc97719824]Generate Database Service Programs
[bookmark: -494244496]The Generate Database Service Programs option calls the IBM i command, XWRTDBSP and submits the job in batch. This option is available on cross-reference library, application areas, and physical files (PF).
Opt for the context menu on the tutorial application and select the Generate Database Service Programs option from the Export Options submenu. The following dialog box gets invoked:
[image: ]
 Fig. 14.6.1 – Generate Database Service Programs
Click OK to execute the batch command.
Opt for the context menu on the application area ORDERS, and select the Generate Database Service Programs option from the Export Options submenu. The following dialog box invokes when the user selects this option:
[image: ]
 Fig. 14.6.2 – Generate Database Service Programs application area, ORDERS
The XWRTDBSP command will generate Service programs for the specified database files. The generated source will be placed in QRPGLESRC of the specified cross-reference library. The type of service program generated will depend on the template specified.
The command requires Template Source Member name as input parameters.
The pre-defined templates are located in XAOBJXXXXX/QRPGLESRC. The following are the available pre-defined templates:
· ZUTEMPLATE – file update/delete program template.
· ZSTEMPLATE – this will generate an SQL CRUD service program.
· ZXTEMPLATE – this will generate an SQL extended READ service program.
· ZRTEMPLATE – this will generate an RPGLE CRUD service program.
[bookmark: _Toc97719825]Generated Service Program
The service program naming depends upon the template selected. The following table explains this:
	Template
	Service Program starting with

	ZUTEMPLATE
	ZU

	ZSTEMPLATE
	ZS

	ZXTEMPLATE
	ZX

	ZRTEMPLATE
	ZR



On selecting ZSTEMPLATE, an SQL CRUD service program is generated whereas on selecting ZRTEMPLATE, an RPGLE CRUD service program is generated. In both the cases, a service program is generated containing sub-procedure definitions for READ / UPDATE / WRITE / DELETE record.
On selecting ZXTEMPLATE, an SQL-extended READ service program is generated. The generated service program contains sub-procedure definitions for Extended READ.
[bookmark: _Toc97719826]Using Generated Service Program
The following is a snapshot of the generated service program:
 	H*¹-------------------------------------------------------------
 	H debug(*yes) copyright('Databorough Ltd. 2008')
 	H nomain
 
 	D****************************************************************
 	D*¹D e f i n i t i o n s
 	D****************************************************************
 	D zrecord       e ds                  extname(condet)
 	D zrecordsql    e ds                  extname(condet)
 	D                                     prefix(sql)
 	D zrecordcpy    e ds                  extname(condet)
 	D                                     prefix(cpy)
 
 	D*¹Data structure containing all required parameters
 	D*¹ Plus: before and after database record image.
 	D*¹ Keys passed in ZOLDRECORD, data returned in ZNEWRECORD
 	D zsdata          ds
 	D znewrecord                          like(zrecord)
 	D zoldrecord                          like(zrecordcpy)
 	D/copy qrpglesrc,zsheader
 
 	D*¹Prototypes
 
 	D*¹Read
 	D zcondetr        pr                  likeds(zsdata)
 	D zreadparms                          likeds(zsdata)
 
 	D*¹Update
 	D zcondetu        pr                  likeds(zsdata)
 	D zupdateparms                        likeds(zsdata)
 
 	D*¹Write
 	D zcondetw        pr                  likeds(zsdata)
 	D zwriteparms                         likeds(zsdata)
 
 	D*¹Delete
 	D zcondetd        pr                  likeds(zsdata)
 	D zdeleteparms                        likeds(zsdata)
 		
Fig. 14.6.3 – Database Service Program


	[image: ]
	Various sub-procedures defined (for Read, Update, Write, and Delete) in the service program are displayed above.


The user should call the appropriate sub-procedure to READ / UPDATE / WRITE / DELETE the record. There is one parameter – a data structure that includes a ‘before’ and ‘after’ image of the database record, plus the fields in the copybook member ZSHEADER. Keys are passed in the ‘before’ image (ZOLDRECORD) and, data is returned in the ‘after’ image (ZNEWRECORD).
Currently, only one field is used from ZSHEADER – ACTION.
       D*¹-----------------------------------------------------------
 	D*ÌAuthor:  DATABOROUGH LTD 2008
 	D*¹------------------------------------------------------------
 	D*¹SERVICE PROGRAM PARAMETERS
 	D*¹------------------------------------------------------------
 	D inuser                        10
 	D indate                         8
 	D intime                         6
 	D action                        10
 	D entrypoint                    20
 	D rtnmsgtp                       1
 	D rtnmsg                        80    dim(20)
 	D rtnmsgids                      7    dim(20)
 	D rtnflds                       30    dim(20)
 	D rtnupdbuf                      1
 	D rtnnewfun                     23
 	D gtots                         30p 9
 	D zworkflds                     50a   dim(20)
 	D zwfnames                      30a   dim(20)
 	D zwftypes                       1a   dim(20)
 	D supflds                       30    dim(20)
 	D conflds                       30    dim(20)
 	D clrflds                       30    dim(20)
 	D ovrclrs                        3    dim(20)
 	D selact                        20
 	D supacts                       23    dim(50)
 	D calltype                       1
 	D*¹--------------------------------------------------------------
 		
Fig. 14.6.4 – Copy-book member ZSHEADER

[bookmark: _Toc97719827]Export Crud Spreadsheet
The Export CRUD Spreadsheet option exports metrics to an Excel Sheet where the rows represent the program name and columns depict the file name. In the spreadsheet, each cell represents the way a program is using a file, that is, Create, Read, Update, or Delete. This option is available in the cross-reference library, Application Areas.
To export the example Tutorial System (XAN4CDXA):
1. Open XAN4CDXA from the X-Analysis Client.
2. Opt for the context menu on XAN4CDXA, and then select the Export CRUD Spreadsheet option from the Export Options submenu.
[image: ]
 Fig. 14.7.1 – Export CRUD Spreadsheet option
The exported data will be shown in a spreadsheet as shown below:
[image: ]
 Fig. 14.7.2 – CRUD sheet for a cross reference
[bookmark: _Toc97719828]Document Manager
The Documenter (Document Manager) facilitates the generation of a PDF/MS Word document containing the system design information for the specified objects in an application.
The System Documentation is generated in the following two ways:
· Marking the individual objects/complete list
· Documenting an application area

[bookmark: _Toc97719829]Marking the Individual Objects/Complete List
Follow the steps below to generate the system document:
1. Start X-Analysis.
2. Select a cross-reference from the cross-reference list view.
3. Mark objects to be included in the System Documentation process. To mark the objects for the documentation process, use the context menu on objects and select the Mark for Documenter option. Alternatively, the entire list can be selected for documentation by selecting the Mark all for Documenter option, available under the X-Analysis menu.
4. Select the Documenter button from the main toolbar.
[image: ]
Fig. 15.1.1 – Document Manager
The Objects/Members on the documenter list can be arranged using the Move Up / Move Down / Delete / Delete All buttons on the Document Manager.
The Document Manager provides a facility for object selection for system document – Invert Selection. On clicking Invert Selection, the selected object gets un-selected, and all other un-selected objects get selected.
After ordering of the objects, click Generate Document. This invokes the Documenter Wizard, as shown below:
[image: ]
Fig. 15.1.2 – System Documenter Wizard

	[image: ]
	Documenter option can also be alternatively accessed from the Export Options drop-down on the Source Browser toolbar of a selected object.


[bookmark: _Toc97719830]Document Wizard Sections
System Documentation Type
Various options are available for the System Documentation type. By default, the Generate Single System Document option is checked.
Document Format
MS Word – Select this if the user wants to generate the report in MS Word.
PDF – Select this if the user wants to generate the report in PDF.
Document Settings
Select Last Used Setting – This field displays the last used setting and appears as disabled when the system documentation is generated for first time.
Save Setting as – This field is editable. A user can edit and save the setting with the required name and this name can be used when the system document is generated subsequently.
Document Details
Document Title – The user can change document title as per the requirement.
Path – Click the Browse button to change the default path. The default path is <C:\Documents and Settings\username\My Documents\X-Analysis Application Data\192.168.21.102\PCF_XAN4CDXA>
Press Next to proceed further. For Single System Documentation, the following dialog box is displayed:
[image: ]
Fig. 15.1.3 – Generate Single System Document – Options
You can select different options from the above dialog box as per the requirements. If you select the Business Rules for documentation, then you have the option to get the business rules documented in MS Excel. This can be done by checking the Export to MS Excel option. If you select the Business Rules for documentation with the Summary option, then the basic rule information will be documented; if you select the Detailed option, then the logic behind the rule will also be documented.
	[image: ]
	From 13.0 onwards, Screen Flow Diagram option and Business Process Logic option has been greyed out in the Document Manager dialog till the user does not have the Modernization Authority to create it.


[image: ]
Fig. 15.1.4 – Single System Document – Features
Screen/Report Layout:
The two options available here are:
· Normal: This prints the Screens and the Fields list of the individual formats for all the screen formats.
· Detailed: This prints the Header information, the Data Content Diagram, and the Screen Action Diagram for each screen, in addition to the Screens and the Fields List, for all the screen formats. This is for internal use only and requires the X-RPG Migrate authority.
Select the options to be included in the document and click Next to proceed further.
[image: ]
Fig. 15.1.5 – Single System Document – Specify Sequencing
From the above screen, you can re-sequence the options selected for the System Documentation. After re-sequencing, click Next to reach the final step of documentation wizard. Here, you will see all the selections that you have made and can also define various options related to document formatting, like 'Paper Size', 'Contention Resolution', etc.
[image: ]
Fig. 15.1.6 – Single System Document – Finish
Click Finish to generate the document. The progress status is displayed on the screen while generating the System document. The document will be located in the specified save location.
[bookmark: _Toc97719831]Generate Individual System Documents
Select the Generate Individual System Documents option from the following dialog:
[image: ]
Fig. 15.1.7 – Individual System Documents – Type and Location
After selecting the Generate Individual System Documents option, click Browse. Select the required location to save the document.
[image: ]
Fig. 15.1.8 – Document Folder
For the Generate Individual System Documents option, the following dialog box is displayed after you click Next on the System Document Wizard:
[image: ]
Fig. 15.1.9 – Individual System Documents – Features
The Object List option is disabled in this dialog box. Choose the options which you want to document from the above dialog box.
If you select the Business Rules for documentation, then you have the option to get the business rules documented in MS Excel. This can be done by checking the Export to MS Excel option. If you select the Business Rules for documentation with the Summary option, then the basic rule information will be documented; if you select the Detailed option, then the logic behind the rule will also be documented.
Screen/Report Layout:
The two options available here are:
· Normal: This prints the Screens and the Fields list of the individual formats for all the screen formats.
· Detailed: This prints the Header information, the Data Content Diagram, and the Screen Action Diagram for each screen, in addition to the Screens and the Fields List, for all the screen formats. This is for internal use only and requires the X-RPG Migrate authority.
Click Next which displays the following screen:
[image: ]
Fig. 15.1.10 – Individual System Documents – Specify Sequencing
From the above screen, you can re-sequence the options selected for System Documentation. After re-sequencing, click Next to reach the final step of documentation wizard. Here, you will see all the selections that you have made and can also define various options related to document formatting, like 'Paper Size', 'Contention Resolution', etc.
[image: ]
Fig. 15.1.11 – Individual System Documents – Finish
Click Finish to generate the document. The progress status is displayed on screen while generating the system document. The generated document will be available in the specified saved location.
[bookmark: _Toc97719832][bookmark: 2019305361]System Documents using previous values
X-Analysis provides a unique feature of recalling previous options opted by you in the System Documentation process. With the help of this feature, you can generate a System Document without selecting the same options again for the System Documentation process.
If you want to generate the System Document using the previous options selected for the System Documentation, select the Generate System Documents using previous values option.
This option gets disabled if you switch to generate the System Document for Application Area from System Documentation for Object(s) or vice-versa. Start the Documenter (either by marking individual Objects for Documentation or selecting the Documenter option on Application Area). Select the Generate System Documents using previous values option from the documentation wizard as shown below:
[image: ]
Fig. 15.1.12 – Generate System Documents using previous values – Type and Location
After selecting the Generate System Documents using previous values option, click Browse to invoke the Save As dialog. Select the required location to save the document and enter a new file name, if required.
[image: ]
Fig. 15.1.13 – Document Folder
Then, click Finish to initiate the System Documentation Process.

[bookmark: _Toc97719833]Documenting an Application Area
The Document Application Area option documents all information about objects belonging to the selected application area. This option is available on the context menu of an application area and invokes the System Documentation Wizard.
On selecting the Document Application Area option, the following System Documentation Wizard appears:
[image: ]
 Fig. 15.2.1 – Type and Location
You can choose from the following options:
1. Generate a single document with documentation for all objects marked for documentation in the Application Area.
2. Generate individual documents for all object marked for documentation in the Application Area.
3. Generate System Document using previous values for the Application Area.
[bookmark: _Toc97719834]Document Application Area – Single System Document
Select the Generate Single System Document option, as displayed below:
[image: ]
 Fig. 15.2.2 – Single System Document – Type and Location
To change the default document name and path, click Browse to specify new document name and path. The default location is <Application Folder>.
After this step, click Next to proceed further as shown below:
[image: ]
 Fig. 15.2.3 – Single System Document – Application Area Features
The Overview Structure Chart and the Data Model Diagram options mentioned in this dialog are only for the selected application area.
The wizard dialog displayed above has a section called 'Coverage of System Document'. This section has three options; depending upon these three options, the System Document differs in its approach. Let us see how these three options work.
Detailed Object Documentation in Alphabetical Order
If the Detailed Object Documentation in Alphabetical Order option is selected, then the object documentation proceeds in ascending alphabetical order of the name of objects in the application area. The following dialog is displayed in the wizard:
[image: ]
 Fig. 15.2.4 – Single System Document – Exclude Objects
The dialog provides removal of objects from the system documentation process, based on the name/type of objects. The selected name/type can be removed using the Delete buttons.
[image: ]
 Fig. 15.2.5 – Single System Document – Document Features
Choose the options which you want to document from the above dialog box.
Click Next which will display the following screen:
[image: ]
 Fig. 15.2.6 – Single System Document – Specify Sequence
From the above screen, the user can re-sequence the options selected for System Documentation. After re-sequencing, click Next to reach the final step of the documentation wizard. Here, the user can see all selections that he has made and can also define various options related to document formatting like 'Paper Size', 'Contention Resolution', etc.
[image: ]
 Fig. 15.2.7 – Select Paper Size and Resolution
Click Finish to generate the document.
Detailed Object Documentation in Call Sequence Order
If the Detailed Object Documentation in Call Sequence Order option is selected, then the object documentation is based on the Overview Structure Chart for the selected application area. For this option, the Overview Structure Chart is always generated.
[image: ]
 Fig. 15.2.8 – Detailed Object Documentation in a Call Sequence Order
Click Next to proceed further.
[image: ]
 Fig. 15.2.9 – Detailed Object Documentation – Document Features
Choose the options which you want to document from the above dialog box.
Click Next to proceed.
[image: ]
 Fig. 15.2.10 – Detailed Object Documentation – Specify Sequence
From the above screen, the user can re-sequence the options selected for System Documentation. After re-sequencing, click Next to reach the final step of the documentation wizard. Here, the user can see all selections that he has made and can also define various options related to document formatting like 'Paper Size', 'Contention Resolution', etc.
[image: ]
 Fig. 15.2.11 – Select Paper Size and Resolution
Click Finish to generate the document.
No Detailed Object Documentation
If the No Detailed Object Documentation option is selected, then only the Overview Structure Chart and/or the Data Model Diagram as specified in the Application Area Options dialog is created.
[image: ]
 Fig. 15.2.12 – No Detailed Object Documentation
Click Next to proceed.
[image: ]
 Fig. 15.2.13 – Sequencing of the Application Area Features
From the above screen, the user can re-sequence the options selected for System Documentation. After re-sequencing, click Next to reach the final step of the documentation wizard. Here, the user can see all selections that he has made and can also define various options related to document formatting like 'Paper Size', 'Contention Resolution', etc.
[image: ]
 Fig. 15.2.14 – Select Paper Size and Resolution
Click Finish to generate the document.
[bookmark: _Toc97719835]Document Application Area – Individual System Documents
Select the Generate Individual System Documents option, as displayed below:
[image: ]
 Fig. 15.2.15 – Document Application Area – Individual System Documents
Click Browse to select the desired location to save the document and enter a new filename, if required.
[image: ]
 Fig. 15.2.16 – Document Folder
After selecting the desired location for documentation and providing the file name, the System Documentation wizard processes further, as shown below:
[image: ]
 Fig. 15.2.17 – Select Application Area Features
The Overview Structure Chart and the Data Model Diagram options mentioned in the above dialog box are only for the selected application area.
The wizard dialog box displayed above has a section called 'Coverage of System Document'. This section has two options, depending on which the System Document differs in its approach. Let us see how the two options work.
Detailed Object Documentation in Alphabetical Order
If the Detailed Object Documentation in Alphabetical Order is selected, then the object documentation generates in ascending alphabetical order of Object name from the application area. The following dialog is displayed in the wizard:
[image: ]
 Fig. 15.2.18 – Exclude Object List
The dialog box provides removal of objects from system documentation, based on name/type of objects. The selected name/type can be removed using the Delete buttons. Click Next to proceed further.
[image: ]
 Fig. 15.2.19 – Features to Document
Choose the options which you want to document from the above dialog box.
Click Next which will present the following screen:
[image: ]
 Fig. 15.2.20 – Sequencing of the Features
From the above screen, the user can re-sequence the options selected for System Documentation.
After re-sequencing, click Next to reach the final step of the documentation wizard. Here, the user can see all selections that he has made and can also define various options related to document formatting like 'Paper Size', 'Contention Resolution', etc.
[image: ]
 Fig. 15.2.21 – Select Paper Size and Resolution
Click Finish to generate the document.
No Detailed Object Documentation
If the No Detailed Object Documentation option is selected, then only the Overview Structure Chart and/or the Data Model Diagram as specified in the Application Area Options dialog box is created.
[image: ]
 Fig. 15.2.22 – No Detailed Object Documentation – Features
Click Next to proceed further.
[image: ]
 Fig. 15.2.23 – No Detailed Object Documentation – Specify Sequence
From the above screen, the user can re-sequence the options selected for System Documentation. After re-sequencing, click Next to reach the final step of the documentation wizard. Here, the user can see all the selections that he has made and can also define various options related to document formatting like 'Paper Size', 'Contention Resolution', etc.
[image: ]
 Fig. 15.2.24 – No Detailed Object Documentation – Finish
Click Finish to generate the document.
[bookmark: _Toc97719836][bookmark: 2008629648]System Document using previous values
We have already discussed this topic under the Marking the individual objects/complete list section.
[bookmark: _Toc97719837]Document an Entire Application
The Document Entire Application option documents all information about objects belonging to the selected application. This option is available on the context menu of an application and invokes the System Documentation Wizard. The procedure for documenting an entire application is the same as the procedure for documenting an application area.

[bookmark: _Toc97719838]Document Changed Objects
The Document Changed Objects option documents those objects which have changed since the last initialization was run on the cross-reference library. This option is available on the context menu on a cross-reference library. 
The Document Changed Objects provides a filter criterion for the System Documentation process. You can select the object's library, name, type, and attribute, as per the requirement. 
[image: ]
 Fig. 15.3.1 – Filter Documentation List
 

[bookmark: _Toc97719839]Viewing the Generated Documents
The default Application Folder for a specific application can be opened by selecting the Open Application Folder option from the X-Analysis menu.
[image: ]
Fig. 15.4.1 – Open Application Folder
Locate the document in the specified save location and double-click on it to open the document.
[image: ]
Fig. 15.4.2 – Document Folder
[image: ]
Fig. 15.4.3 – Preview of the generated System Document – TOC
[image: ]
Fig. 15.4.4 – Preview of the generated System Document – Legend
If the Flowchart option is selected, then the flowchart will be generated using Microsoft Visio, and its link is placed in the System Document.
[image: ]
Fig. 15.4.5 – Flowchart generated using Microsoft Visio

[bookmark: _Toc97719840]Limitation of X-Analysis System Documenter
[bookmark: _Toc97719841]Editing another Word Document
X-Analysis uses OLE Automation to send data to Microsoft Word. This depends on Automation objects provided by Microsoft Word. Automation objects by Microsoft Word have the limitation that when Automation is used on a Word document, then, editing of another Word document may get affected or may interfere with the automation process of the system document.
The following problems may be noticed in the document being edited:
· The cursor will frequently change to hourglass.
· Text once selected may not be unselected.
· After clicking a menu, it may disappear by itself.
· Opening a dialog may end/block the documentation process abruptly.

[bookmark: _Toc97719842]Using the Annotator
[bookmark: _Toc97719843]Annotate option
The Annotate option is available on the context menu of an object or field name. Selecting the Annotate option invokes a dialog box. Provide the required text and click Save. The annotation is stored in a table available in the cross-reference library.
[image: ]
 Fig. 15.5.1 – Annotation dialog for a program object
[bookmark: _Toc97719844]Object type-based Annotation
The annotations based on the Object type are saved in a table available in the cross-reference library.
Select the All Objects option from the navigation pane and opt for the context menu. Then, select the Annotation Template option. This invokes a dialog box as shown below:
[image: ]
 Fig. 15.5.2 – Annotation Template
From the Object Type drop-down, select the required object type. After that, provide appropriate headings for the object type and click Save. The user can now see the prescribed heading if the user annotates the specified object.
[bookmark: _Toc97719845]Appendix A – X-Analysis Offline
X-A Open (module for Open Systems Analysis) uses X-Analysis Client. This is referred to as X-Analysis offline mode. It is based on the IBM DB2 database. X-Analysis offline is used for the analysis of PC-based applications – Java, VB, and VB.Net, by using X-A Open of Fresche Solutions. For more details, refer to the section “XA-Open_User_Manual” for this release.
[bookmark: _Toc97719846][bookmark: -1881707122]Appendix B – Enabling the SEU Interface
[bookmark: _Toc97719847]Create User Profile XAN4SEU
When browsing source code using the IBM i SEU, it is necessary to be logged in as user, XAN4SEU. The following gives instructions for creating the correct user profile.
Step 1 Logon as QSECOFR.
Step 2 Create XAN4SEU user profile.
Use the CRTUSRPRF command to create the XAN4SEU user profile. Make sure that the following parameters are set:
User Password : XAN4SEU
User Class : *PGMR
Initial Program: XSEUCLP
Library : XAPROD
                         Create User Profile (CRTUSRPRF) 
                                                                                
  Type choices, press Enter.
 
  User profile . . . . . . . . . . > XAN4SEU     Name
  User password  . . . . . . . . .   *USRPRF     Name, *USRPRF, *NONE
  Set password to expired  . . . .   *NO         *NO, *YES
  Status . . . . . . . . . . . . .   *ENABLED    *ENABLED, *DISABLED
  User class . . . . . . . . . . . > *PGMR       *USER, *SYSOPR, *PGMR...
  Assistance level . . . . . . . .   *SYSVAL     *SYSVAL, *BASIC, *INTERMED..
  Current library  . . . . . . . .   *CRTDFT      Name, *CRTDFT
  Initial program to call  . . . . > XSEUCLP      Name, *NONE
  Library  . . . . . . . . . . . >   XAPROD       Name, *LIBL, *CURLIB
  Initial menu . . . . . . . . . .   MAIN         Name, *SIGNOFF
  Library  . . . . . . . . . . .     *LIBL        Name, *LIBL, *CURLIB
  Limit capabilities . . . . . . .   *NO          *NO, *PARTIAL, *YES
  Text 'description' . . . . . . . > 'X-Analysis – SEU User'
 
 		                                                    More... 
  F3=Exit   F4=Prompt   F5=Refresh   F12=Cancel   F13=How to use this display
  F24=More keys                                                    
Fig. 16.1.1 – Create User Profile (CRTUSRPRF)
Press F10 and Page Down
Set Special Authorities:
· *ALLOBJ
· *JOBCTL
· *SAVSYS
                           Change User Profile (CHGUSRPRF)                        
 
  Type choices, press Enter.
 
 			          Additional Parameters                               
 
  Special authority  . . . . . . .   *ALLOBJ      *SAME, *USRCLS, *NONE...      
 			             *JOBCTL
 			             *SAVSYS
  Special environment  . . . . . .   *SYSVAL      *SAME, *SYSVAL, *NONE,*S36
  Display sign-on information  . .   *SYSVAL      *SAME, *NO, *YES, *SYSVAL
  Password expiration interval . .   *SYSVAL      1-366, *SAME, *SYSVAL,*NOMAX
  Limit device sessions  . . . . .   *SYSVAL      *SAME, *NO, *YES, *SYSVAL
  Keyboard buffering . . . . . . .   *SYSVAL      *SAME, *SYSVAL, *NO...
  Maximum allowed storage  . . . .   *NOMAX	   Kilobytes, *NOMAX
  Highest schedule priority  . . .   3             0-9
  Job description  . . . . . . . .   QDFTJOBD      Name
  Library  . . . . . . . . . . .     QGPL          Name, *LIBL, *CURLIB
  Group profile  . . . . . . . . .   *NONE         Name, *NONE
 
 		                                                  More...
  F3=Exit   F4=Prompt   F5=Refresh   F12=Cancel   F13=How to use this display
  F24=More keys
Fig. 16.1.2 – Change User Profile (CHGUSRPRF)
Step 3 Logoff.
	[image: ]
	If there is an instance where a source member is already open for editing, then that specific source member cannot be opened using SEU.



[bookmark: _Toc97719848]Creating Macro for XAN4SEU
Macros allows the user to automatically sign on for XAN4SEU., Same time it also allows the user to work with the SEU option. So, it is necessary to verify whether the XAN4SEU macro has been created or not. If not, then the user must record this macro using the following steps:
Step 1: Press the Start Recording button. The Record Macro/Script as dialog box will be displayed. Sign on with the XAN4SEU user profile.
[image: ]
 Fig. 16.2.1 – Record Macro/Script
Step 2: On the Sign On screen, enter the User Profile – XAN4SEU. Press Tab and enter the Password also as XAN4SEU.
[image: ]
Fig. 16.2.2 – Sign On
Press ENTER. The IBM i main menu screen will be displayed:
[image: ]
Fig. 16.2.3 – IBM i Main Menu
Step 3: Stop the recording by selecting the Stop Recording Macro option from the Actions submenu or clicking the related button directly from the toolbar.
[image: ]
Fig. 16.2.4 – Stop Recording Macro
[bookmark: _Toc97719849][bookmark: 587042752]Appendix C – X2E Specific Features
[bookmark: _Toc97719850]Action Diagram
The X-Analysis Initialization process uses the 2E Model to generate Action Diagrams in the cross-reference library. On the X-Analysis Perspective, double-click the Programs node under the selected cross-reference to bring up the list of all programs.
Double-click on a program to zoom source into its corresponding Action Diagram (see below).
[image: ]
 Fig. 17.1.1 – Action Diagram for a program
The ‘Call’ statement has a ‘x’ before it indicates that the program being called has parameter(s).
	[image: ]
	In case the Action Diagram is not available (for external or internal function), then zooming will display the Entry Parameters and Data Section. If these details are not present, then zooming will display the S2E source.



[bookmark: _Toc97719851]Business Rules
Select the Business Rules option from the Source Options drop-down menu on the Action Diagram toolbar.
[image: ]
 Fig. 17.2.1 – Business Rules option on the Action Diagram toolbar
On selecting the Business Rules option, the following screen is displayed:
[image: ]
 Fig. 17.2.2 – Business Rules for the selected program
This also opens an additional Business Rules summary window listing all the business rules for the program.

[bookmark: _Toc97719852]Internal Routine Objects
The X-Analysis Initialize process uses the Model information to identify internal routines. This information is maintained in the X2E repository in the XS2EANXRF file.
Opt for *INTRTN on the Work with Objects dialog. This displays the following screen:
[image: ]
 Fig. 17.3.1 – Object List displaying INTRTN objects

[bookmark: _Toc97719853]Program Structure Chart
If you select the Structure Chart Diagram and the Program Structure Chart options on the same Synon program, you will notice that both diagrams are the same. However, the Program Structure Chart (PSC) also displays the Internal Routines. The following two sample screens point out this difference.
[image: ]
Fig. 17.4.1 – Structure Chart Diagram for TSAGEFR
[image: ]
Fig. 17.4.2 – Program Structure Chart for TSAGEFR

[bookmark: _Toc97719854]Business Process Logic Metrics
Select Audit Options on the context menu over the cross-reference library and choose the Business Process Logic Metrics option from it, as is shown below:
[image: ]
 Fig. 17.5.1 – Business Process Logic Metrics option
[image: ]
 Fig. 17.5.2 – Business Process Logic Metrics window
[bookmark: _Toc97719855]Appendix D – Troubleshooting
	[image: ]
	The X-Analysis sessions can be started using the ‘Start > All Programs > X-Analysis > X-Analysis for Eclipse’ shortcut.
For X-Analysis version 12.1.0 and onwards, simply click the 'X-Analysis for Eclipse' shortcut.


This will launch Eclipse correctly and you will be able to switch to the X-Analysis Perspective.

[bookmark: _Toc97719856]Perspective After Installing V12.1.X
On some machines, the X-Analysis Perspective may not be visible after having upgraded/installed the 12.1 series. In such a case, the following steps are to be taken:
· Right-click on the Start > X-Analysis for Eclipse shortcut and select Properties.
[image: ]
 Fig. 18.1.1 – X-Analysis for Eclipse
·  Next, select the Advanced tab.
[image: ]
 Fig. 18.1.2 – Advanced tab
· Check the Run as administrator checkbox.
[image: ]
 Fig. 18.1.3 – Run as administrator
· Finally, click OK and launch X-Analysis. The perspective will now be seen.
[image: ]
 Fig. 18.1.4 – Launch X-Analysis

[bookmark: _Toc97719857]X-Analysis Menu Disappears from the Perspective
Sometimes, the X-Analysis menu may disappear from the main menu bar. In this case, use the Window->Reset Perspective option to restore it.
[image: ]
Fig. 18.2.1 – Reset Perspective
Also, Eclipse allows you to drag and drop various views. If some of the X-Analysis views are accidentally closed or are not visible, the Window->Reset Perspective option should be used to restore them.

[bookmark: _Toc97719858]Initialization Reports
After initializing an IBM i application, various log reports are generated by the X-Analysis server. The log reports generated are categorized as:
· Program Reference Exclusions
· Missing Object and Source
[bookmark: _Toc97719859]Program Reference Exclusions
These exclusions are specified in the XAOBJ12XXXXX/XPGREXCS file.
X-Analysis is shipped with XPGREXCS file containing values QRN*, QLE*, QC*, QM*, and QS*. The file is duplicated into the user's X-Analysis library.
Any program reference specified in this file is excluded from the X-Analysis program cross-reference database, X@XPGRF.
Two reports are produced to list all actual exclusions:
· XARRMIVN program reports on exclusions from the DSPPGMREF output
· X@PMX1 program lists exclusions from the QBNLPGMI output
[bookmark: _Toc97719860]Missing Object and Source
Various programs in X-Analysis initialization process write mismatches to all logs. These mismatches are printed out under the following headings:
· References to Objects not loaded
· References to Sources not loaded
· Source Code without Objects
	[image: ]
	The above reports help you to interpret the outcome of the initialization command run on an IBM i application.



[bookmark: _Toc97719861]System Documentation Failed: File Not Found Exception
On executing the X-Analysis Documenter, if the following error is reported:
[image: ]
 Fig. 18.3.1 – System Documentation Failed
This means that the user does not have rights to create files under Program Files folder.
Do the following to get around this problem:
1. On WDSc, under the X-Analysis menu, opt for Change Application Folder. Select the folder for which you have full rights.
2. Opt for the Documenter again.

[bookmark: _Toc97719862]Screen/Report Design Feature Fails With Server Job Error
If the Screen/Report Design feature was working fine earlier and is now giving error, then look at the Server Job associated with X-Analysis.
1. Identify the QZDASOINIT job associated with the XA session and look for the USER NAME/QPRTJOB messages. For example:
Message . . . . : A duplicate job named 103581/MARK/QPRTJOB was found.
Message . . . . : A duplicate job named 161482/MARK/QPRTJOB was found.
2. Run the following command on the session:
WRKSPLF SELECT(*ALL) JOB(103581/MARK/QPRTJOB) and
WRKSPLF SELECT(*ALL) JOB(161482/MARK/QPRTJOB).
Take Option 4 against the spool files to delete them.
3. Opt for the Screen/Report Design feature again. This should be working now.

[bookmark: _Toc97719863]X-Analysis Diagnostics Utility
	[image: ]
	To ensure correct results, please use the ‘Run as administrator’ option for this utility.


The X-Analysis Diagnostics utility gets invoked automatically when an exception occurs on X-Analysis; it opens the log folder, which has the "XADiagnostics.log" along with other '.log' files. This utility will log entries under CLSID value (for bean), databorough\lib folder structure, and information about IBM's Rational products 9.5 and above or Eclipse 4.4 and above.
This utility can also be invoked stand-alone to provide directory and registry structure related to the X-Analysis installation to a log file. To run this utility, select the X-Analysis Diagnostics under the X-Analysis program group:
[image: ]
Fig. 18.4.1 – X-Analysis Diagnostics utility dialog box

[bookmark: _Toc97719864]Error Message Appears on Sign On to X-Analysis
Perform the following troubleshooting steps while signing on to X-Analysis if the following error message is displayed. perform Refer to the screen below that display an error message:
[image: ]
 Fig. 18.5.1 – Error dialog
Go to the Control Panel.
Double-click the Java Plugin. This opens the Java Plug-in Control Panel. 2. Start XA again.Go to Proxies Panel. The Proxies panel looks like this:
[image: ]
Fig. 18.5.2 – Java Plug-in Control Panel
Uncheck the Use Browser Settings checkbox. Click Apply and close the Java Plug-in Control Panel.
Start XA again.

[bookmark: _Toc97719865]Error in Generating Program Documentation
There may be instances (while generating program documentation) when you may encounter the following error:
[image: ]
 Fig. 18.6.1 – Information window showing error in MS Word initialization
To resolve this error, check the preference setting for documentation.
Go to Window->Preferences->X-Analysis->Advanced tab. You will see a specific setting Use MS Word OLE Automation under Document Generation. Check the box to activate the OLE automation for various documenting and exporting tasks.
[image: ]
 Fig. 18.6.2 – Advanced Preferences window – Document Generation
If OLE automation fails, check your OS configuration. For instance, if you have a 64-bit OS, the OLE automation will not work. In such a case, uncheck the Use MS Word OLE Automation to continue generating documents in a generic format. These documents can be viewed later using MS Office or Open Office.

[bookmark: _Toc97719866]Knowing the Specific Build Version of X-Analysis
While working with X-Analysis, it may be necessary to verify of the X-Analysis build version you are working with. This information is available through the Help tab on the Eclipse toolbar.
Click Help>About Eclipse Platform and select the X-Analysis icon as indicated in the below screen.
[image: ]
 Fig. 18.7.1 – About Eclipse Platform
Clicking on this icon will provide the information on the build id.
[image: ]
 Fig. 18.7.2 – About Eclipse Platform Features

[bookmark: _Toc97719867]Using the French Interface
If you wish to run the Eclipse provided with the Runtime Environment in the French mode, you need to edit the properties of the shortcuts provided in X-Analysis group – X-Analysis for Eclipse.
Using the Properties option on the shortcuts, update the Target value by appending '-nl fr_FR' at the end of existing value.
[image: ]
 Fig. 18.8.1 – X-Analysis for Eclipse – Properties dialog

[bookmark: _Toc97719868]X-Analysis Multiple Version
The X-Analysis functionalities or processing could be affected if a user is working with multiple versions of X-Analysis. Hence, the user must use a different (or create new) workspace for a different version.
For details on working with multiple versions of X-Analysis, refer to the document “X-Analysis_Installation_And_Upgrade_Guide” for this release.

[bookmark: _Toc97719869]XA Installation Removes Other User Pulgin RDI
For RDi Eclipse or any Eclipse which is in protected space within the restricted folder, and has some plugins in the user's space like TD/OMS plugins, subversion plugins or any latest plugins in the current marketplace that get placed under the ".eclipse" directory, the XA installation could make these plugins unavailable to the targeted Eclipse and a wizard as displayed below will be seen.
[image: ]
 Fig. 18.9.1 – Install Details
This will be prompted only once after installing/Uninstalling X-Analysis (all versions, namely, pre-V12, V12.0.x and V12.1 and onwards) and the user must follow the wizard to reconnect with the unavailable plugins. If this is not done, the plugins will not be retrieved, and the user will have to re-install them.

[bookmark: _Toc97719870]Manual Steps for SSL (Machines with TLS 1.2 Security)
If a user is unable to use the SSL feature as usual, despite being in the Runtime and RDi environment, the issue may have arisen due to the SSL protocol of TLS 1.2 security. In such a situation, the solution will be to install a higher version of Java on the machine.
Perform a few manual steps as given below:
For Runtime:
· Install JRE 1.8.0_112.
· Replace the JCE (Java Cryptography Extension) files for the installed JRE 1.8.0_112. You can download the JCE for the Oracle Java (one with Runtime) from here:
http://www.oracle.com/technetwork/java/javase/downloads/jce8-download-2133166.html
[image: ]
Fig. 18.10.1 – Installed JREs
· Rename the C:\Program File(x86)\Fresche Solutions\X-Analysis\Eclipse\JRE to some other name.
· Modify the eclipse.ini file at C:\Program File(x86)\Fresche Solutions\X-Analysis\Eclipse folder and add a line:
 -vm
 <Path of installed JRE>\bin\javaw.exe
· Install the certificates as is specified in Appendix F – Use SSL feature.
For RDi:
The IBM version of Java used in RDi uses a different JCE which can be downloaded from the following link:
https://www.ibm.com/support/knowledgecenter/en/SSWPVP_2.6.0/com.ibm.sklm.doc/admin/tsk/tsk_ic_admin_backup_jce_policy_files.html

[bookmark: _Toc97719871]TOC of XA Online Help Cannot be Viewed Via Chrome
Follow the steps given below if you are using the latest version of Chrome and facing issues in viewing the Online Help:
· Double-check the version number of Chrome to upgrade to the latest version.
· In case there are any open instances of Chrome, close them before proceeding.
· Create shortcut for Chrome on your desktop and right-click on it for the Properties >Shortcut tab.
· Append the following line in the Target field:
"C:\Program Files (x86)\Google\Chrome\Application\chrome.exe" --allow-file-access-from-files (refer to the given screenshot)
[image: ]
 Fig. 18.11.1 – Google Chrome Properties
· Click OK to apply the change.
The TOC of the Online Help should now appear correctly on Chrome as well.

[bookmark: _Toc97719872]Include Exclude Data Structure (DS) Sub-Fields in VWU
Data Area, *XINDSSFLDS *(Include DS Subfields), has been introduced to include/exclude Data Structure (DS) sub-field(s) when fetching Variable Where Used data. The values are:
· *YES (by default) – The DS sub-fields are included in Variable Where Used.
· *NO – The DS sub-fields are excluded in Variable Where Used.
                                Display Data Area 
 
  Data area . . . . . . . :       XINDSSFLDS
  Library . . . . . . . . :       XADTA13000
  Type  . . . . . . . . . :       *CHAR
  Length  . . . . . . . . :       5
  Text  . . . . . . . . . :       Include DS subfields
 			Value                             Offset    
  *...+....1....2....+....3....+....4....+....5
 	0      ‘*YES’		
Fig. 18.12.1 – Display Data Area

[bookmark: _Toc97719873]Setting Up CCSID and Database Language Translation
When a cross-reference is initialized using a certain CCSID, the cross-reference should be viewed using the respective Database Language Translation setting on Advanced Preferences as shown below.

Sample Values for CCSID
	CCSID (5250 Screen)
	Database Language Translation (XA-Client)

	5026
	Japanese Katakana 

	5035
	Japanese

	1388
	Simplified Chinese

	937
	Traditional Chinese

	933, 1364
	 Korean

	424
	Hebrew

	297, 1147
	French

	280, 1144
	Italian

	284, 1145
	Spanish

	273
	German 



	[image: ]
	If other problems are encountered which are not covered above, the user must send their requests to Support@freschesolutions.com along with the log file for the current X-Analysis session. The file can be obtained by using X-Analysis -> Open Log Folder menu option. Alternatively, use the Report an Issue feature.


[bookmark: _Toc97719874]Appendix E – Refresh X-Analysis
X-Analysis provides two commands for the operational maintenance of X-Analysis repository (cross-reference library). These two commands are XREFRESH and XAXREF.
[bookmark: _Toc97719875]XREFRESH Command
The XREFRESH command refreshes the cross-reference library to reflect any changes that are made to the cross-reference library. The command refreshes both the sources and objects that are already initialized as well as for newly created source members and objects.
	[image: ]
	The REFRESH process updates the data model for a changed object if it gets generated earlier. So, if the program is changed or newly added along with the dependent file, then the REFRESH process will update the data model for that program. This process does not work for the files.




	[image: ]
	It is recommended to run this command each night so that the cross-reference reflects the most updated state.


Before using the XREFRESH command ensure the following sequence of the library list:
· XAOBJXXXXX
· XAPROD
· QGPL
· QTEMP
Then, type the XREFRESH command on the command line and press ENTER. The following screen should appear:
                           Refresh Changed Objects (XREFRESH)
 
  Type choices, press Enter.
 
  X-Analysis Library . . . . . . .                 Name
  Refresh Application Areas  . . .   *YES          *YES, *NO, Y, N
  Refresh Business Rules . . . . .   *NO           *YES, *NO
                    
 			                                          Bottom
  F3=Exit   F4=Prompt   F5=Refresh   F12=Cancel   F13=How to use this display
  F24=More keys
  Parameter XRFLIB required.		
Fig. 19.1.1 – XREFRESH Command Screen
Provide the name of the cross-reference library which needs to be refreshed along with other details and click ENTER to submit a batch job. This batch job refreshes the cross-reference library.
At the end of XREFRESH process an Application Area called PRVRFRESH gets created containing all the members processed in the last refresh process.
Scheduling Initialization/Refresh jobs
With multiple versions of the product being allowed on the same partition, the alternative is to automatically select the right version of the product libraries while adding the initialization/refresh jobs in the job scheduler. For this purpose, a new command – XACMD has been introduced in the XAPROD library. Use this command in your customized programs for running the initialization/refresh. This command uses two parameters (the X-Ref library and the command to execute) and based on the specified X-Ref library, the appropriate version of product libraries will be used for the request submitted with this new command.
                         XA Command Launcher (XACMD)
 
  Type Choices, press Enter.
 
  X-Analysis Library . . . . . . .   __________   Name
  X-Analysis command . . . . . . .   _____________________________________
 
  ________________________________________________________________________
  ________________________________________________________________________
  ________________________________________________________________________
  ________________________________________________________________________
  ________________________________________________________________________
  __________________________________________________________________ . . .
 
    Action . . . . . . . . . . . . .  *EXEC       *SBMJ, *EXEC, *DSPL
 			                        Character value
 
 
 			                                               Bottom
  F3=Exit   F4=Prompt   F5=Refresh   F12=Cancel   F13=How to use this display F24=More Keys	
Fig. 19.1.2 – XACMD Launcher

	Parameter
	Description

	*SBMJ 
	Submit

	*EXEC
	Execute

	*DSPL 
	Display



	[image: ]
	Note:
· It is recommended to clear QTEMP library before executing XACMD command
· Any XA Library present in Library list is removed before XAPROD is added


Once the batch job is over, the user can check the error log. It is a spool file generated as a result of this batch job. The following screen displays the spool file listing:
                         Work with Job Spooled Files
 
  Job:   XREFRESH       User:   US             Number:   086439
 
  Type options, press Enter.
     1=Send  2=Change  3=Hold  4=Delete  5=Display  6=Release  7=Messages
 	8=Attributes      9=Work with printing status
 
 			Device or                       Total   Current
  Opt  File        Queue       User Data   Status  Pages     Page   Copies
       XREPORT     QPRINT      XARPTRLOG    RDY        1                1
       QPJOBLOG    QEZJOBLOG   XREFRESH     RDY     2594                1
 
 
 		                                                   Bottom
  Parameters for options 1, 2, 3 or command
  ===>
  F3=Exit   F10=View 3   F11=View 2   F12=Cancel   F22=Printers   F24=More keys		
Fig. 19.1.3 – Spool File Listing
Then, use Option 5 against spool files to view the report.
                             Display Spooled File
  File  . . . . . :   XREPORT                          Page/Line   1/1
  Control . . . . .                                    Columns     1 - 78
  Find  . . . . . .
  *..+...1...+...2...+...3...+...4....+....5....+....6....+....7....+...
  X-Analysis              Audit Log for X4SRCXC XREFRESH Processing
  XARPTRLOG
  ___________________________________________________________________________
  XREFRESH completed X4SRCXC    at 08.50.56 on 2012-12-10
  * * * * * E N D   O F   R E P O R T * * * * *
 
 			                                  Bottom
  F3=Exit   F12=Cancel   F19=Left   F20=Right   F24=More keys
  Overprinting not displayed.	
Fig. 19.1.4 – Spool file for the XREFRESH Command

[bookmark: _Toc97719876]XAXREF Command
The XAXREF command reinitializes the cross-reference library to reflect any changes that have been made to the cross-reference library.
	[image: ]
	It is recommended to run this command each night (or weekly, as the case may be) so that the cross-reference reflects the most updated state.


Before using the XAXREF command ensure the following sequence of the library list:
· XAOBJXXXXX
· XAPROD
· QGPL
· QTEMP
Then type the XAXREF command on the command line and press ENTER. The following screen should appear:
                        Initialise X-Analysis/4 (XAXREF)
 
  Type choices, press Enter.
 
  X-Analysis Library . . . . . . .ABCD            Name
 
 
 
 			                                       Bottom
  F3=Exit   F4=Prompt   F5=Refresh   F12=Cancel   F13=How to use this display
  F24=More keys
  Parameter XRFLIB required.		
Fig. 19.2.1 – XAXREF Command Screen
Provide the name of the cross-reference library and press ENTER to input further details:
                       Initialise X-Analysis/4 (XAXREF) 
                                                                          
  Type choices, press Enter.
 
  X-Analysis Library . . . . . . . > ABCD          Name
  Object Libraries . . . . . . . .   *SPECIFIED    Name, *SPECIFIED
  + for more values
  Source Libraries . . . . . . . .   *SPECIFIED    Name, *SPECIFIED, *NONE
  + for more values
  Index Source Files . . . . . . .   *ALL          *ALL, *UPG
  Build Data Model . . . . . . . .   *NO           *YES, *NO
  Generate Business Rules  . . . .   *NO           *YES, *NO               
  Initialise X-Resize  . . . . . .   *NO           *YES, *NO
  Include Duplicate Source/Object    *NO           *YES, *NO
Fig. 19.2.2 – XAXREF Command Screen
If the sources and objects are modified, then the XREFRESH job needs to run. The Build Data Model with *YES (to track any file level changes in keys, fields etc.), Generate Business Rules with *YES (to track any source level changes).
The details of the various options available on the XAXREF command are given below:

	Feature
	Brief Description

	X-Analysis Library 
	The X-Analysis cross-reference library name.

	Object Libraries 
	Special value *SPECIFIED is selected by default. It means that X-Analysis will retrieve all object libraries you have previously specified (using Option 8).

	Source Libraries
	Special value *SPECIFIED is selected by default. It means that X-Analysis will retrieve all source libraries you have previously specified (using Option 8). 

	Index Source Files 
	Specify whether to create indexes over the source files. These indexes will allow the immediate display of "where used" data. They may be required for the data model generation, depending on which options are taken. If the indexes are not built now, they can be built for an individual Source Member at the time they are viewed through the X-Analysis browser. Select one of the following:
· *ALL – It will index all source members without checking the change date.
· *UPG – Upgrade the X-Analysis database and rebuild all data including all indexes (replacing current ones).

	Build Data Model
	If you take the option to build the data model for your application then you can view it through X-Analysis. Select one of the following:
· *YES – Build the data model
· *NO – Do not build the data model
You should have the X-Analysis Professional Module/Modeling set for this to work.

	Generate Business Rules
	If you take the option to generate the business rules for your application, then you can view it through X-Analysis. Select one of the following:
· *YES – Generate Business Rules
· *NO – Do not generate Business Rules
You should have the X-Rules Module/Design Recovery set for this to work. If choosing *YES, Modeling should have been already performed or Build Data Model should be *YES.

	 Initialize X-Resize
	If you take the option to generate the X-Resize Project for your application, then you can view it through X-Analysis. Select one of the following:
· *YES – Initialize X-Resize Project
· *NO – Do not initialize X-Resize Project
You should have the X-Resize Module for this to work.

	Include Duplicate Source/Object
	If the user has different (duplicate) versions of the same source(s)/object(s) in different libraries and all such libraries are part of the cross-reference, then the behaviour shall be as follows: 
*NO – The object and source from the topmost library in the library list shall only be processed and become part of the cross-reference library. The duplicate object/source will neither be processed nor shown on Object/Member list. 
*YES – The duplicate objects and members will also get processed and shown on the Object and Member list. The object reference data is extracted on the basis of library sequence in the library list.
	[image: ]
	When *YES is selected, the object references shown in the diagrams like Structure Chart Diagram and Data Flow Diagram may show incorrect references to the duplicate objects. This is a known limitation.






	[image: ]
	From 13.0 onwards, *CHG and *NO options of ‘Index Source Files’ parameter has been removed from XAXREF command screen. 


Press ENTER to submit a batch job to process the XAXREF command.
Once the batch job is over, the user can check the different log files, which are spool files generated as a result of this batch job. Different sets of spool files are generated based on RPG or 2E environment.
For RPG environment, the following spool files are generated:

	Spool File
	Message
	Purpose

	XREPORT
	Audit Log for <X-Ref library> Init
	Job Initialisation

	XREPORT
	Audit Log for <X-Ref library> D/B Model Build
	If Build Data Model is *YES

	XREPORT
	Audit Log for <X-Ref library> Business Rule Extraction
	If Generate Business Rules is *YES



For 2E environment, the following spool files are generated:
	Spool File
	Message
	Purpose

	XREPORT
	Audit Report for <X-Ref library> Load on…
	Object/Member List

	XREPORT
	Audit Log for <X-Ref library> Init
	Job Initialisation

	XREPORT
	SYNON Relationships where foreign keys are missing
	Foreign key relationships

	XREPORT
	Audit Log for <X-Ref library> D/B Model Build
	If Build Data Model is *YES

	XREPORT
	Audit Log for<X-Ref library> Re-engineering Processing
	Re-engineering executed

	XREPORT
	Audit Log for <X-Ref library> Business Rule Extraction
	If Generate Business Rules is *YES



Use the following command to check the generated spool file:
WRKJOB JOB(JOB NUMBER/USER/XAXREF)
This should invoke the following similar screen:
                                Work with Job
 			                                   System:   DBSPW6
  Job:   QPADEV0021     User:   US             Number:   087868
 
  Select one of the following:
 
 	1. Display job status attributes
 	2. Display job definition attributes
 	3. Display job run attributes, if active
 	4. Work with spooled files
 
 	10. Display job log, if active, on job queue, or pending
 	11. Display call stack, if active
 	12. Work with locks, if active
 	13. Display library list, if active
 	14. Display open files, if active
 	15. Display file overrides, if active
 	16. Display commitment control status, if active
 		                                              	More...
  Selection or command
  ===>
 
  F3=Exit   F4=Prompt   F9=Retrieve   F12=Cancel		
Fig. 19.2.3 – Work with Job Screen
Then, use Option 4 to work with associated spool files:
                         Work with Job Spooled Files
 
  Job:   XAXREF         User:   US             Number:   087868
 
  Type options, press Enter.
   1=Send   2=Change   3=Hold   4=Delete   5=Display   6=Release   7=Messages
   8=Attributes        9=Work with printing status
 
 			Device or                  Total   Current             
  Opt   File        Queue       User Data   Status  Pages     Page   Copies
       XREPORT      QPRINT      XARPTRLOG    RDY        1                1
       XREPORT      QPRINT      XARPTRLOG    RDY        1                1
       XREPORT      QPRINT      XARPTRLOG    RDY        1                1
       QPJOBLOG     QEZJOBLOG   XAXREF       RDY       90                1      	
Fig. 19.2.4 – Job-Specific Spool Files
Then, use Option 5 against spool files to view the report.
                    X-Ref Job Scheduler Entries (XASCDEIDX)
 
  Type choices, press Enter.
 
  X-Analysis library . . . . . . .                 Name
  CL source library  . . . . . . .                 Name		
Fig. 19.2.5 – X-Ref Job Scheduler Entries (XASCDEIDX)
                     Create/Index Robot Sched Jobs (XAROBOT)
 
  Type choices, press Enter.
 
  X-Analysis library . . . . . . .                 Name
  Robot library  . . . . . . . . .                 Name      
  CL source library  . . . . . . .                 Name		
Fig. 19.2.6 – Index Robot Scheduler Jobs (XAROBOT)
[bookmark: _Toc97719877][bookmark: 396638855]Appendix F – Use SSL feature
The X-Analysis Sign-on dialog box is equipped with the Use SSL feature. The feature has been introduced to transfer data securely. The box is unchecked by default. Check the box to enable the feature while working with X-Analysis.
The following screen shows the dialog box:
[image: ]
Fig. 20.1.1 – Application Library view
Before using this feature, follow the given steps to establish the SSL connection:
1. Choose the X-Analysis drop-down menu from the X-Analysis toolbar and click the Install SSL CA certificate feature. The selection is shown below:
[image: ]
Fig. 20.1.2 – X-Analysis drop-down menu – Install SSL CA certificate feature
2. Click Install SSL CA certificate to invoke the Install CA Certificates dialog box (as shown below).
[image: ]
Fig. 20.1.3 – Install CA Certificates dialog box
3. Click Open to invoke the Open CA Certs Keystore dialog with cacerts file. Select it and click Open.
[image: ]
Fig. 20.1.4 – Open CA Certs Keystore dialog box
4. A new dialog box is displayed which prompts a message to enter the password for Keystore. The default password is ‘changeit’.
[image: ]
Fig. 20.1.5 – Password for Keystore dialog
5. Click OK. The Install CA Certificates dialog displays the list of all the available certificates.
[image: ]
Fig. 20.1.6 – Install CA Certificates window displaying all certificates
6. Click Import and select the Security Certificate issued from the iSeries. It would then get added to the list of certificates, providing you with the necessary authorization.
After performing these steps, check the ‘Use SSL’ box in the Sign-on dialog to begin using the feature.
[bookmark: _Toc97719878]Appendix G – Setting Status for Business Rules
[bookmark: _Toc97719879]Business Rules Status
When the user selects the Business Rules Overlay or the Business Rules mode in the Source Editor, a new functionality allows a user to set Rule Status for any rule.
	[image: ]
	Check the box – ‘Allow editing in Consolidated Rules’ from Window->Preferences->X-Analysis to activate these features.


The user can set comment and/or change the rule status for any rule. Select the right-click option, Change Rule Status to, for directly changing the rule status.
A list of such possible statuses is already provided, and shown in the screen below:
[image: ]
 Fig. 21.1.1 – Business Rules window – List of Rule Status
The user can view the history of how the rule status has changed through the Rule Status Manager option, available on right-click on a rule. The following screen shows the Rule Status Manager dialog.
[image: ]
 Fig. 21.1.2 – Rule Status Manager dialog
The Business Rules view displays new columns for Error Message, Business Rule Annotation, Rule Status, and Rule Status Comment. The columns are shown in the screen below.
[image: ]
 Fig. 21.1.3 – Business Rules window showing the new columns
The Configure Columns feature in the Business Rules view allows the user to manage the columns displayed. The user can reduce the width or hide any column by setting width to 0.
[image: ]
 Fig. 21.1.4 – Business Rules window – Configure Columns option
There are various buttons for filtering business rules display. The rules are filtered based on whether they are Exportable Rules, Update Rules, or Excluded Rules. The filters have toggle behavior. The following screen shows the three filter buttons.
[image: ]
 Fig. 21.1.5 – Business Rules window – Filter buttons
An additional option, Filter by Rule Status has been provided to filter the rules based on their status. Make the selection from the list of Rule Status in a drop-down menu.
[image: ]
 Fig. 21.1.6 – Business Rules window – Filter by Rule Status option
There is an option to allow to Add User defined Rule. Select the relevant File/Field and set the Rule text and error message ID. Such rules start from 60001 and are shown in a different color (orange). Select the option to invoke the following dialog box:
[image: ]
 Fig. 21.1.7 – Add User Defined Rule dialog box

	[image: ]
	Define a rule only when you have selected the ‘Business Rules’ feature on an individual program from the Source Member view.


Select the right-click option to convert a rule to 'Exportable/Non-Exportable'. The option is displayed in the screen below:
[image: ]
 Fig. 21.1.8 – Business Rules window – Convert to Exportable option
The X-Analysis client allows a user to view the Business Rules Matching/Exclusion list, produced as a result of a process on the server that compares the existing cross-reference against an older one, and moves the Business Rule Status and Annotations from the older to the new cross-reference.
This report can be seen by the right-click option, Business Rule Matching, available on the context menu of the entire cross-reference, an application area, or a program. The report can be filtered to view only one of the types (Changed/Removed/Matched), and also exported to Word/PDF/Excel.
The following screen shows Business Rule Matching view of application area, HORIZON.
[image: ]
 Fig. 21.1.9 – BR Matching window

[bookmark: _Toc97719880]Business Rules Status Category
The Business Rules Status Category option is present on the context menu of the X-Ref library as is displayed in the screen below.
[image: ]
 Fig. 21.2.1 – Business Rules Status Category option – X-Ref context menu
All the pre-set categories of Business Rules Status are displayed on clicking this option. The following window shows all the categories:
[image: ]
 Fig. 21.2.2 – Business Rules Status Categories
The existing categories can be edited or deleted by using the right-click context menu on a specific category. The following screen shows the context menu opted on a category.
[image: ]
 Fig. 21.2.3 – Right-click context menu opted on a category
On selecting the Edit option, the following dialog box is invoked:
[image: ]
 Fig. 21.2.4 – Work With Status Category dialog box
Using the above dialog box, modify the description of the default category, as required.
On clicking Add Status Category icon on the Status Category toolbar, the same dialog as presented above is invoked. This time you can assign a letter for the Category, besides the Description. The icon is indicated in the following screen:
[image: ]
 Fig. 21.2.5 – Add Status Category icon
[bookmark: _Toc97719881]Appendix H – Export to Google Drive
The user can now export DOCX and XLSX type to Google Drive. The use of Google Drive export requires Authorization setup. As the initial step, the user needs to authorize the Google Drive, and then select the related options from X-Analysis Preferences.
The link provided below helps you with all the information related to the Google Drive Web APIs:
https://developers.google.com/drive/web/quickstart/quickstart-java
The steps to be followed are given as below:
1. Generate a Client ID/Client Secret for your google account. Click on the link:
https://console.developers.google.com//start/api?id=drive&credential=client_key
The following window will appear:
[image: ]
 Fig. 22.1.1 – Sign in window – Google Developers Console
Sign in with your google email id and password.
2. After sign in is complete, the following registration window will appear:
[image: ]
 Fig. 22.1.2 – Sign in Complete
Check the box on the pop-up and click Continue.
3. The following window will appear. Confirm the registration process by checking all the boxes.
[image: ]
 Fig. 22.1.3 – Registration Confirmation
Click Agree and continue. A project will be created with the default name, My Project.
4. Under My Project > APIs & auth, click on APIs. Check that the Drive API is ON as displayed in the following image:
[image: ]
 Fig. 22.1.4 – APIs window
If not, locate it under Browse APIs. The image below shows Drive API as OFF. Click OFF to enable the feature.
[image: ]
 Fig. 22.1.5 – Drive API under Browse APIs section
5. Under My Project > APIs & auth, click Consent screen. The following window will appear:
[image: ]
 Fig. 22.1.6 – Consent screen window
Provide your email address and Product Name, as shown below:
[image: ]
 Fig. 22.1.7 – Consent screen window with email and product details
Click Save.
6. Now, click Credentials under My Project > APIs & auth. The following window will appear:
[image: ]
 Fig. 22.1.8 – Credentials window
Click on Create new Client ID. The following pop-up window will appear:
[image: ]
 Fig. 22.1.9 – Create Client ID pop-up window
On the pop-up window, select APPLICATION TYPE > Installed application and INSTALLED APPLICATION TYPE > Other.
Click Create Client ID.
7. A window will appear displaying the Client ID and Client Secret. Please save the Client ID and Secret for later use.
[image: ]
 Fig. 22.1.10 – Client ID and Client Secret
8. On the X-Analysis Client, check to allow options for DOCX and XLSX on the Window>Preferences>X-Analysis>General.
[image: ]
 Fig. 22.1.11 – General Preferences window showing Google Drive Export options
9. Click the Preferences>Advanced tab. The following window will be displayed. Provide the saved Google Client ID and the Google Client Secret in the specified fields.
[image: ]
 Fig. 22.1.12 – Advanced Preferences window
10. Click Authorize Google Drive from the X-Analysis drop-down menu.
[image: ]
 Fig. 22.1.13 – X-Analysis menu – Authorize Google Drive option
The Authentication URL using the Client ID and Secret will be automatically generated.
11. The Google Authorization window will appear. Sign in with your gmail id and password.
[image: ]
 Fig. 22.1.14 – Google Authorization – Sign in window
12. After sign in, the following window will appear:
[image: ]
 Fig. 22.1.15 – Google Authorization window
Click Accept.
13. The following window containing a code will appear. Copy and paste this code on the Paste code from Web Browser box.
[image: ]
 Fig. 22.1.16 – Google Authorization window – with code
Click Authorize.
14. The following window will appear. Click OK to confirm the use of the Google Drive feature.
[image: ]
 Fig. 22.1.17 – Google Authorization successful dialog box
After completing these steps, the user will now see Export DOCX to Google Drive and Export XLSX to Google among the Export Options.
[image: ]
 Fig. 22.1.18 – Export Options displaying Google Export
The document you select would be placed in the google drive and can be checked using the web browser.
	[image: ]
	Once authorized, the Google Export feature will work on an active session of X-Analysis. After exiting the X-Analysis platform, the user will need to re-authorize the Google drive.


[bookmark: _Toc97719882]Appendix I – RSE (Remote System Explorer) on RDi
X-Analysis features can be invoked through the Remote System Explorer on RDi. The user has to right-click on a specific member name to use the options.
The first step is to install RDi. Download RDi version 9.0 and above (preferably).
Then go to the X-Analysis client interface. If you have installed a new version, then go to Window > X-Analysis > Open Perspective > Other… and choose Remote System Explorer.
[image: ]
 Fig. 23.1.1 – Open Perspective – Remote System Explorer
Click OK.
Select the object from the Member List or the Object List as shown below:
[image: ]
 Fig. 23.1.2 – Selected object - WWCUSTS
Now right-click on the object to use the X-Analysis options. The following screen shows these options:
[image: ]
 Fig. 23.1.3 – X-Analysis Options
For instance, if the user selects the Data Flow Diagram option then the following dialog box will get invoked:
[image: ]
 Fig. 23.1.4 – X-Analysis Login dialog box on RSE
Enter the IP Address, user name, and password to enable the X-Analysis Login.
[image: ]
 Fig. 23.1.5 – Login details
Click OK. This will invoke another dialog box that will ask the user to specify the X-Ref library.
The drop-down box will show as follows:
[image: ]
 Fig. 23.1.6 – Select X-Ref dialog box – Drop-down showing the available X-Ref libraries
Select the X-Ref library.
[image: ]
 Fig. 23.1.7 – Selected X-Ref Library
Click OK. The Data Flow Diagram for the selected object will be displayed as follows:
[image: ]
 Fig. 23.1.8 – Data Flow Diagram on RSE
The Variable Where Used options can also be accessed through the Lpex editor. For this, change the settings through X-Analysis General Preferences.
[image: ]
 Fig. 23.1.9 – Lpex as the Default Source Editor
Click OK to confirm the change.
Again, select the WWCUSTS program and right-click for the context menu and see the Zoom in Lpex option.
[image: ]
 Fig. 23.1.10 – Right-click context menu - Zoom in Lpex option
The following window shows the Variable Where Used option on the Lpex Source Editor.
[image: ]
 Fig. 23.1.11 – X-Analysis Options - Variable Where Used

	[image: ]
	Switching between the RSE and X-Analysis perspectives (or, if changing the X-Ref library within RSE) will close all the active Editors/Views in X-Analysis.


[bookmark: _Toc97719883]Appendix J – User Authority option
[bookmark: _Toc97719884]Disabling View Data
Expand the X-Analysis application library, and then double-click the File node. This invokes the Object List. On selecting the View Data option from the context menu, the record of *File type objects (PFs and LFs) may be viewed.
New functionality allows the user to disable the View Data option for All/specific User. This feature can be used on version 13.0.05 or later. After initialization process, the cross-reference should have the table XUSRAUT with USER=*PUBLIC and FUN=VIEWDATA record as seen in the screen below.
                               Display Data
 			                 Data Width . . . . . . :     267
  Position to line . . . . ._______    Shift To column  . . . . . _______
 
  ...+...1...+...2...+....3...+...4....+....5...+....6...+...7....+....
  USER         FUN                    EXTYP   PFILE      FUNAUT
  XWEB         GOOGLE                         *ALL         Y
  *PUBLIC      VIEWDATA                       *ALL         Y
 
  ******** END OF DATA ********
 
 
 		                                          	Bottom
  F3=Exit       F12=Cancel      F19=Left       F20=Right        F21=Split
Fig. 24.1.1 – Display data
[bookmark: _Toc97719885]Disable for all users
· Change FUN=VIEWDATA row to FUNAUT=N in XUSRAUT Table in cross-reference library for *PUBLIC.
                               Display Data
 			                 Data Width . . . . . . :     267
  Position to line . . . . ._______    Shift To column  . . . . . _______
 
  ...+...1...+...2...+....3...+...4....+....5...+....6...+...7....+....
  USER         FUN                    EXTYP   PFILE      FUNAUT
  XWEB         GOOGLE                         *ALL         Y
  *PUBLIC      VIEWDATA                       *ALL         N
 
  ******** END OF DATA ********
 
 
 		                                          	Bottom
  F3=Exit       F12=Cancel      F19=Left       F20=Right        F21=Split		
Fig. 24.1.2 – Display data
[bookmark: _Toc97719886]Disable a specific or multiple user
· Add a new record in XUSRAUT Table in cross-reference library with same as the *PUBLIC record but change the USER to the actual user name.
· Change FUN=VIEWDATA row to FUNAUT=N in XUSRAUT Table in cross-reference library for that specific or multiple USER. The screen below is showing View Data Option disabled for multiple USER.
                               Display Data
 			                 Data Width . . . . . . :     267
  Position to line . . . . ._______    Shift To column  . . . . . _______
 
  ...+...1...+...2...+....3...+...4....+....5....+....6....+...7....+....
  USER         FUN                    EXTYP   PFILE      FUNAUT
  XWEB         GOOGLE                         *ALL         Y
  *PUBLIC      VIEWDATA                       *ALL         N
  USER_1       VIEWDATA                       *ALL         N
  USER_2       VIEWDATA                       *ALL         N
 					
  ******** END OF DATA ********
 
 
 		                                          	Bottom
  F3=Exit       F12=Cancel      F19=Left       F20=Right       F21=Split	
Fig. 24.1.3 – Display data
[bookmark: _Toc97719887]Disable all users except a specific or multiple users
· Add a new record in XUSRAUT Table in cross-reference library with same as the *PUBLIC record but change the USER to actual USER.
· Change FUN=VIEWDATA row to FUNAUT=N in XUSRAUT Table in cross-reference library for *PUBLIC.
·  Change FUN=VIEWDATA row to FUNAUT=Y in XUSRAUT Table in cross-reference library for that specific or multiple users. The screen below is showing View Data Option disabled for *PUBLIC but at the same time, enabled for a specific or multiple user.
                               Display Data
 			                 Data Width . . . . . . :     267
  Position to line . . . . ._______     Shift To column  . . . . . _______
 
  ....+...1...+....2...+....3...+...4...+...5...+...6....+....7....+....
  USER         FUN                    EXTYP   PFILE      FUNAUT
  XWEB         GOOGLE                         *ALL         Y
  *PUBLIC      VIEWDATA                       *ALL         N
  USER_1       VIEWDATA                       *ALL         Y
  USER_2       VIEWDATA                       *ALL         Y
 					
  ******** END OF DATA ********
 
 
 		                                          	Bottom
  F3=Exit       F12=Cancel      F19=Left       F20=Right       F21=Split
Fig. 24.1.4 – Display data
The View Data option present on the context menu appears as disabled when it has been disabled for all the users or a particular user. Refer to the screen below:
[image: ]
 Fig. 24.1.4 – View Data

[bookmark: _Toc97719888]Application Library List Modification Restrictions
The Application Library List is used to view/update the list of object and source libraries for the selected cross-reference. To view/change the application libraries, opt for the context menu on the application library and select the Application Library List option. The following dialog box stipulates that there is no modification restriction imposed:
[image: ]
 Fig. 24.2.1 – Application Library List dialog box
X-Analysis now supports a mechanism whereby a user can be restricted from changing the Application Library List. This feature can be used on version 13.1.06 or later. After initialization process, the cross-reference should have the table XUSRAUT with USER=*PUBLIC and FUN= CHGLIBLIST record as seen in the screen below.
                               Display Data
 			                 Data Width . . . . . . :     267
  Position to line . . . . ._______     Shift To column  . .  . . _______
 
  ....+...1...+...2...+...3...+...4....+...5....+....6....+....7....+....
  USER         FUN                    EXTYP   PFILE      FUNAUT
  XWEB         GOOGLE                         *ALL         Y
  *PUBLIC      CHGLIBLIST                     *ALL         Y
 
  ******** END OF DATA ********
 
 
 		                                          	Bottom
  F3=Exit       F12=Cancel      F19=Left       F20=Right       F21=Split		
Fig. 24.2.2 – Display data
[bookmark: _Toc97719889]Restrict for all users
· Change FUN= CHGLIBLIST row to FUNAUT=N in XUSRAUT Table in cross-reference library for *PUBLIC.
                               Display Data
 			                 Data Width . . . . . . :     267
  
  Position to line . . . . ._______     Shift To column  . . .  . _______
 					
 
  ....+...1...+...2...+....3...+...4...+....5....+....6....+....7....+....
  USER         FUN                    EXTYP   PFILE      FUNAUT
  XWEB         GOOGLE                         *ALL         Y
  *PUBLIC      CHGLIBLIST                     *ALL         N
 
  ******** END OF DATA ********
 
 
 		                                          	Bottom
  F3=Exit       F12=Cancel      F19=Left       F20=Right       F21=Split	
Fig. 24.2.3 – Display data
[bookmark: _Toc97719890]Restrict for specific or multiple user
· Add a new record in XUSRAUT Table in cross-reference library with same as the *PUBLIC record but change the USER to actual username.
· Change FUN= CHGLIBLIST row to FUNAUT=N in XUSRAUT Table in cross-reference library for that specific or multiple USER. The screen below is showing application library list modification restricted for multiple USER.
                               Display Data
 			                 Data Width . . . . . . :     267
  
  Position to line . . . . ._______     Shift To column  . . . . ._______
 					
 
  ....+...1...+...2...+...3...+...4...+...5...+....6...+....7....+....
  USER         FUN                    EXTYP   PFILE      FUNAUT
  XWEB         GOOGLE                         *ALL         Y
  *PUBLIC      CHGLIBLIST                     *ALL         Y
  USER_1       CHGLIBLIST                     *ALL         N
  USER_2       CHGLIBLIST                     *ALL         N
 										
  ******** END OF DATA ********
 
 
 		                                          	Bottom
  F3=Exit       F12=Cancel      F19=Left       F20=Right       F21=Split		
Fig. 24.2.4 – Display data
[bookmark: _Toc97719891]Restrict for all users except a specific or multiple users
· Add a new record in XUSRAUT Table in cross-reference library with same as the *PUBLIC record but change the USER to actual USER.
· Change FUN=CHGLIBLIST row to FUNAUT=N in XUSRAUT Table in cross-reference library for *PUBLIC.
· Change FUN= CHGLIBLIST row to FUNAUT=Y in XUSRAUT Table in cross-reference library for that specific or multiple users. The screen below is showing application library list modification restricted for *PUBLIC but at the same time, unrestricted for a specific or multiple user.
                               Display Data
 			                 Data Width . . . . . . :     267
  
  Position to line . . . . ._______     Shift To column  . . . . ._______
 					
 
  ....+...1...+...2...+....3....+...4...+....5...+....6....+....7....+....
  USER         FUN                    EXTYP   PFILE      FUNAUT
  XWEB         GOOGLE                         *ALL         Y
  *PUBLIC      CHGLIBLIST                     *ALL         Y
  USER_1       CHGLIBLIST                     *ALL         N
  USER_2       CHGLIBLIST                     *ALL         Y
 										
  ******** END OF DATA ********
 
 
 		                                          	Bottom
  F3=Exit       F12=Cancel      F19=Left       F20=Right       F21=Split		
Fig. 24.2.5 – Display data
The Modify/Remove/Move Up/Move Down/Add options in Application Library List dialog box are disabled when it has been disabled for all the users or a particular user. Refer to the screen below:
[image: ]
 Fig. 24.2.6 – Application Library List dialog box
[bookmark: _Toc97719892]Disabling Export to Google Drive
A new functionality allows you to disable the Export to Google Drive option for All/specific User. This feature can be used on version 13.1 or later.
	[image: ]
	Make sure the desired options on XA Client preferences are selected in order to get this option as explained in Appendix H.


After the initialization process, the cross reference should be manually updated to have FUN=GOOGLE record for USER = *PUBLIC or specified user name as shown in the screen below:
                               Display Data
 			                 Data Width . . . . . . :     267
  
  Position to line . . . . ._______     Shift To column  . . . . ._______
 					
 
  ....+...1...+...2....+....3...+....4...+....5...+...6....+....7....+....
  USER         FUN                    EXTYP   PFILE      FUNAUT
  XWEB         GOOGLE                         *ALL         N
  *PUBLIC      GOOGLE                         *ALL         Y
 
Fig. 24.3.1 – Display data
[bookmark: _Toc97719893]Disable for all users
· Change FUN=GOOGLE row to FUNAUT=N in XUSRAUT Table in cross-reference library for *PUBLIC.
                               Display Data
 			                 Data Width . . . . . . :     267
  
  Position to line . . . . ._______     Shift To column  . . . . ._______
 					
 
  ....+...1...+....2...+...3...+...4...+....5...+....6....+....7....+....
  USER         FUN                    EXTYP   PFILE      FUNAUT
  XWEB         GOOGLE                         *ALL         N
  *PUBLIC      GOOGLE                         *ALL         Y
 
  ******** END OF DATA ********
 
 
 		                                          	Bottom
  F3=Exit       F12=Cancel      F19=Left       F20=Right       F21=Split	
Fig. 24.3.2 – Display data
[bookmark: _Toc97719894]Disable a specific or multiple users
· Add a new record in XUSRAUT Table in cross-reference library with same as the *PUBLIC record but change the USER to actual user name.
· Change FUN=GOOGLE row to FUNAUT=N in XUSRAUT Table in cross-reference library for that specific or multiple users. The screen below is showing Export to Google Drive option disabled for multiple users.
                               Display Data
 			                 Data Width . . . . . . :     267
  
  Position to line . . . . ._______     Shift To column  . . . . ._______
 					
 
  ....+....1...+....2...+...3...+...4....+...5....+...6....+....7....+....
  USER         FUN                    EXTYP   PFILE      FUNAUT
  XWEB         GOOGLE                         *ALL         Y
  *PUBLIC      GOOGLE                         *ALL         Y
  USER_1       GOOGLE                         *ALL         N
  USER_2       GOOGLE                         *ALL         N
 										
  ******** END OF DATA ********
 
 
 		                                          	Bottom
  F3=Exit       F12=Cancel      F19=Left       F20=Right       F21=Split		
Fig. 24.3.3 – Display data
[bookmark: _Toc97719895]Disable all users except a specific or multiple users
· Add a new record in XUSRAUT Table in cross-reference library with same as the *PUBLIC record but change the user to actual user.
· Change FUN=GOOGLE row to FUNAUT=N in XUSRAUT Table in cross-reference library for *PUBLIC.
· Change FUN=GOOGLE row to FUNAUT=Y in XUSRAUT Table in cross-reference library for that specific or multiple users. The screen below is showing Export to Google Drive option disabled for *PUBLIC but at the same time, enabled for a specific or multiple users.
                               Display Data
 			                 Data Width . . . . . . :     267
  
  Position to line . . . . ._______     Shift To column  . . . . ._______
 					
 
  ....+....1...+...2...+...3...+...4....+...5...+....6...+....7....+....
  USER         FUN                    EXTYP   PFILE      FUNAUT
  XWEB         GOOGLE                         *ALL         Y
  *PUBLIC      GOOGLE                         *ALL         N
  USER_1       GOOGLE                         *ALL         Y
  USER_2       GOOGLE                         *ALL         Y
 										
  ******** END OF DATA ********
 
 
 		                                          	Bottom
  F3=Exit       F12=Cancel      F19=Left       F20=Right       F21=Split	
Fig. 24.3.4 – Display data
The Export to Google Drive option present on the tool bar appears as disabled when it has been disabled for all the users or a particular user. Refer to the screen below:
[image: ]
 Fig. 24.3.5 – Export to Google options
[bookmark: _Toc97719896]Appendix K - Control Options
[bookmark: _Toc97719897]Instrumentation Control
X-Analysis allows the creation of logs via Instrumentation. There are two options to control the data for the Instrumentation.
The options to create the logs via Instrumentation are provided at two levels:
1. System level
2. Cross Reference level
System level node: New option, Control Options is added below the Refresh Application List. Right-click the IP node, select Control Options->Instrumentation Control.
[image: ]
 Fig. 25.1.1 – System level node
Cross-Reference level: New option, Control Options is added below the Audit Options. Right-click the cross-reference node, select Control Options->Instrumentation Control.
[image: ]
 Fig. 25.1.2 – Cross-Reference level node
Clicking the Instrumentation Control will invoke a new dialog box.
[image: ]
 Fig. 25.1.3 – Instrumentation Control
This allows the users to either Enable or Disable Instrumentation and will also allow the user to change the Instrumentation Log Level.
Clicking Restore Defaults will reset the factory settings of Instrumentation Control, which is Enable Instrumentation - YES and Instrumentation Log Level - FATAL.
	[image: ]
	A running job will verify after every five minutes for any change on the Instrumentation Log Level and will perform the logging accordingly.



[bookmark: _Toc97719898]Instrumentation Log Level and Description
DEBUG: This designates fine-grained informational events that are most useful to debug. It is used by the application developers for detail tracing.
TRACE: This designates fine-grained informational events than DEBUG. It is used in troubleshooting when doing integration testing.
INFO: This designates informational messages that highlight the progress of the application at a coarse-grained level. It provides informational messages that might make sense to end-users and system administrators and highlight the progress of the application.
WARN: This designates potentially harmful situations to the end-users or system managers that indicate potential problems.
ERROR: This designates error events that might still allow the application to continue running. This will prevent normal program execution, but might still allow the application to continue running.
FATAL: This designates very severe error events that will presumably lead the application to abort which might cause the application to terminate.
[bookmark: _Toc97719899]Extracting Log Data from the Instrumentation Log
The user can access all the logged information from the table X_LOG. The user should use the <X-Ref Name>.X_LOG to receive all the information from the log.
[bookmark: _Toc97719900]Enable / Disable Instrumentation
From release 13.2.05, by default, the Instrumentation Control is Enabled. However, since release 13.2.06, any time user can disable the Instrumentation Control from the GUI either at the system level or the cross-reference level by opting Control Options->Instrumentation Control explained above.
	[image: ]
	From release 13.2.01 to release 13.2.04, the Instrumentation Control was by default Disabled for any given cross-reference. However, for the above mentioned XA versions, the user can Enable the Instrumentation Control for any cross-reference by setting the data area XFACADESET value to *ON. This data area was present inside the cross-reference libraries created for XA versions 13.2.01 to 13.2.04.


[bookmark: _Toc97719901]Appendix L – REGEX Search
X-Analysis is now enhanced to provide REGEX search for the options available in the cross-reference menu:
· Application Area List
· Annotation List
· Application Area Diagram summary (AAD summary)
After adding the filter criteria, it is not required for the user to press <Enter>. The Filtering criteria gets automatically updated and displayed in the applicable windows.
If any filtering criteria already exists, then the new filtering criteria will complement the existing filtering criteria.
This appendix explains different types of filtering criteria for the options mentioned above.
· For filtering a column with the text that is available at the middle or the end of that column. In that case, the user must add the prefix “*” before the filter text in the filtering column. Refer to the screen below for all the three options with the criterion explained above.
[image: ]
 Fig. 26.1.1 – Application Area List
[image: ]
 Fig. 26.1.2 – Application Area Diagram summary
[image: ]
 Fig. 26.1.3 – Annotation List
· For filtering the text in a column that starts and ends with some specific character. In that case, the user must add the character(s) with a “*” before the last character in the filtering column. Refer to the screen below for all the three options with the criterion explained above.
[image: ]
 Fig. 26.1.4 – Application Area List
[image: ]
 Fig. 26.1.5 – Application Area Diagram summary
[image: ]
 Fig. 26.1.6 – Annotation List
· For filtering column with a digit. In that case, the user must add “*\d” in the filtering column. Refer to the screen below for all the three options with the criterion explained above.
[image: ]
 Fig. 26.1.7 – Application Area List
[image: ]
 Fig. 26.1.8 – Application Area Diagram summary
[image: ]
 Fig. 26.1.9 – Annotation List
· For filtering column not starting with specific character(s). In that case, the user must add “[^xx]” in the filtering column. Here, xx denotes the first two character of that text. Refer to the screen below for all the three options with the criterion explained above.
[image: ]
 Fig. 26.1.10 – Application Area List
[image: ]
 Fig. 26.1.11 – Application Area Diagram summary
[image: ]
 Fig. 26.1.12 – Annotation List
· For filtering column containing the digits from 1 to 9. In that case, the user must add “*[1-9]” in the filtering column. Refer to the screen below for all the three options with the criterion explained.
[image: ]
 Fig. 26.1.13 – Application Area List
[image: ]
 Fig. 26.1.14 – Application Area Diagram summary
[image: ]
 Fig. 26.1.15 – Annotation List
· For filtering column with character(s) A to Z. In that case, the user must add “[x-x]*” in the filtering column. Here, xx denotes the character(s) A to Z. Refer to the screen below for all the three options with the criterion explained.
[image: ]
 Fig. 26.1.16 – Application Area List
[image: ]
 Fig. 26.1.17 – Application Area Diagram summary
[image: ]
 Fig. 26.1.18 – Annotation List
[bookmark: _Toc97719902]Appendix M - XA-Client Hot-keys
This appendix list down the shortcut keys for various options available in XA-Client.
· Jump to Dialog: User can invoke this option by pressing Ctrl+Shift+J.
· Help: User can invoke this option by pressing Fn+F1.
[bookmark: _Toc97719903][bookmark: -540831305]Appendix N - Importing data from Production machines
This appendix highlights the steps and requirements to extract production data from one or multiple systems where the application gets analyzed by X-Analysis. Those production data include file changed/created/Used date and Days Used information, which will bring valuable and accurate information when analyzing such files.
Prerequisite and assumptions regarding the preparation and extraction of the data:
· X-Analysis must be installed on a “development” machine and a corresponding X-Ref has been created based on the source and object libraries running in production.
· The X-Ref has been fully initialized.
· The production environment must have the exact library names, containing the same objects, as what has been used during the preparation of the X-Analysis X-Ref.
· When the same application is being used on more than one production machine, the procedure to extract the production data must be executed on each machine. The extraction of the information from the production environment will be done using the system command DSPOBJD.
[image: ]
Fig. 27.1.1 – Display Object Description DSPOBJD
Before using the CPYPRDOBJD command ensure the following sequence of the library list:
· XAOBJXXXXX
· XAPROD
· QGPL
· QTEMP
Then enter the command CPYPRDOBJD and press F4. Refer to the below screen.
[image: ]
Fig. 27.1.2 – Command CPYPRDOBJD
User must make sure to enter a valid file name and X-Analysis Library. By default the command has ‘Input Files’ as *ALL. It will process all the files present in the below mentioned library.
[image: ]
 Fig. 27.1.3 – Copy Data in cross repository
Enter the valid X-Analysis Library and File name. Make sure that the Library exists in the system.
[image: ]
 Fig. 27.1.4 – Copy Data in cross repository
The execution of the CPYPRDOBJD command should generate a message such as Execution completed with errors, Execution completed with warnings, and Execution complete successfully. 
While executing the command the IBM i green screen displays the following message which were presented in the below screenshots.
· Execution completed with errors: Error occurs while processing the data.
· Execution completed with warnings: During the import of data some objects were either missing or not expected.
· Execution completed successfully: Everything has been imported as expected.
[image: ]
Fig. 27.1.5 – Execution completed with warnings
Now enter the SQL statement STRSQL.
[image: ]
Fig. 27.1.6 – SQL Statement
[image: ]
Fig. 27.1.7 – SQL Statement
Message gets displayed in the screen that the data gets copied in our new file.
[image: ]
Fig. 27.1.9 – Execution completed
Similarly, if all the data has been imported as expected, a completion message gets displayed with a message that Execution completed successfully.
[image: ]
Fig. 27.1.10 – Execution completed successfully
Message gets displayed in the screen that the data gets copied in our new file – XAPRDOBJD successfully. 
[image: ]
Fig. 27.1.11 – Execution completed with Success
Once the production data is imported inside the X-Analysis repository, option All Object/Files/Programs will provide a new option to specify from which system to display the detail file information. Also Application Area Rules is now enhanced with new panel Object Usage to create rules based on some production data related information. For more details refer to the section Application Area Rules.
Refer to the screen displaying the new feature, System added with the following options:
[image: ]
Fig. 27.1.12 – System names for objects in Application Area Rules
· <specific system>: Identifying a specific system, the application area rules will only qualify the objects reported from the mentioned system.
· <Max All Systems>: Selecting the System value <Max All Systems>, the application area rules will look if the maximum value from all the systems meets the criteria.
· <Min All Systems>: Selecting the System value <Min All Systems>, the application area rules will look if the minimum value from all the systems meets the criteria.
From System drop-down in the Object Usage tab, select the option <Min all Systems> or <Max all Systems> regardless of the number of machines. When the option <Min all Systems> or <Max all Systems> is selected, the “Omit Locale Usage” is available to checked in. Otherwise, the option Omit Locale Usage should be unselected.
Switching from <Min all Systems> or <Max all Systems> to a specific system name, should cause the “Omit Local Usage” to be unselected and unchecked.
After applying the rules, click Update.
Click the option Object List that displays the All Objects drop-down combo. Select the system name and display the Changed/Created/Used and Days value of the selected system's production data. The drop-down only appears if the production data are available for the objects from multiple machines.
[image: ]
Fig. 27.1.13 – Object List identifying the system name
Click the option Program List that displays the Program List drop-down combo. Select the system name and display the Changed/Created/Used and Days value of the selected system's production data. The drop-down only appears if the production data are available for the programs from multiple machines.
[image: ]
Fig. 27.1.14 – Program List identifying where the Changed/Created/Used and Days information
Click the option Files that displays the Files drop-down combo. Select the system name and display the Changed/Created/Used and Days value of the selected system's production data. The drop-down only appears if the production data are available for the Files from multiple machines.
[image: ]
Fig. 27.1.15 – Files identifying where the Changed/Created/Used and Days information
Contents
Contents
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[bookmark: _Toc97719904]Miscellaneous Topics
[bookmark: _Toc97719905]Dual Installation of X-Analysis
	[image: ]
	Refer to the section “XA Plugins in Multiple Eclipse/RDi application” in the document “X-Analysis_Installation_And_Upgrade_Guide” for this release.



[bookmark: _Toc97719906]X-Analysis Indexes Job Scheduler Entries
X-Analysis initialization process (XA4INIT command) calls the XASCDEIDX and XAROBOT commands towards the end of the processing. These commands generate source members for IBM Job Scheduler entries and ROBOT Job Scheduler entries.
X-Analysis initialization process starts the ROBOT processing if it finds the RBTROB8, RBTCMD1 and RBTCS2 files all in the same library.
For ROBOT entries, it creates and indexes source members in QCLSRC and writes XMEMBER records. It also populates the XAROBOTIDX file.
XASCDEIDX Command
The XASCDEIDX command will cross reference the IBM job scheduler entries. A CL source member is generated in the specified library for each job.
This source is then indexed, enabling references to be displayed through the Variable Where Used and the Object Where Used features. To run the XASCDEIDX command, the data area XAJOBSCDE in the repository library should be set to *YES.
                    X-Ref Job Scheduler Entries (XASCDEIDX)
 
  Type choices, press Enter.
 
  X-Analysis library . . . . . . .                 Name
  CL source library  . . . . . . .                 Name
 		
Fig. 28.1.1 – X-Ref Job Scheduler Entries (XASCDEIDX)
X-Analysis Library
Enter the name of the X-Analysis library where the Where Used data should be stored.
CL Source Library
Enter the name of the library where the CL source should be stored. This can be the X-Analysis library itself, if required.
XAROBOT Command
The XAROBOT command creates Program References and Variable Where Used entries for jobs initiated from the Robot job scheduler.
	[image: ]
	User can run XAROBOT Command against multiple systems.


                   Create/Index Robot Sched Jobs (XAROBOT)
 
  Type choices, press Enter.
 
  X-Analysis library . . . . . . .                 Name
  Robot library  . . . . . . . . .                 Name
  CL source library  . . . . . . .                 Name
 
 
 		
Fig. 28.1.2 – Index Robot Scheduler Jobs (XAROBOT)
X-Analysis Library
Enter the name of the X-Analysis cross-reference library built for the application containing the jobs scheduled by Robot.
Robot Library
Enter the library name that contains the Robot database.
CL Source Library
Enter the library name where the program can generate CL source members for each scheduled job entry. QTEMP can be entered if you do not wish to keep or view the source programs generated.

[bookmark: _Toc97719907]Overriding Data Tables
[bookmark: _Toc97719908]Synon Function Key / Option Defaults
The XS2EFODFT table identifies default function keys and options, their texts and action type. Applications may re-assign the *PREVIOUS key from F12 to F24, and use "A" for *DELETE and "Z" for *DETAIL.
  A    R XS2EFODFTF
  A      S2ODTYP     1A      TEXT('Function Key/Option')
  A      S2ODVAL     2A      TEXT('Value')
  A      S2ODOVL     2A      TEXT('Override Value')
  A      S2ODTXT    50A      TEXT('Text')
  A      S2ODACT    20A      TEXT('Action')
  A* ----------------------------------------------------
  A     K S2ODTYP
  A     K S2ODVAL
  A* ------------------------------------------------------
Fig. 28.2.1 – Table Structure for XS2EFODT

Default Values of the Table XS2EFODT
	S2ODTYP 
	S20DVAL
	S2ODOVL
	 S2ODTXT
	S2ODACT

	F
	03
	 
	Exit  
	*EXIT 

	F
	09
	 
	Add/Change
	*ADD/*CHANGE

	F
	11
	 
	Delete
	*DELETE

	F
	12
	 
	Cancel
	*PREVIOUS

	O
	01
	 
	Select
	*SELECT

	O
	04
	 
	Delete
	*DELETE

	O
	05
	 
	Display
	*DETAIL 




Example – Modified Values for the Table XS2EFODT
	S2ODTYP 
	S20DVAL
	S2ODOVL
	 S2ODTXT
	S2ODACT

	F
	03
	 
	Rinucia  
	*EXIT 

	F
	09
	 
	Modo<Inser>::Modo <Modif.>
	*ADD/*CHANGE

	F
	11
	 
	Annullamento
	*DELETE

	F
	12
	24
	Ritorna
	*PREVIOUS

	O
	A
	 
	Cancellazione
	*SELECT

	O
	Z
	 
	 Zoom
	*DELETE

	O
	01
	 
	Selezione
	*DETAIL 



[bookmark: _Toc97719909]Synon Function Key/Option Extra Defaults
The XS2EFOXTR table details additional function key usage. In some applications, F12 could be an extra default function key for the functions listed.
  A    R XS2EFOXTRF
  A      S2OXTYP      1A     TEXT('Function Key/Option')
  A      S2OXVAL      2A     TEXT('Value')
  A      S2OXFNT     10A     TEXT('2E Function Type')
  A* ---------------------------------------------------------------
  A    K S2OXTYP
  A    K S2OXVAL
  A* ---------------------------------------------------------------
 
Fig. 28.2.2 – Table Structure for XS2EFOXTR

Sample Values for XS2EFOXTR
	S2OXTYP 
	S20XVAL
	S2OXFNT

	F
	12
	PMTRCD 

	F
	12
	DSPRCD

	F
	12
	EDTRCD

	F
	12
	SELRCD




[bookmark: _Toc97719910]Data Model Editing
The Data Model Diagram can be edited through the Change Cardinality option. Right-click on a DMD relation from the Relationships in DMD view to select the option. This functionality is restricted by the data area, XUSRDBREL. The data area should exist on the X-Ref library and the value should be set as 'Y'.
[image: ]
 Fig. 28.3.1 – Relationships in DMD view showing the right-click option, Change Cardinality to
The cardinality on the DMD editor is shown by a rhombus symbol. Selecting this option will allow the user to set the relation as N:1, 1:N, or N:N. Presence on one end indicates 'N' (Many) and absence '1'.
When a user selects the relation as One to One, the DMD will appear as below:
[image: ]
 Fig. 28.3.2 – DMD Editor with Cardinality selected as One to One
When the cardinality is changed to One to Many, then the following DMD will appear:
[image: ]
 Fig. 28.3.3 – DMD Editor with Cardinality selected as One to Many
Changing the cardinality to Many to One will present the following DMD:
[image: ]
 Fig. 28.3.4 – DMD Editor with Cardinality selected as Many to One
When the Many to Many option is selected, then the DMD will appear as below:
[image: ]
 Fig. 28.3.5 – DMD Editor with Cardinality selected as Many to Many

[bookmark: _Toc97719911]Specification for Exporting in Docx Format
After generating the system document, if you want to open the docx format. Word will prompt a dialog indicating that the external fields are needed to be referred. Click Yes to see the Table of Content (TOC) in the generated system document.
The following screenshot shows the dialog:
[image: ]
 Fig. 28.4.1 – Dialog prompt confirming the reference to external fields

[bookmark: _Toc97719912]Specification for Exporting to MS Visio
While exporting to MS Visio if the user click on the Stencil tab which is in minimized state (as per MS-Visio 2013), the export process will get interrupted. The exporting feature is an automated process; hence, it is advised not to click the Stencil tab, and prevent the process from raising an exception.
Refer to the screen below displaying the Stencil tab for a better idea.
[image: ]
 Fig. 28.5.1 – MS Visio window displaying the Stencil tab

[bookmark: _Toc97719913]Limitations of the Japanese/DBCS Version
X-Analysis has certain limitations when run in the DBCS environment. Below are a few observed limitations:
· The VWU process and other similar functionalities like the FFWU process do not support the DBCS characters.
· Data Dictionary and its related options for DBCS fail to convert Japanese characters.
· Source Compare Editor incorrectly converts Japanese character YEN (¥) to backslash (\).

[bookmark: _Toc97719914]Limitations on the Number of Object/Source Libraries in X-Analysis
There are three different aspects of it (aspect one and two are valid when using Index Source Files only, and rest all parameters on XAXREF should be set to *NO):
1. Option 12=Initialise invokes Initialise X-Analysis/4 (XAXREF) with a special value *SPECIFIED, allowing up to 999 Object libraries and 999 Source libraries.
2. If we do not use *SPECIFIED on the XAXREF command, then up to 300 Object libraries and 300 Source libraries are allowed.
3. If the requirement is to have both Index Source Files and Build Data Model, then a maximum 200 Object libraries and 200 Source libraries can be supplied.

[bookmark: _Toc97719915]Limitations on the Length of the Command Tracked by X-Analysis
The commands tracked by X-Analysis are dependent on XA4MCL Data Area, and therefore X-Analysis can track commands of a specified length. Currently, the default length is set as 7, and, in this case, the X-Analysis will not track commands whose length is less than 7. However, the default length may be changed according to the command tracking requirement.

[bookmark: _Toc97719916]Limitations on the Field Type in Field Search
There is a known limitation with Field Search logic for a multi-procedure member using the same variable name of a different type in different procedures. The logic can’t distinguish between both.
For a DDS member with no actual object, the search specified with a Field Type will not yield any result. It will behave normally for All Types.

[bookmark: _Toc97719917]SQL Member Object Reference / Field Attribute Limitations
· References are reported only when the SQL member has at most single object definition with body (BEGIN-END block).
· It is expected that the member and system name of the object defined (with the body), have the same name. If the names are different, then the field attributes reporting will be affected; either no field attributes will be reported or will be reported against incorrect object.
	[image: ]
	The SYSTEM name refers to the name of the object created when the SQL member will be compiled. The SYSTEM name is the name used by the IBM i operating system.



[bookmark: _Toc97719918]Limitations on Embedded SQL Source Processing
· Object-less members are processed only if they are included in members which have associated object, or if they have member type of SQLRPG, SQLRPGLE.
· It is also expected that members with Embedded SQL are of SQL member types, for example SQLRPG, SQLRPGLE, SQLCBL, and SQLCBLLE.

[bookmark: _Toc97719919]X-Analysis Diagram System Scaling Support
The X-Analysis currently supports a maximum system scaling of 150%. The X-Analysis may display distorted diagrams in case the scaling is set to more than 150%.

[bookmark: _Toc97719920]Switching User Interface Language among English, French, and Japanese
The X-Analysis currently supports a maximum system scaling of 150%. The X-Analysis may display distorted diagrams in case the scaling is set to more than 150%.
· English
· French
· Japanese
By default, the UI of X-Analysis is displayed in the same language as your operating system. However, you can switch between the English, French, and Japanese language as instructed in the following steps:
· Select X-Analysis for Eclipse shortcut from Start Menu>All Programs>X-Analysis XX.Y.Z
· Right click on the X-Analysis for Eclipse shortcut and select properties.
· Edit the Target field as-
· For English - " C:\Program Files (x86)\Fresche Solutions\X-Analysis\X-Analysis13.x.x\X-Analysis 13.x.x for Eclipse.bat" -nl en
· For French - " C:\Program Files (x86)\Fresche Solutions\X-Analysis\X-Analysis13.x.x\X-Analysis 13.x.x for Eclipse.bat" -nl fr
· For Japanese -" C:\Program Files (x86)\Fresche Solutions\X-Analysis\X-Analysis13.x.x\X-Analysis 13.x.x for Eclipse.bat " -nl ja
 
	[image: ]
	“13.x.x” in the target field denotes the latest release number.


[image: ]
 Fig. 28.6.1 – Eclipse Properties
Miscellaneous Topics
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[bookmark: _Toc97719921]Index
2E, 15, 84, 245, 250, 256, 272, 276, 433
5250 Emulator, 56, 211
Access Path Diagram, 14, 285, 327
Access Paths, 164, 195, 230, 237, 285, 293, 313, 314
Action Diagram, 347, 352, 396, 398
Activity Diagram, 209, 281, 306
Add Status Category, 445
Add User defined Rule, 442
Additional Parameters, 392
Affinity Comparison, 63, 136, 152
All References, 215, 219, 231
Annotation, 154, 187, 237, 248, 300, 323, 388, 440, 480
Annotation Template, 193, 388
APD, 14
API, 51
APIs, 447
application area, 14, 37, 49, 62, 63, 68, 69, 77, 80, 101, 114, 118, 123, 128, 133, 135, 136, 147, 148, 149, 150, 152, 154, 155, 156, 161, 177, 179, 184, 196, 245, 257, 269, 277, 287, 291, 297, 341, 355, 358, 359, 372, 383, 443, 480, 493
Application Area Options, 136, 369, 379
Application Area Rules, 70, 116, 123, 136, 149, 493
Application Folder, 42, 71, 331, 360, 385, 410
ASP, 17, 36
Attributes, 84, 136, 199, 237, 301, 430, 434, 510
Audit Options, 12, 76, 97, 121, 154, 305, 403, 477
Audit Report, 434
Batch programs, 140, 295
block diagrams, 247, 258
Bookmark, 195, 233
Business Process Logic, 76, 205, 346, 403
Business Rule Matching, 443
Business Rules, 12, 14, 23, 25, 49, 67, 68, 77, 82, 91, 92, 151, 154, 194, 201, 219, 279, 294, 295, 297, 299, 305, 306, 345, 351, 398, 428, 431, 439, 444
Business Rules Analysis, 12, 68, 294
Business Rules Overlay, 49, 201, 439
Business Rules Status Category, 49, 444
C#, 112
Called Programs, 140, 205, 222, 252, 265
Calling Programs, 177, 265, 268
CASE Tool, 196
Change Cardinality, 501
Class Diagram, 155, 209, 306, 308
Client, 12, 16, 33, 37, 45, 50, 69, 73, 123, 149, 212, 331, 339, 390, 427, 443, 447, 460, 474, 486
COBOL, 199, 200, 328
Component Status, 80
configuration, 416
Configure Columns, 301, 441
Consolidated Rules, 49, 92, 202, 300, 439
Converted Source, 167
Cross-Reference Libraries, 75, 303, 479
cross-reference library, 16, 17, 23, 37, 61, 62, 64, 65, 67, 72, 78, 88, 91, 114, 123, 154, 177, 249, 269, 291, 297, 303, 305, 335, 339, 384, 388, 396, 403, 428, 431, 468, 472, 474, 498
customized, 75, 212, 303, 429
Customized Libraries, 75, 303
Data Definition Language, 71, 331
Data Dictionary, 293, 313, 314, 315, 317, 318, 319, 322, 506
Data Flow Diagram, 14, 30, 48, 112, 113, 126, 196, 208, 236, 245, 256, 327, 433, 462
Data Management, 154, 309
data model, 14, 23, 25, 37, 64, 66, 67, 71, 126, 168, 197, 287, 291, 293, 309, 310, 313, 315, 319, 323, 327, 331, 361, 375, 428, 431, 501, 507
Data Model Diagram, 14, 197, 287, 291, 319, 327, 361, 375, 501
Data Modelling, 293, 314, 318
Database Fields, 295, 298
Database Library, 37
DB2 Connection, 38
DB2 database, 323, 390
DB2 Port, 47
DDL, 44, 71, 79, 112, 156, 160, 161, 162, 167, 168, 169, 170, 331
DDL conversion, 156, 160, 161, 162, 167, 169, 170
DDS LFs, 162, 164, 174
Default View Level, 56, 220
Dependent File, 141, 287, 309, 316, 428
Detail DFD, 242
Detailed SCD, 252
Device Files, 197, 219, 231
DFD, 14, 31, 48, 195, 196, 236, 245
Diagram Options, 208
Diagrams, 20, 49, 51, 52, 236, 247, 258, 306, 323, 327, 328, 330, 396, 401, 433, 512, 513
Difference Analysis, 75, 303
DMD, 14, 49, 195, 196, 285, 287, 291, 310, 321, 501
Document Application Area, 154, 358, 359, 372
Document Manager, 12, 42, 72, 154, 341, 342, 346
documentation, 12, 14, 41, 236, 280, 295, 323, 341, 342, 343, 351, 355, 358, 362, 374, 383, 384, 387, 410, 415
Documenter, 41, 212, 280, 341, 342, 355, 387, 410
Eclipse, 15, 33, 38, 46, 70, 211, 306, 404, 405, 408, 412, 417, 419, 421, 422, 496, 513
Edit Problem Categories, 76
entity relationship diagram, 323
Excluded Rules, 301, 441
Expand/Collapse Referenced Objects, 237
Export Options, 71, 118, 154, 185, 212, 225, 323, 324, 325, 326, 327, 331, 335, 339, 343, 455
Export to MS Excel, 120, 145, 183, 212, 345, 351
Export to PDF, 118, 212, 323, 324
Exportable Rules, 95, 301, 441
Fetch Next References, 217
FFD, 14
Field Type, 108, 313, 318, 509
Fields, 17, 57, 86, 92, 107, 164, 219, 228, 230, 231, 241, 279, 295, 298, 300, 308, 314, 318, 337, 347, 352, 426, 431, 455, 504
File Analysis, 161, 166, 167, 168, 170
File Connection, 288
File Field Details, 14, 195, 229
File Metrics, 76
Filter by Rule Status, 442
flowchart, 51, 52
Flowchart, 209, 323, 328, 386
Function Attributes, 84
Function Type, 82, 250, 256, 267, 272, 276, 500
Generate Database Service Programs, 71, 335
Generate UML, 209
generic file, 21
Google Drive, 45, 51, 55, 447, 474
Hide/Show Objects, 237
Hierarchical Structure Chart, 14, 208, 258
Hierarchy Exclusions, 20, 250, 272
IBM, 11, 12, 15, 29, 33, 37, 38, 46, 56, 60, 71, 123, 145, 165, 198, 211, 303, 335, 390, 391, 394, 409, 412, 423, 490, 497, 510
IBM DB2, 390
IBM i, 12, 15, 29, 35, 37, 38, 47, 60, 71, 123, 145, 165, 211, 303, 335, 391, 394, 409, 490, 510
Indented Source Code, 200
Initialize, 62, 64, 76, 97, 122, 400
Initialize Source Archiving, 76, 97
Inquiries, 11
Interactive Structure Chart, 55
Inter-Repository Options, 75, 303
Invert Selection, 342
Inverted Structure Chart, 265
Java, 112, 390, 413, 422, 447
Jump to Subroutine, 328
Legend, 80, 178, 184, 219, 231, 244, 247, 263, 265, 268, 270, 281, 286, 290, 386
Level, 26, 54, 59, 84, 112, 115, 140, 151, 152, 159, 170, 207, 215, 228, 236, 266, 269, 290, 315, 328, 391, 431
LFs, 142, 159, 162, 164, 174, 195, 216, 228, 230, 285, 468
LFs/Access Paths, 230, 285
libraries, 19, 23, 25, 36, 60, 62, 65, 75, 78, 303, 429, 431, 464, 471, 479, 487, 507
Library List, 16, 37, 62, 428, 431, 471, 487
License Manager, 12, 38
Manage Linked Repositories, 75, 303
Member List, 77, 88, 90, 93, 230, 306, 433, 460
metadata, 293, 313, 314, 318, 323, 331
Metrics Analysis, 76
Metrics History, 97
MS Visio, 185, 328, 505
Narratives, 252, 260, 273
New DB2 Connection, 38
New DB2 Connection for i, 38
Object Allocation, 76
Object Library, 79, 269
Object List, 29, 50, 77, 78, 93, 121, 128, 133, 215, 229, 281, 351, 376, 400, 460, 468, 494
Object Where Used, 20, 28, 56, 112, 113, 195, 196, 199, 215, 237, 266, 497
Objects, 20, 23, 25, 29, 49, 50, 55, 63, 65, 68, 72, 73, 77, 78, 121, 123, 124, 128, 136, 150, 152, 155, 170, 185, 188, 195, 196, 208, 215, 229, 236, 245, 247, 250, 252, 257, 258, 269, 272, 277, 279, 282, 287, 291, 297, 304, 310, 320, 322, 341, 342, 355, 358, 362, 377, 382, 383, 384, 387, 388, 400, 409, 428, 431, 468, 487
OLE Automation, 51, 387, 415
Open Database Connectivity, 323
Open Office Draw, 51
Overridden Files, 252
Overview Structure Chart, 14, 21, 269, 273, 274, 276, 327, 361, 375
parameters, 56, 86, 165, 219, 231, 236, 335, 391, 397, 429, 507
Parent File, 287
Preferences, 46, 50, 52, 54, 57, 58, 79, 95, 184, 207, 218, 220, 230, 243, 256, 257, 276, 279, 286, 289, 300, 415, 427, 439, 447, 465, 474
Print, 213, 258, 265, 271
Problem Analysis, 20, 76, 121, 138, 160, 161, 168, 305
program logic, 25, 236, 247
Program Structure Chart, 14, 56, 196, 208, 267, 401
PSC, 14, 195, 196, 267, 401
pseudo code, 56, 91, 206, 295
PTF Analysis, 75, 303
RDi, 15, 211, 306, 421, 422, 460, 496
Referred Files, 141, 178, 228, 261
Refresh, 23, 25, 64, 65, 67, 97, 115, 124, 149, 215, 391, 428, 431, 477
Relation Type, 319
Relationship Details, 316, 322
Relationships in DMD, 288, 501
Remote System Explorer, 460
repository, 16, 64, 65, 67, 75, 127, 303, 400, 428, 489, 497
Reset Perspective, 408
RPG, 25, 68, 73, 81, 112, 199, 200, 279, 297, 306, 328, 347, 352, 433
RPG environment, 433
RPGLE, 68, 73, 199, 279, 281, 297, 328
Rule Status Manager, 439
Runtime Environment, 419
SCD, 14, 21, 54, 247, 248, 250, 251, 252, 255, 257, 258, 267, 272, 276
Screen Components, 12, 74, 77, 210
Screen Flow Diagram, 208, 281, 346
Screen Metrics, 76, 305
Screen/Report Design, 210, 279, 411
Search Words, 102
Server, 28, 47, 54, 64, 71, 149, 150, 181, 331, 409, 411, 443
SOURCE, 20, 23, 31, 49, 56, 62, 65, 76, 77, 82, 88, 90, 91, 97, 101, 110, 112, 113, 126, 165, 167, 168, 170, 171, 172, 173, 174, 195, 196, 198, 200, 215, 219, 230, 231, 232, 233, 267, 294, 295, 298, 299, 324, 325, 326, 328, 330, 335, 343, 391, 396, 398, 409, 431, 439, 466, 471, 487, 497, 506, 507, 511
Source Browser, 82, 195, 196, 198, 200, 294, 328, 343
Source Compare, 97, 167, 506
Source Lines, 195, 197, 208, 219, 231
Source Options, 200, 299, 398
Specialized Analysis, 76
Spool File, 429
Stencil, 505
Structure Chart Diagram, 14, 126, 196, 208, 247, 251, 252, 256, 257, 258, 401, 433
Structured Query Language, 331
subroutines, 20, 73, 205, 219, 231, 267
Subset Data, 50
Suite of products, 12
Summary Report, 76
Surrogate File Analysis, 162, 168
Synon, 15, 86, 245, 247, 264, 266, 267, 271, 290, 401, 499
SYNON, 434
Tasks, 12, 73, 415
TD/OMS, 421
Test Management Options, 154
TLS 1.2, 422
Track Database Changes, 76
Troubleshooting, 404, 413, 479
UML Options, 155, 209, 306, 308
Update Rules, 301, 441
Use SSL, 36, 45, 47, 423, 436
user authorities, 28
V2, 12, 38
Variable Program Calls, 25
Variable Where Used, 56, 107, 111, 112, 113, 195, 196, 199, 219, 228, 316, 426, 465, 497
VB, 390
VB.Net, 390
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Object Where Used - Usage References for XANACDEM/CUSF(“FILE), Total Objects: 83 Hem-
Object Type  Attribute  Text Usage Library LastUsed A
CBI0GR *PGM__ RPG Back-out account File Updated By Program XANACDEM _ 00/00/00
CNTDELRCD *PGM  RPGLE File Updated By Program/Delete O.. XANACDEM  00/00/00
CONSTPROC  *PGM  CLE PROC_WITH_ALL_CONSTANTS File Read By Program XAN4CDEM  00/00/00
CONUPDO  *PGM  RPGLE  Revert Back Customer Info File Updated By Program XAN4CDEM  00/00/00
CONUPD1 ~ *PGM  RPGLE  Update Customer Info - Version 1 File Updated By Program XAN4CDEM  00/00/00
CONUPD2 ~ *PGM  RPGLE  Update Customer Info - Version 2 File Updated By Program XAN4CDEM  00/00/00
CRTVAROT ~ *PGM  RPGLE  Embedded SQL with Create Variable St.. ~File Read By Program XAN4CDEM  00/00/00
cuscpy SPGM  RPG Customer Copy File Read/Written To By Program  XANACDEM  00/00/00
CUSFLA SFILELF Sites by Product - renamed from cusfla...  Logical File XAN4CDEM  00/00/00
CUSFLB SFILELF Sites by Orig.List Logical File XAN4CDEM  00/00/00
CUSFLC SFILELF Sites by Salesperson Logical File XAN4CDEM  00/00/00
CUSFLD SFILELF Sites by Validator Logical File XAN4CDEM  00/00/00
CUSFLE SFILELF Sites by Organisation Logical File XAN4CDEM  00/00/00
CUSFLT SFILELF Sites by Name. Logical File XAN4CDEM  00/00/00
CUSFL2 SFILELF Sites by Status Logical File XAN4CDEM  00/00/00
CUSFL3 SFILELF Sites by Number Logical File XAN4CDEM  00/00/00
CUSFLS SFILELF Sites by Dist& Status Logical File XAN4CDEM  00/00/00
CUSFL6 SFILELF Sites By Dist& Name Logical File XAN4CDEM  00/00/00
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% Object List |3 Object Where Used B CBIOGR 2 | -8

Source List of CBI0GR in XAN4CDEM/QRPGSRC, Lines: 155, View Level: 5 .04
EvEEE-YPyR-vE-usEEi AvE~vea~

Seq No 445 46 .. Date Changed A
0001.00 ECBY06RD CF E WORKSTN 00/00/00
0002.00 FSECE  UF E K DISK 01/10/12
0003.00 ECUSF  UF E K DISK 12/12/03
0004.00 F*BORPF UF E K DISK 01/10/12
0005.00 F*BACPF IF E K DISK 01/10/12
0006.00 F*BLNPF IF E K DISK 01/10/12
0007.00 F*BSTPF IF E K DISK ... 01/10/12
0008.00 E 2RC 10 1 00/00/00
0009.00 c *ENTRY ~ PLIST 00/00/00
0010.00 c PRARM WWACEN 3 ... 00/00/00
0011.00 c PRARM WWACTE 10 00/00/00
0012.00 c PRARM WWACSS 1 00/00/00
0013.00 c PRARM WWDAPG 60 00/00/00
0014.00 c PARM WWPTIT 104 00/00/00
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Object Where Used - Entry Level References for XANACDEM/CUSFL3(*FILE), Total Objects: 15, View Level: 1 P £ & & ~

Object Type  Attribute  Text Usage Library Last Used
ZBTRNHST PGM_CBL Work with transaction history. Entry Level Reference XANACDEM _00/00/00
CUSTMNTI2  *PGM  RPGLE  Customer Detail Maintenance  Entry Level Reference  XANACDEM  00/00/00
ZBCONHDR ~ *PGM  CBL Work with Orders - Cobol vers.  Entry Level Reference  XANACDEM  00/00/00
CUSTMNTR ~ *PGM  RPGLE  Customer Detail Maintenance  Entry Level Reference  XANACDEM  00/00/00
WWCUSTSARR  *PGM  RPGLE  Work with Customers Entry Level Reference  XAN4CDEM  00/00/00
OE008 SPGM  RPG Order Entry Entry Level Reference  XAN4CDEM  00/00/00
7BCUSTS SPGM  CBL Work with customer - Cobol vers.  Entry Level Reference  XAN4CDEM  00/00/00
CUSTMNTIO  *PGM  RPGLE  Customer Detail Maintenance  Entry Level Reference  XANCDEM  00/00/00
WWCUSTS 0 *PGM  RPGLE  Workwith Customers Entry Level Reference  XAN4CDEM  00/00/00
ZBCUSFMNT ~ *PGM  CBL Customer Site Maintenance Entry Level Reference  XAN4CDEM  00/00/00
SECFOCLP. SPGM CLP Security Report Entry Level Reference  XAN4CDEM  00/00/00
CUSTMNTI1  *PGM  RPGLE  Customer Detail Maintenance Entry Level Reference  XANCDEM  00/00/00
WWCUSTS1 ~ *PGM  RPGLE  Workwith Customers Entry Level Reference  XAN4CDEM  00/00/00
WWCUSTS2 ~ *PGM  RPGLE  Workwith Customers Entry Level Reference  XAN4CDEM  00/00/00

‘CUSFMOLD *PGM  RPGLE  Customer Site Maintenance Entry Level Reference  XAN4CDEM  00/00/00
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Object Where Used - Entry Level References for XANACDEM/CUSFL3 (“FILE), Total Objects: 15, View Level: 1 M & & & ~

Object Type  Atibute  Text Usage Library Last Used
ZBTRNHST  *PGM  CBL Work with transaction history  Entry Level Reference  XANACDEM _ 00/00/00
CUSTMNT1.2  *PGM  RPGLE  Customer Detail Maintenance _ Entry Level Reference  XANACDEM _00/00/00
ZBCONHDR  Ba Zoom Source - Cobolvers.  Entry Level Reference  XAN4CDEM 00/00/00
CUSTMNTR | Data Flow Diagram Maintenance  Entry Level Reference  XANACDEM  00/00/00
WWCUSTSARR ~ Object Where Used > ers Entry Level Reference  XAN4CDEM  00/00/00
OE008 e N Entry Level Reference  XAN4CDEM  00/00/00
ZBCUSTS, S her - Cobol vers.  Entry Level Reference  XANACDEM  00/00/00
CUSTMNT1_0 Maintenance  Entry Level Reference  XANACDEM  00/00/00
. Structure Chart Diagram
WWCUSTS0 2 Structure Chart mers Entry Level Reference  XAN4CDEM  00/00/00
ASEER | iogram S i Bintenance Entry Level Reference  XAN4CDEM  00/00/00
SECFOCLP Entry Level Reference  XAN4CDEM  00/00/00
CUSTMNT1_1 “ Maintenance  Entry Level Reference  XANACDEM  00/00/00
wwcusts1 | B Screen/Report Design Mers Entry Level Reference  XANACDEM  00/00/00
wwcusts2 | B Screen/Report Source fers. Entry Level Reference  XANACDEM  00/00/00

cusimoLp | BF Consolidated Rules hintenance Entry Level Reference  XANACDEM  00/00/00
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% Call Path 52
~ CUSTMNT1_2 - Entry Level Reference
CUSFL3
~ WCUSTP
CUSFL3 - Referred Object
~ CUSFSEL
CUSFL3 - Referred Object
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34 Variable Where Used 22 | @RAYHEBEHYyA~Yy 4r =0
Variable Where Used for *ALL/CUSNO, 1 to 270 Lines of Total 270 Lines, View Level: Level1

Name SeqNo  A...t... 1 ...t... 2 ...f... 3 ...+... 4 ...+..... Library Source File ILevel
CBCUSTSD  0270.00 2 zcUsNO R B 15 22REF... XAN4CDEM  QDDSSRC 1
CBCUSTSD  0383.00 2 zcusNO R © 15 22REF... XAN4CDEM QDDSSRC 1
CBIOER 0101.00 c MOVELCUSNO CUSNO... XAN4CDEM QRPGSRC 1
CBIOER 0102.00 c cusNo CHAINRSECF ... XAN4CDEM QRPGSRC 1
creT 0004.00 pc VAR (&CUSNO) TYPE(YDEC) ... XAN4CDEM QCLSRC 1
creT 0009.00 CHGVAR &CUSNO &CUSNC XAN4CDEM QCLSRC 1
crer 0010.00 CALL LETN1 (&CUSNO &PREFIX &LETSQ) XAN4CDEM  QCLSRC 1
crETN 0001.00 e PARM(&CUSNO &PREFTX &LL... XAN4CDEM QCLSRC 1
crETN 0003.00 pc VAR (&CUSNO) TYPE(YDEC) ... XAN4CDEM QCLSRC 1
crETN 0010.00 CALL LETN1 (&CUSNO GPREFIX GLLETSQ)  XAN4CDEM OQCLSRC 1
cNTAcs 0003.00 2 cusNo sp 0 TEX... XAN4CDEM QDDSSRC 1
cNTAcs 0021.00 2 ® cusNo XAN4CDEM  QDDSSRC 1
CNTCMAINT ~ 0101.00 c eval zcusno = cusno  XAN4CDEM QRPGLESRC 1
CNTCMAINT  0120.00 c eval cusno = zousno  XAN4CDEM QRPGLESRC 1
CNTCMAINT  0247.00 c eval cusno = cust... XAN4CDEM QRPGLESRC 1
CNTCMAINT  0261.00 c x£ld ... XAN4CDEM QRPGLESRC 1 .
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3 Variable Where Used 52 | @mvuumvn§<> =8
n

Variable Where Used for *ALL/CUSNO, 1 to 270 Lines of Total 270 Lines, View Level: Level1 W Definition Statemer

Name Seq No 1 4...2 ...b... 3 ...+ 4 ...+..... Libz W File Operations

cBCUSTSD | 0270.00 a zcusvo R B 15 22REF... XAN& g g

CcBCUSTSD  0383.00 a zcusvo R © 19 22REF... xaN4

CBYOER 0101.00 c MOVELCUSNO cusNo... xan4™ Program Structure Operation
cB90ER 0102.00 c cusNo CHAINRSECF ... XBN4W Field Operation

CLET 0004.00 DCL VAR (&CUSNO) TYPE (*DEC) ... TCLSRT

cLer 0009.00 CHGVAR &CUSNO &CUSNC XAN4CDEM QCLSRC 1
cLer 0010.00 CALL LETN1 (&CUSNO &4PREFIX GLETSQ) XAN4CDEM  QCLSRC 1
cremy 0001.00 pau PARM(GCUSNO GPREFIX GLL... XANCDEM OQCLSRC 1
CLETN 0003.00 DCL VAR (&CUSNO) TYPE(*DEC) ... XAN4CDEM QCLSRC 1
cremy 0010.00 CALL LETN1 (SCUSNO GPREFIX GLIETSQ)  XAN4CDEM  QCLSRC 1
cnTAcs 0003.00 a cusNo se 0 TEX... XAN4CDEM QDDSSRC 1
cnTAcs 0021.00 a & cusNo XAN4CDEM  QDDSSRC 1
CNTCMAINT  0101.00 c eval zcusno = cusno  XANACDEM OQREGLESRC 1
CNTCMAINT  0120.00 c eval cusno = zcusno  XANACDEM OQREGLESRC 1
CNTCMAINT  0247.00 c eval cusno = cust... XANACDEM OQRPGLESRC 1
CNTCMAINT  0261.00 c x£ld ... XANACDEM OQRPGLESRC 1 ©
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Variable Where Used for *ALL/CUSNO, 1 to 270 Lines of Total 270 Lines, View Level: Level1 ¥ Levelt

Name Seq No 1ot 2 b3 .t 4 b, Lib: Level2

cBCUSTSD | 0270.00 a zcosvo R B 15 22mer... xaw  Level3

CcBCUSTSD  0383.00 a zcusvo R © 15 22REF... XAN.  lvé/Parameters

cB90ER 0101.00 c MOVELCUSNO COSNO... XN LyS/Cascading Parameters
cB90ER 0102.00 c cusNo CHAINRSECF S i tckieg
CLET 0004.00 DCL VAR (&CUSNO) TYPE (*DEC) ...

cLer 0009.00 CHGVAR &CUSNO GCUSNC XANACDEM  QULSRC 1
cLer 0010.00 CALL LETN1 (SCUSNO GPREFIX GLETSQ) XANACDEM  QCLSRC 1
cremy 0001.00 om0 PARM (GCUSNO GPREFIX GLL... XANACDEM QCLSRC 1
CLETN 0003.00 DCL VAR (&CUSNO) TYPE(*DEC) ... XAN4CDEM QCLSRC 1
cremy 0010.00 CALL LETN1 (SCUSNO GPREFIX GLIETSQ)  XAN4CDEM  QCLSRC 1
cnTAcs 0003.00 a cusno se 0 TEX... XANACDEM QDDSSRC 1
cnTAcs 0021.00 a K cusno XANACDEM  QDDSSRC 1
CNTCMAINT  0101.00 c eval zousno = cusno  XANACDEM OQRPGLESRC 1
CNTCMAINT  0120.00 c eval cusno = zcusno  XANCDEM ORPGLESRC 1
CNTCMAINT  0247.00 c eval cusno = cust... XANACDEM ORPGLESRC 1
CNTCMAINT  0261.00 c x£1d ... XAN4CDEM QRPGLESRC 1 %
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Variable Where Used for *ALL/CUSNO, 1 to 270 Lines of Total 270 Lines, View Level: Level1

Name Seq No  F..t... 1 ...be.. 2 .t 3 b4 Lt 5 4.6 Tibrary  source File [zevel | ~
CBCUSTSD  0270.00 2 zcuswo R B 15 22REFFLD(CUSNO XAN4CD... XAN4CDEM  QDDSSRC 1

CBCUSTSD  0383.00 a zcusyo R © 15 22REFFLD(CUSNO XAN4CD... XAN4CDEM  QDDSSRC 1

CBI0ER 0101.00 c MOVELCUSNO cusNo 50 XAN4CDEM  QREGSRC 1

CBI0ER 0102.00 c cusNo CHAINRSECF 5050 XAN4CDEM  QREGSRC 1

creT 0004.00 pc VAR (&CUSNO) TYPE(YDEC) LEN(S 0) XAN4CDEM  QCLSRC 1

creT 0009.00 CHGVAR &CUSNO &CUSNC XAN4CDEM  QCLSRC 1

crer 0010.00 CALL LETN1 (&CUSNO &PREFIX &LETSQ) XAN4CDEM  QCLSRC 1

crETN 0001.00 2aM PARM (&CUSNO &PREFIX &LLETSQ) XAN4CDEM  QCLSRC 1

crETN 0003.00 pc VAR (&CUSNO) TYPE(YDEC) LEN(S 0) XAN4CDEM  QCLSRC 1

crETN 0010.00 CALL LETN1 (&CUSNO &PREFIX &LLETSQ) XAN4CDEM  QCLSRC 1

cNTAcs 0003.00 a cusNo 5p 0 TEXT ('Cus. No.') XAN4CDEM  QDDSSRC 1

cNTAcs 0021.00 2 ® cusNo XAN4CDEM  QDDSSRC 1

CNTCMAINT  0101.00 c eval zcusno = cusno XAN4CDEM  QREGLESRC 1

CNTCMAINT  0120.00 c eval cusno = zcusno XAN4CDEM  QREGLESRC 1

CNTCMAINT  0247.00 c eval cusno = customer XAN4CDEM  QREGLESRC 1

CNTCMAINT ~ 0261.00 c xfld cusno ... XAN4CDEM  QRPGLESRC 1

CNTLE3 0003.00 2 ® cusNo XAN4CDEM  QDDSSRC 1

CNTLFS 0005.00 2 ® cusNo XAN4CDEM  QDDSSRC 1 .
g nnan oo v cresen —  svamncncncs PErTTE P B R
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Variable Where Used for *ALL/CUSNO, 1 to 270 Lines of Total 270 Lines, View Level: Level1

Name seq No E T . Library  Source File Level ~
CBCUSTSD  0270.00 2 zcusNo R B 195 22REFFLD(CUSNO XAN4CD... XAN4CDEM  QDDSSRC 1

CBCUSTSD  0383.00 2 zcuswo R © 15 22REFFLD(CUSNO XAN4CD... XAN4CDEM  QDDSSRC 1

CBI0ER 0101.00 c MOVELCUSNO cusvo 50 XAN4CDEM  QREGSRC 1

CBI0ER 0102.00 c cusNo CHAINRSECF 5050 XAN4CDEM  QREGSRC 1

crET 0004.00 pc VAR (&CUSNO) TYPE(YDEC) LEN(S 0) XAN4CDEM  QCLSRC 1

crET 0009.00 CHGVAR &CUSNO &CUSNC XAN4CDEM  QCLSRC 1

crer 0010.00 CALL LETN1 (&CUSNO &PREFIX &LETSQ) XAN4CDEM  QCLSRC 1

crETN 0001.00 2aM PARM (&CUSNO &PREFIX &LLETSQ) XAN4CDEM  QULSRC 1

crETN 0003.00 pc VAR (&CUSNO) TYPE(YDEC) LEN(S 0) XAN4CDEM  QCLSRC 1

crETN 0010.00 CALL LETN1 (&CUSNO &PREFIX &LLETSQ) XAN4CDEM  QULSRC 1

cNTAcs 0003.00 2 cusNo 58 0 TEXT ('Cus. No.') XAN4CDEM  QDDSSRC 1

cNTAcs 0021.00 2 ® cusNo XAN4CDEM  QDDSSRC 1

CNTCMAINT  0101.00 c eval zcusno = cusno XAN4CDEM  QRPGLESRC 1

CNTCMAINT  0120.00 c eval cusno = zcusno XAN4CDEM  QRPGLESRC 1

CNICMAINT  0247.00 c eval cusno = customer XAN4CDEM  QRPGLESRC 1

CNTCMAINT  0261.00 c xfld cusno ... XAN4CDEM  QRPGLESRC 1

CNTLE3 0003.00 2 ® cusNo XAN4CDEM  QDDSSRC 1

CNTLFS 0005.00 2 ® cusNo XAN4CDEM  QDDSSRC 1 .
g nnan oo v v~ svamnencncs PETTrE P B R
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34 Variable Where Used 22 | @RAYrHEBEHYyAYy«4r»r =0

Variable Where Used for *ALL/CUSNO, 1 to 418 Lines of Total 418 Lines, View Level: Level2

Name Seq No E R 5 . € . Library  Source File ILevel ~
cLer 0011.00 CHGVAR GCUSNC &PREFTX XAN4CDEM  QCLSRC 2

cLer 0014.00 carL WKCUSL  (&CUSNC PREFIX GLETNR) XAN4CDEM  QCLSRC 2

cLETN 0001.00 peu BARM (6CUSNO &PREFTX &LLETSQ) XAN4CDEM  QCLSRC 1

cLETN 0003.00 e VAR (6CUSNO) TYPE (*DEC) LEN(S 0) XAN4CDEM  QCLSRC 1

cLETN 0010.00 CALL LETN1 (&CUSNO GPREFTX SLLETSQ) XAN4CDEM  QCLSRC 1

cNTACS 0003.00 a cusNo 58 0 TEXT ("Cus. No. XAN4CDEM  QDDSSRC 1

cNTACS 0021.00 2 R cusNo XAN4CDEM  QDDSSRC 1

CNTCMAINT  0021.00 D customer s sp 0 XANACDEM  QRPGLESRC 2

CNICMAINT  0045.00 c cntacskey chain(e) rentac XANACDEM  QRPGLESRC 2

CNTCMAINT  0101.00 c eval zousno = cusno XAN4CDEM  QRPGLESRC 1

CNTCMAINT  0120.00 c eval cusno = zcusno XAN4CDEM  QRPGLESRC 1

CNTCMAINT  0247.00 c eval cusno = customer XAN4CDEM  QRPGLESRC 1

CNTCMAINT  0257.00 c parm customer ... XANCDEM  QRPGLESRC 2

CNTCMAINT  0260.00 c cntacskey Klist XANACDEM  QRPGLESRC 2

CNTCMAINT  0261.00 c keld cusno ... XAN4CDEM  QRPGLESRC 1

CNTCMAINTD 0025.00 2 2cusNo sv 08 4 28 XAN4CDEM  QDDSSRC 2

coNTLE3 0003.00 2 R cusNo XAN4CDEM  QDDSSRC 1

coNTLFY 0005.00 2 R cusNo XAN4CDEM  QDDSSRC 1 .
T s~ evamnenencs P—— p—— B R
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Variable Where Used for *ALL/CUSNO, 1 to 637 Lines of Total 637 Lines, View Level: Level3

Name seq No 1 ...%... 2 ...+...3 ...t... 4 ...+..... Library Source File Level
CBCUSTSD  0270.00 IS zcusNo R B 15 22REF... XAN4CDEM QDDSSRC 1
CBCUSTSD  0383.00 2 zcusNo R © 15 22REF... XAN4CDEM QDDSSRC 1
CBI0ER 0101.00 c MOVELCUSNO CUSNO... XAN4CDEM QRPGSRC 1
CBIOGR 0102.00 c cusNo CHAINRSECF ... XAN4CDEM QRPGSRC 1
CIET 0001, 00 BEM BARM (4PK) KAN4CDEM | OCLSRC E)
crET 0002.00 pcL VAR (GPK) TYPE(*CHAR) LE... XAN4CDEM QCLSRC 3
crET 0004.00 pc VAR (&CUSNO) TYPE(YDEC) ... XAN4CDEM QCLSRC 1
crET 0005.00 pc VAR (&CUSNC) TYPE(YCHAR)... XAN4CDEM QCLSRC 2
crET 0006.00 pc VAR (eprefix) TYPE(*CHAR... XAN4CDEM QCLSRC 3
crET 0008.00 CHGVAR &CUSNC &PK XAN4CDEM QCLSRC 2
crET 0009.00 CHGVAR &CUSNO &CUSNC XAN4CDEM QCLSRC 1
crer 0010.00 CALL LETN1 (&CUSNO &PREFIX &LETSQ) XAN4CDEM  QCLSRC 1
crET 0011.00 CHGVAR &CUSNC &PREFTX XAN4CDEM QCLSRC 2
crer 0014.00 cann WECUST, (SCUSNC PREFI... XAN4CDEM QCLSRC 2
crETN 0001.00 paM PARM (&CUSNO &PREFTX §LL... XAN4CDEM QCLSRC 1
CLETN 0003.00 DpeL. VAR (&CUSNO) TYPE (*DEC) ... XAN4CDEM QCLSRC 1

~
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Variable Where Used for *ALL/CUSNO, 1 to 772 Lines of Total 772 Lines, View Level: Lv4/Parameters

Name Seq No 1 ..t 2 ... 3 L.+ & ..+..... Library Source File Level
cLETN 0003.00 e VAR (SCUSNO) TYPE (*DEC) ... XAN4CDEM QCLSRC 1
CLETN 0604.00 B, VAR (GBREFTX) TYPE (\CHAR... XANACDEM QCLSRC 4
cLETN 0010.00 CALL LETNI (GCUSNO GPREFIX GLLETSQ)  XAN4CDEM QCLSRC 1
cLETN 0012.00 CHGVAR  VAR(4CUSNC) VALUE (SPREFIX) XAN4CDEM QCLSRC 4
cLETN 0016.00 WECUSL 24CUSNO (&CUSNC) ?*PREFIX(&P... XANCDEM QCLSRC 4
coNTACS 0003.00 2 cuswo 58 0 TEX... XAN4CDEM QDDSSRC 1
coNTACS 0021.00 2 R cusNo XAN4CDEM QDDSSRC 1
CNTCMAINT  0021.00 D customer s sp 0 XANACDEM QREGLESRC 2
CNICMAINT  0025.00 < cntacskey chain(e) rentac XANACDEM OQREGLESRC 2
CNTCMAINT  0101.00 c eval zousno = cusno  XANCDEM OQRPGLESRC 1
CNTCMAINT  0120.00 c eval cusno = zousno  XANCDEM OQRPGLESRC 1
CNTCMAINT  0247.00 c eval cusno = cust... XAN4CDEM ORPGLESRC 1
CNTCMAINT  0257.00 c parm ... XAN4CDEM OQREGLESRC 2
CNTCMAINT  0260.00 c cntacskey Klist XANACDEM QREGLESRC 2
CNTCMAINT  0261.00 c keld ... XAN4CDEM OQREGLESRC 1
CNTCMATNTD  0025.00 a ZcUSNO sy 08 4 28 XAN4CDEM QDDSSRC 2

~
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Variable Where Used for *ALL/CUSNO, 1 to 1027 Lines of Total 1027 Lines, View Level: Lv5/Cascading Parameters

Name Seq No E L T . Library  Source File ILevel ~
cLer 0011.00 CHGVAR GCUSNC &PREFTX XAN4CDEM  QCLSRC 2
cLer 0014.00 carL WKCUSL  (&CUSNC BREFIX GLETNR) XAN4CDEM  QCLSRC 2
cLETN 0001.00 pau BARM (6CUSNO &PREFTX &LLETSQ) XAN4CDEM  QCLSRC 1
cLETN 0003.00 per VAR (6CUSNO) TYEE (*DEC) LEN(S 0) XAN4CDEM  QCLSRC 1
cLETN 0004.00 per VAR (SPREFIX) TYPE(*CHAR) LEN(S) XAN4CDEM  QCLSRC 7
cLETN 0007.00 per VAR (CUSNC) TYBE (YCHAR) LEN(S) XAN4CDEM  QCLSRC s
cLETN 0010.00 CALL LETN1 (&CUSNO GPREFTX SLLETSQ) XAN4CDEM  QCLSRC 1
cLETN 0012.00 CHGVAR  VAR(GCUSNC) VALUE (SPREFTX) XAN4CDEM  QCLSRC 7
cLETN 0016.00 2 WECUSL 24CUSNO (&CUSNC) ?*PREFIX (SPREFTX) 2?LETNR(&... XANACDEM  QCLSRC A
coNTACS 0003.00 a cusNo 58 0 TEXT("Cus. No.') XAN4CDEM  QDDSSRC 1
coNTACS 0021.00 2 R cusNo XAN4CDEM  QDDSSRC 1
CNTCMAINT  0021.00 D customer s sp 0 XANACDEM  QRPGLESRC 2
CNICMAINT  0045.00 c cntacskey chain(e) rentac XANACDEM  QRPGLESRC 2
CNTCMAINT  0101.00 c eval zousno = cusno XAN4CDEM  QRPGLESRC 1
CNTCMAINT  0120.00 c eval cusno = zcusno XAN4CDEM  QRPGLESRC 1
CNTCMAINT  0247.00 c eval cusno = customer XAN4CDEM  QRPGLESRC 1
CNTCMAINT  0257.00 c parm customer ... XAN4CDEM  OQRPGLESRC 2
CNTCMAINT  0260.00 c cntacskey Klist XANACDEM  QRPGLESRC 2 .

)

< >
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Variable Where Used for *ALL/CUSNO, 1 to 1027 Lines of Total 1027 Lines, View Level: Maximum Tracking

Name
cBCUSTSD
cBCUSTSD
cBS06R
cBS06R
cLer
crer
crer
crer
crer
crer
crer
cLer
crer
cLer
cLemN
cLemN
cLemN
cLemN

<

Seq No
0270.00
0383.00
0101.00
0102.00
0001.00
0002.00
0004.00
0005.00
0006.00
0008.00
0005.00
0010.00
0011.00
0014.00
0001.00
0003.00
0004.00
0007.00

a
a
c
c

1

2.

zcuswo R
zcusyo R

b3 bl & Lr
B 15 22REFFLD(CUSNO XAN4CD...
© 15 22REFFLD(CUSNO XAN4CD...

5 ..+
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e VAR (6FK) TYPE(*CHAR) LEN (500

e VAR (6CUSNO) TYEE (*DEC) LEN(S 0)

e VAR (SCUSNC) TYEE (“CHAR) LEN(S

e VAR (Gprefix) TYPE(*CHAR) LEN(S

CHGVAR &CUSNC &P
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VAR (6CUSNC) TYPE (YCHAR) LEN(S
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Name seq No 1 iiitie. 2 cet...® ..t... 4 ...t..... Dibrary Source File Devel
cBcUsTSD 027000 a zcusvo R B 15 22REF... XANACDEM QDDSSRC 1
cBcUSTSD  0383.00 a zcusvo R © 15 22REF... XANACDEM QDDSSRC 1
cBsoer 0101.00 c MOVELCUSNO ~  CUSNO... XANACDEM QREGSRC 1
cBsoer 0102.00 c cusNo  crAINRsECE ... XANACDEM ORPGSRC 1
crer 0001.00 = AR (62K) XANSCDEM _oCLSRC 3
[czx 60200 o VAR(GPK) TYPE (FCHAR) IE...  XANACDEM  GULSRC 3
crer 0004.00 By Zoom Source VAR (4CUSNO) TYEE (*DEC) ... XANACDEM QCLSRC T
crer 0005.00 g’vuucusncy TYPE(ACHAR) ... XAN4CDEM QCTSEC 2
crer 0006.00 oL VAR (Gprefix) TYPE(‘CHAR... XANCDEM QCLSRC 3
crer 0008.00 CHGVAR GCUSNC &R XANSCDEM  OCLSRC 2
crer 0005.00 CHGVAR GCUSNO GCUSNC XANSCDEM  OCLSRC 1
crer 0010.00 CALL LETN1 (GCUSNO GPREFIX GLETSQ) XANSCDEM  oCLSRC 1
crer 0011.00 CHGVAR &CUSNC &PREFIX XANSCDEM  OCLSRC 2
crer 0014.00 cars WECUSL  (GCUSNC PREFI... XANCDEM QCLSRC 2
cremy 0001.00 o PARM(GCUSNO GPREFTX GLL... XANACDEM OQCLSRC 1
CLETN 0003.00 DCL VAR (&CUSNO) TYPE(*DEC) ... XAN4CDEM QCLSRC 1

~
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Name Seq No o142 L+l 3 L Li
CLET 0009.00 CHGVAR &CUSNO &CUSNC XA
CLET 0008.00 CHGVAR &CUSNC &PK XA
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cLer 0001.00 om0 BARM (&2K) XANSCDEM QCLSRC 3
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CLET 0005.00 DCL VAR (&CUSNC) TYPE (*CHAR)... XAN4CDEM QCLSRC 2

cLer 0006.00 ez VAR (Sprefix) TYPE(*CHAR... XAN4CDEM QCLSRC H
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CLETN 0003.00 DCL VAR (&CUSNO) TYPE(*DEC) ... XAN4CDEM QCLSRC 1 v
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XWB2(D  Statement Accou.. Character 11 00052 300 300 Statement Acco...
XWB3CD  Related Account  Character 11 00063 400 400 Related Account
XWHITX  Tax Reg Character 15 00074 500 500 Tax Reg

XWEONB  Bank Packed De.. 9 0 00089 600 600 Bank

XWJUNO  Bank Ac Packed De.. 15 0 00094 7.00 7.00 Bank A/c
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XWGIVA  Credit_Limit Packed De.. 15 2 00115 13.00 13.00 Credit Limit
XWAOCD  Stl_Dsc Character 3 00123 1400 1400 Stl Dsc
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1

b2t 3

Seq No . e 5 .. Name Level
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0046.00 c +IND3 IENE 1t coN001 1
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0078.00 c +IND3 IENE 1t coNo01 1
0005.00 2 cA03(03 'Exit') coN0OlDE 1
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E-B

Seq No 1. 2 403 L4 4 405 46

0021.00 CHEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE

0022.00 C* Receive Parameters

0023.00 c SENTRY ~ PLIST

0024.00 c PRRM @eRTN 1 Return Code

0026.00 c* Until F3
0027.00 @ *INO3 DOUEQ'1'
2 c i
0029.00 c* Initialise screen Add Bookmark
0030.00 c MOVERC!  yariable Where Used >
0031.00 c MOVEL* Member X-Ref
0032.00 € HOEL  Enhanced Member XRef
0033.00 c MOVEL* D
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Source List of CON0O1 in XANACDEM/QRPGSRC, Lines: 271, View Level: 5 H~

EvEEEYPy-E-yaEEi AvE~S A~

Seq No Fob... 1l .42 4.3 ..+, 4 ..4...5 ...+..6 ...+..7... Date Changed A
0021.00 CHRREAA AR R KR AR AR KRR KK EARR KR AR AR KRR RKEAAARRRREAAARS | 02/08/07
0022.00 C* Receive Parameters ... 92/08/07
0023.00 c *ENTRY ~ PLIST ... 00/00/00
0024.00 c PRRM @eRTN 1 Return Cod... 92/08/07
0026.00 c* Until F3 ... 92/08/07
0027.00 © ¥INO3 DOUEQ™ 1" ... 00700700
2 c #IN03 09/3¢
0029.00 c* Initialise S addvooma Ny ... 92/09/30
0030.00 c AR WRerel B ... 92/09/30
0031.00 c o 1 ... 03/10/14
0032.00 c e ————— 2 ... 03/10/14
0033.00 c P ——— 3 03/10/14
0034.00 c E 03/10/14
0035.00 c Z-ADD*ZERO 92/09/30
35.01 Cx* *ZERO 11/09/14
0036.00 c MOVE *BLANKS DSCSNO ... 03/10/14

0037.00 c MOVEL'0" *IN34 ... 92/09/30
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seq No ®oob... 1 ..+...2 ..%...3 ..+...4 ..+...5 ...+... 6 ...+... 7... Date Changed
0021.00 CHRREAA AR SRR AR KR KRR KKK AARR KR AR AR KA ERRRKEAAARRRREAAARS | 02/08/07
0022.00 C* Receive Parameters 92/08/07
0023.00 c *ENTRY ~ PLIST ... 00/00/00
0024.00 c PRRM @eRTN 1 Return Cod... 92/08/07
0026.00 c* Uptil F3 92/08/07
10027.00 @ *INO3 DOUEQ'1" 00/00/00
= = TR
0029.00 c* Initialise screen 92/09/30
0030.00 c MOVEACMD, 1 CMDDTA 92/09/30
0031.00 c MOVEL*BLANKS XWADD1 03/10/14
0032.00 c MOVEL*BLANKS XWADD2 03/10/14
0033.00 c MOVEL*BLANKS XWADD3 03/10/14
0034.00 C MOVEL*BLANKS XWPCDE 03/10/14
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Library Name Type  Attribute  Description Status Changed Created  Used Days Function A
REXANACDEM  CUSCPY “PGM_ RPG Customer Copy *D  14/06/21 01/09/08 00/00/00 0 UPDFIL
PFXANACDEM  CUSF SEEDF Sites B 14/06/21 01/09/08 00/00/00 O

PFXANACDEM  CUSFFF B Zoom Source B 14/06/21  28/02/20  00/00/00 O

LFXAN4CDEM cusm? roduct 14/06/21 28/02/20 00/00/00 O

LFXAN4CDEM  CUSFFF Object Where Used rig.List 14/06/21 28/02/20  00/00/00 O

LFXANACDEM  CUSFFF Variable Where Used > salesperson 14/06/21  28/02/20 00/00/00 O

LEXANACDEM - CUSFFR g (o jalidator 14/06/21  28/02/20  00/00/00 O

LEXANACDEM  CUSFFE oo oo rganisation 14/06/21  28/02/20  00/00/00 O

LFXANACDEM  CUSFFR o |/ coecc paths jame 14/06/21  28/02/20  00/00/00 O

LEXANACDEM  CUSFFE & Access path Diagram tatus 14/06/21  28/02/20  00/00/00 O

LFXANACDEM  CUSFFE  Consolidated Rules umber 14/06/21  28/02/20 00/00/00 O

LFXANACDEM  CUSFFR programs to Consolidate ist& Status 14/06/21  28/02/20 00/00/00 O

LFXANCDEM  CUSFFR ist& Name 14/06/21  28/02/20 00/00/00 O
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Exclude Constraints

LFXANACDEM  CUSFFF ‘ax No. 14/06/21  28/02/20 00/00/00 O

LFXANACDEM CUSFLZ  SetObsolete Object Flag roduct - rename... 14/06/21  01/09/08  00/00/00 O

LFXANACDEM CUSFLE ~ More Info rig List 14/06/21 01/09/08  00/00/00 0O
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LFXANACDEM  CUSFL3 umber 14/06/21 01/09/08  00/00/00 O

LFXANCDEM  cuspls  Modemization Options 7 bist Status 14/06/21 01/09/08 00/00/00 O

LFXANACDEM CUSFLE  UML Options > Dist& Name 14/06/21 01/09/08 00/00/00 O
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CUSFMAINT 00001 CUSNO  CUSF  Cus_No not found on Sites
CUSFMAINT 00002 CNAME CUSF  Company = blank
CUSFMAINT 00003 TELNO  CUSF  Phone <> blank
CUSFMAINT 00004 FAXNO  CUSF  FaxNo <> blank
CUSFMAINT 00005 DSDCDE CUSF  Distributor <> blank
CUSFMAINT 00006 DSDCDE DISTS  Exact match not found for...
CUSFMAINT 00007 STATUS  CUSF  Sts <> blank

CUSFMAINT 00008 USERNM CUSF  Contact = blank
CUSFMAINT 00009 SALUT  CUSF  Salutation <> blank and S.

CUSFMAINT 00010 CUSNO CUSE  Cus_No

Message ID

(OEMO012 (You must.
(OEMO014 (The telep.
(OEMO015 (The fax. n.

(OEMO018 (The distri...
(OEMO019 (The statu.
(OEMO0020 (You must.
(OEMO021 (The title i

Rule Status  Rule Status Comm... Annotation
No Status
No Status
No Status
No Status
No Status
No Status
No Status
No Status
No Status
No Status
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Business Rules for CUSFMAINT, Number of Lines: 10

Source Mem... Rule Number Field File Rule Message ID Rule Status  Rule Status Comm... Annotation
CUSFMAINT 00001 CUSNO  CUSF  Cus_No not found on Sites No Status
CUSFMAINT 00002 CNAME CUSF  Company = blank (OEMO012 (You must.. No Status.
CUSFMAINT 00003 TELNO  CUSF  Phone <> blank (OEMO014 (The telep.. No Status

CUSFMAINT 00004 FAXNO CUSF  Fax_No <> blank ‘OEMO015 (The fax. n.. No Status
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REXANACDEM ~ CONOOT *PGM  RPG Contract Entry

CLXAN4CDEM ~ CPDM *PGM  CLP List Correspondence

#EXAN4CDEM  CRTVAROT ~ *PGM RPGLE  Embedded SQL with Create..
CLXAN4CDEM  CSEC *PGM  CLP Build Security Fax

Status Changed

A
B
A
A
A
A
D
A
*C
D
D
*C
A
D
D
A
D
A

14/06/21
14/06/21
14/06/21
14/06/21
14/06/21
14/06/21
14/06/21
14/06/21
14/06/21
14/06/21
14/06/21
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14/06/21
14/06/21
14/06/21
14/06/21
14/06/21

Created

24/10/16
12/08/15
01/09/08
01/09/08
06/05/14
13/09/10
01/07/20
30/12/15
12/05/16
12/10/20
04/06/13
04/06/13
27/11/15
05/06/13
01/09/08
01/09/08
05/08/20
01/09/08

Used

00/00/00
00/00/00
00/00/00
00/00/00
00/00/00
00/00/00
00/00/00
00/00/00
00/00/00
00/00/00
00/00/00
00/00/00
00/00/00
00/00/00
00/00/00
00/00/00
00/00/00
00/00/00

Days

cococococoococoooo00o o000

Function A
UPDFIL
EDTFIL
OTHCAL
OTHCAL
OTH
EDTRCD
UPDFIL
OTHCAL
OTH
OTHFIL
UPDFIL
UPDFIL
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UPDFIL
EDTFIL
OTHCAL
OTHFIL
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Object List of *ALLUSR/*ALL/*FILE/PF/*ALL/*ALL, Total Objects: 75 @~ N
Library Name Type  Attribute  Source Attribute  Description Status  Changed  Created  Used
PEXANACDEM  ASIMPLTEST  *FILE  PF PF-DDS D 14/06/21  30/03/11  14/06/21
PEXANACDEM  ASTATUS SFILE PF PF-DDS Status file A 14/06/21  01/09/08  14/06/21
PEXANACDEM  CNTACS SFILE PF PF-DDS Contacts C 14/06/21  01/09/08  00/00/00
PFXANACDEM ~ CONDET SFILE PF PF-DDS Contract Detail B 14/06/21  01/09/08  14/06/21
PFXANACDEM CONDETNW  *FILE  PF PF-DDS Contract Detail new... *8 14/06/21  02/02/11  00/00/00
PFXANACDEM  CONHDR SFILE PF PF-DDS Contract Header B 14/06/21  01/09/08  00/00/00
PEXANACDEM CONHDRFR  *FILE  PF PF-DDS Contract Header B 14/06/21  28/02/20  00/00/00
PEXANACDEM CPYBKSRC ~ *FILE  PF PF-DDS D 14/06/21  10/05/11  14/06/21
PFXANACDEM  CUSF SFILE PF PF-DDS Sites B 14/06/21  01/09/08  00/00/00
PEXANACDEM  CUSFFR SFILE PF PF-DDS Sites B 14/06/21  28/02/20  00/00/00
PEXANACDEM  CUSGRP SFILE PF PF-DDS Customer Groups ~~ *B 14/06/21  01/09/08  00/00/00
PFXANACDEM CUSGRPFR  *FILE  PF PF-DDS Purchaser Groups ~ *B. 14/06/21  28/02/20  00/00/00
PEXANACDEM  CUSTS SFILE PF PF-DDS Purchases B 14/06/21  01/09/08  00/00/00
PFXANACDEM  CUSTSFR SFILE PF PF-DDS Purchases B 14/06/21  28/02/20  00/00/00
PFXANACDEM DDLTBLXMP  *FILE  PF PF-SQL D 14/06/21  18/07/13  00/00/00
PEXANACDEM  DELIVA SFILE PF PF-DDS Delivery Areas B 14/06/21  01/09/08  00/00/00
PFXANACDEM DEMODBF  *FILE  PF PF-DDS demo database file  *A 14/06/21  30/12/15  00/00/00

PFXANACDEM  DISTS SFILE PF PE-DDS Distributors B 14/06/21  01/09/08 14/06/21
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Member List of *ALLUSR/*ALL/*ALL/*ALL, Total Members: 497 .
sm~
Library Sourcefile  Name Type  Description Date Changed  ~
PFXANACDEM QDDSSRC  ASTATUS  PF Statusfile 25/05/11
LFXANACDEM QDDSSRC ~ ASTATUSLT  LF  Non-keyed LF 10/04/14
REXANACDEM QRPGLESRC CALLPGM  RPGLE 22/09/16

= XAN4CDEM QDDSSRC ~ CBCUSTSD ~ DSPF  Work with Customers 27/07/10
CLXAN4CDEM QCLSRC CBC110 CLP Order Entry System 13/09/11
REXAN4CDEM QRPGSRC — CBIO3R RPG  Calculate Interest 22/09/11

o

XAN4CDEM QRPGSRC ~ CBIOSR RPG  Apply transactiontoan...  13/09/11

REXAN4CDEM QRPGSRC  CBIOGR RPG  Back-out account 03/12/12
REXANACDEM QRPGSRC — CB9OGR@BK RPG  Back-out account 13/09/11

XAN4CDEM QDDSSRC ~ CBIOGRD DSPF  Order Entry display file ~ 01/08/05
REXAN4CDEM QRPGSRC  CFD211 RPG Indicator Restructuring E..  17/03/07
CLXAN4CDEM QCLSRC CLET CLP Build Customer Letter 14/09/11

CLXAN4CDEM QCLSRC CLETN CLP  Print Customer Letter 21/09/11
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Source File List for: XAN4CDXA, Total Objects: 15
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Business Rules for *ALL, Number of Lines: 577

Source Mem... Rule Number Field File
CBYOGR 00001 CUSNO  SECF
CBYOGR 00002 CUSNO  SECF
CBYOGR 00003 SSRLNB  SECF
CBYOGR 00004 SSRLNB  SECF
CNTCMAINT 00001 CUSNO  CNTACS
BICNTCMAINT 00002 IXNAME  NAME...
CNTCMAINT 00003 USERNM  CNTACS
CNTCMAINT 00004 TELNO  CNTACS
CNTCMAINT 00005 FAXNO  CNTACS
CNTCMAINT 00006 SINIT  CNTACS
CNTCMAINT 00007 SINIT  CNTACS
CNTCMAINT 00008 STATUS ~ CNTACS
CONUPDO 00001 XWBCC... CUSTS
CONUPDT 00001 XWBCC... CUSTS
CONUPD2 00001 XWBCC... CUSTS

Rule
WWTATP = 'Y’ and Cmp_N...
Cmp_No not found on Sec..
Stl_no = blank N
Sti_no = blank

Cus_No not found on Cont...
Name found on Names_In...
Contact = blank

Phone <> blank

Fax_No <> blank
Sales_Person <> blank
Exact match not found for...
Sts <> blank

Customer found on Purch...
Customer found on Purch...
Customer found on Purch...

Message ID

(OEMO0020 (You must.
(OEMO014 (The telep.
(OEMO015 (The fax. n.

©OEMO0023 (Invalid sa...
(OEMO019 (The statu,

Rule Status Annotation ~
No Status.
No Status
No Status.
No Status.
No Status
Awaiting f...
No Status
No Status
No Status
No Status
No Status
No Status
No Status
No Status
No Status

Rule Status Comm...

Rule Status Com..  Annotation...
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Consolidated Rules for XANAC...ield Count:76 Rule Count:200 & A =& & v & @ &~
File/Field/Rule Member Message ID/Description A
- CUSNO (Cus. No)
> CusNo=0 WWCCONS/2/246
> Cus_No found on Contacts WWCCONS/1/159
> Cus No not found on Contacts  CNTCMAINT/1/44
- FAXNO (FaxNo.)
> Fax_No <> blank CNTCMAINT/5/184  OEMO015 (The fax. no. is invalid.)
- SINIT (Sales Person)
> Exact match not found for Sales.. CNTCMAINT/7/198  OEM0023 (Invalid salesman.)
> Sales_Person <> blank CNTCMAINT/6/196
- STATUS (Sts)
> Sts <> blank CNTCMAINT/8/209  OEM0019 (The status is invalid)
- TELNO (Phone)
> Phone <> blank CNTCMAINT/4/172  OEMO014 (The telephone no. is invalid.)
- USERNM (Contact)
> Contact = blank CNTCMAINT/3/163  OEM0020 (You must enter a contact name.)
“ CONDET (Contract Detail) o




image72.png
& Consolidated Rules 2 = a

Consolidated Rules for XANCDXA - Full View; Field Count:76 Rule Count:200 [
ZAEAve @~
File/Field/Rule Member Message ID/Description
v CNTACS (Contacts)
~  CUSNO (Cus.No)
v~ CusNo=0 WWCCONS/2/246
//1f customer number not provided then prompt
IF CUSNO EQ *zeros
CALLP CUSFSEL CUSNO
END
~  CusNofound on Contacts WWCCONS/1/159
// Subroutine: Display record
] sssssse——————_——-,_
READ rentac CUSNO
IF %found(cntacs)
CUSNO EQ cusno
PRPCDE EQ prpcde
USERNM EQ usernm
TELNO EQ telno
FAXNO EQ faxno
dsemail EQ email
// dsemail = email;
numdate Equctdat
dsdate EQ %date(chardate*YMDO)
dslctdat EQ %char(dsdate)
numdate EQ apdate v
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Consolidated Rules for XANACDXA/...iew; Field Count:4 Rule Count:13 & A = @ ~ & @ ~ @~
File/Field/Rule Member Message ID/Description A
- CONDET (Contract Detail)
- XWAACS (Store)
> Store found on Contract_Detail and not E.. ORDAUDIT0/1/36
> Store not found on Stock_Balances or CO... WWCONDET/7/398 OES0370 (Exceeds the stock)
- XWABCD (Product)
> Product <> 0 CONO01/5/178
> Product found on Contract_Detail CON001/6/184
> Product found on Contract_Detail and N.. WWCONDET/2/270
> Product not found on Contract Detail  CON001/11/240  OEM0008 (No transaction history for product)
- XWA2CD (U/M)
> UM = EAC' WWCONDET/9/421
- XWORDN (Contract)
> Contract not found on Contract Detail ~ ZBCONDET/19/730
> CONDET-RECORD.Contract <> CONDET... ZBCONDET/9/496 v
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Consolidated Rules for XANACDXA - Full View; Field Count:76 Rule Count:200 AABRE~ye@d @~
File/Field/Rule Member Message ID/Description A
v CUSNO (Cus. No)
>0 CusNo=0 WWCCONS/2/246
> Cus_No found on Contacts WWCCONS/1/159
> Cus_No not found on Contacts CNTCMAINT/1/44
v FAXNO (FaxNo.)
> Fax_No <> blank CNTCMAINT/5/184  OEMOO1S (The fax. no. is invalid.)
v SINIT (Sales Person)
> Exact match not found for Sales_Person on Contacts CNTCMAINT/7/198  OEMO0023 (invalid salesman.)
> Sales_Person <> blank CNTCMAINT/6/196
M STATUS (Sts)
> Sts <> blank CNTCMAINT/8/209  OEMO019 (The status is invalid)
v TELNO (Phone)
> Phone <> blank CNTCMAINT/4/172  OEM0014 (The telephone no. is inval.
v USERNM (Contact)
> Contact = blank CNTCMAINT/3/163  OEM0020 (You must enter a contact

CCONDET (Contract Detail)
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Change History for XKANACDXA [ s

ChangedDate/Name  Library Source Files Type  Attribute  Description Source change date
MYCALL XANACDEM QCLSRC  *PGM  CLLE New CMD similar to CALL cmd ~ 2021-04-16 00:33:29
MYDSPFD XANACDEM QCLSRC ~ *PGM  CLLE New CMD similar to DSPFD cmd - 2021-04-16 00:33:29
MYPGM XANACDEM QCLSRC ~ *PGM  CLLE New pgm for usr defined cmds  2021-04-16 00:33:29

¥ MYSBMIOB  XANACDEM QCISRC  *PGM CLLE New CMD similar to SBMJOB c...  2021-04-16 00:33:29
MYXCALL XANACDEM QCLSRC ~ *PGM  CLLE New CMD similar to CALL cmd  2021-04-16 00:33:29
XACALL XAN4CDEM QCMDSRC  *CMD  CMD Command to replicate CALL co... 2021-04-16 00:33:30
XCALL XAN4CDEM QCMDSRC  *CMD  CMD Command to replicate CALL co... 2021-04-16 00:33:30
XDSPFD. XAN4CDEM QCMDSRC  *CMD  CMD Command to replicate DSPFD c... 2021-04-16 00:33:30
XSBMIOB. XAN4CDEM QCMDSRC  *CMD  CMD Command to replicate SBMJOB ... 2021-04-16 00:33:30

~ 2021-04-14
CALLPGM XANACDEM QRPGLESRC *PGM  RPGLE 2021-04-14 12:53:56
c8ci0 XAN4CDEM QCLSRC ~ *PGM  CLP Order Entry System 2021-04-14 12:5237
CBIOIR XANACDEM QRPGSRC ~ *PGM  RPG Calculate Interest 2021-04-14 125251
CBIOSR XANACDEM QRPGSRC ~ *PGM  RPG Apply transaction to an account  2021-04-14 125251

‘CB906R XAN4CDEM QRPGSRC  *PGM  RPG Back-out account 2021-04-14 12:52:51
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Change History for XANACDXA [ .~

ChangedDate/Name  Library Source Files Type  Attribute  Description Source change date
MYCALL XANACDEM QCLSRC ~ *PGM  CLLE New CMD similar to CALL cmd ~ 2021-04-16 00:33:29
MYDSPFD XANACDEM QCLSRC  *PGM  CLLE New CMD similar to DSPFD cmd - 2021-04-16 00:33:29
MYPGM XANACDEM QCLSRC  *PGM  CLLE New pgm for usr defined cmds ~ 2021-04-16 00:33:29
MYSBMIOB ~ XANACDEM QCLSRC ~ *PGM CLLE New CMD similar to SBMJOB c... 2021-04-16 00:33:29
MYXCALL XANACDEM  QCtsh Zoom Source MD similar to CALLcmd  2021-04-16 00:3329
XACALL XANACDEM  QCMI [ Compare with Previous and to replicate CALL co... 2021-04-16 00:3330
XCALL XANACDEM  QCMI - Compare with Next and to replicate CALL co... 2021-04-16 00:3330
XDSPFD. XANACDEM  QCMI [ Compare with Current and to replicate DSPFD c... 2021-04-1600:3330
XSBMIOB. XAN4CDEM  QCMDY mimand to replicate SBMJOB ... 2021-04-16 00:33:30

~ 2021-04-14
CALLPGM XANACDEM QRPGLESRC *PGM  RPGLE 2021-04-14 12:53:56
c8ci0 XANACDEM QCLSRC ~ *PGM  CLP Order Entry System 2021-04-14 12:5237
CBIOIR XANACDEM QRPGSRC ~ *PGM  RPG Calculate Interest 2021-04-14 125251
CBIOSR XANACDEM QRPGSRC ~ *PGM  RPG Apply transaction to an account  2021-04-14 125251

CBY06R XAN4ACDEM QRPGSRC  *PGM  RPG Back-out account 2021-04-14 12:52:51 v
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Change History for XAN4CDXA N R4 ':* l:lﬁ -
ChangedDate/Name  Library Source Files Type  Attribute  Description Order by Program fe date A

~ 2021-04-16
MYCALL XAN4CDEM QCLSRC ~ *PGM  CLLE New CMD similar to CALLcmd  2021-04-16 00:33:29
MYDSPFD XAN4CDEM QCLSRC ~ *PGM  CLLE New CMD similar to DSPFD cmd  2021-04-16 00:33:29
MYPGM XAN4CDEM QCLSRC ~ *PGM  CLLE New pgm for ust defined cmds ~ 2021-04-16 00:33:29
MYSBMIOB XAN4CDEM QCLSRC ~ *PGM  CLLE New CMD similar to SBMJOB c..  2021-04-16 00:33:29
MYXCALL XAN4CDEM QCLSRC ~ *PGM  CLLE New CMD similar to CALLcmd  2021-04-16 00:33:29
XACALL XAN4CDEM QCMDSRC ~ *CMD  CMD Command to replicate CALL co... 2021-04-16 00:33:30
XCALL XAN4CDEM QCMDSRC ~ *CMD  CMD Command to replicate CALL co... 2021-04-16 00:33:30
XDSPFD XAN4CDEM QCMDSRC ~ *CMD  CMD Command to replicate DSPFD c... 2021-04-16 00:33:30
XSBMIOB XAN4CDEM QCMDSRC ~ *CMD  CMD Command to replicate SBMJOB ... 2021-04-16 00:33:30

~ 2021-04-14
CALLPGM XAN4CDEM QRPGLESRC *PGM  RPGLE 2021-04-14 125356
CBC110 XAN4CDEM QCLSRC ~ *PGM  CLP Order Entry System 2021-04-14 1255237
CBYO3R XAN4CDEM QRPGSRC ~ *PGM  RPG Calculate Interest 2021-04-14 12552551

CB9OSR XAN4CDEM QRPGSRC ~ *PGM  RPG Apply transaction to an account  2021-04-14 12:5251 v
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Chanpe History for XANACDXA [ .-

ChangedDate/Name  Library Source Files Type  Attribute  Description Source change date
~ CALLPGM
2021-04-14  XANACDEM QRPGLESRC *PGM  RPGLE 2021-04-14 12:53:56
2016-09-22 (New XANACDEM  QRPGLESRC *PGM  RPGLE 2016-09-22 12:1241
2016-09-22  XANACDEM QRPGLESRC *PGM  RPGLE 2016-09-22 121241
~ CBIO3R
2021-04-14  XANCDEM QRPGSRC ~ *PGM RPG Calculate Interest 2021-04-14 125251
2011-09-22  XANCDEM QRPGSRC  *PGM  RPG Calculate Interest 2011-09-22 06:06:11
2011-09-22  XANCDEM QRPGSRC  *PGM  RPG Calculate Interest 2011-09-22 06:06:11
~ CBIOSR
2021-04-14  XANCDEM QRPGSRC ~ *PGM RPG Apply transaction to an account  2021-04-14 125251
2011-09-13 XANACDEM QRPGSRC ~ *PGM  RPG Apply transaction to an account  2011-09-13 10:10:21
2011-09-13 XANACDEM QRPGSRC ~ *PGM  RPG Apply transaction to an account  2011-09-13 10:10:21
~ CBIOGR
2021-04-14  XANCDEM QRPGSRC ~ *PGM RPG Back-out account 2021-04-14 125251

2012-12-03 XAN4CDEM QRPGSRC ~ *PGM  RPG Back-out account 2012-12-03 17:4623 v
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